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I. ABSTRACT 

This report documents the models and methods used in the Symbolic Nuclear Analysis 

Package/RADionuclide Transport, Removal and Dose Estimation code (SNAP/RADTRAD) 

plugin to the SNAP graphical user interface (GUI) and the RADionuclide Transport and Removal 

and Dose Estimation analytical code (RADTRAD-AC) developed for the U.S. Nuclear 

Regulatory Commission (NRC) Office of Nuclear Regulatory Research to estimate transport and 

removal of radionuclides and dose at selected receptors. SNAP/RADTRAD along with the 

RADTRAD-AC code is used to estimate the radionuclide release from the containment using 

either the NRC TID-14844 or NUREG-1465 source terms and assumptions, or a user-specified 

table. In addition, the code can account for a reduction in the quantity of radioactive material 

released due to containment sprays, natural deposition, filters, and other engineered safety 

features. The code uses a combination of tables and numerical models of source term 

reduction phenomena to determine the time-dependent dose at user-specified locations for a 

given accident scenario. The code system also provides the inventory, decay chain, and dose 

conversion factor tables needed for the dose calculation. SNAP/RADTRAD can be used to 

assess occupational radiation exposures, typically in the control room; to estimate site boundary 

doses; and to estimate dose attenuation due to modification of a facility or accident sequence. 
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1.0 INTRODUCTION 

The purpose of the Symbolic Nuclear Analysis Package/RADionuclide Transport, Removal and 

Dose Estimation (SNAP/RADTRAD) code is to determine the dose from a release of 

radionuclides during a design basis accident to the exclusion area boundary (EAB), the low 

population zone (LPZ), and the control room and other locations of interest. As radioactive 

material is transported through the containment, the user can account for sprays and natural 

deposition to reduce the quantity of radioactive material. Material can flow between buildings, 

from buildings to the environment, or into control rooms through high-efficiency particulate air 

(HEPA) and charcoal filters, piping, or other connectors. Decay and in-growth of daughters can 

be calculated over time as the material is transported. 

The focus of SNAP/RADTRAD is licensing analysis to show compliance with nuclear plant siting 

and control room dose limits for various loss-of-coolant accidents (LOCAs) and non-LOCA 

accidents. The RADTRAD code was originally developed by the Accident Analysis and 

Consequence Assessment Department at Sandia National Laboratories for the U.S. Nuclear 

Regulatory Commission (NRC) in 1997 as documented in NUREG/CR-6604, “RADTRAD: A 

Simplified Model for RADionuclide Transport and Removal and Dose Estimation,” [1]. The code 

was revised to include a Visual Basic graphic user interface (GUI) for user convenience in 1999, 

which is described in NUREG/CR-6604, Supplement 1, “RADTRAD: A Simplified Model for 

RADionuclide Transport and Removal and Dose Estimation,” [2]. Finally, NUREG/CR-6604, 

Supplement 2, “RADTRAD: A Simplified Model for RADionuclide Transport and Removal and 

Dose Estimation,” [3] was published in 2002 discussing the testing of RADTRAD version 3.03. 

The NRC decided to update RADTRAD by converting the code into JAVA and develop a 

RADTRAD plugin to interface with the SNAP graphical user interface (GUI). As part of this 

update to RADTRAD, the RADTRAD analytical code (RADTRAD-AC) was separated from 

SNAP and distributed as RADTRAD Version 4.0. The SNAP GUI with the RADTRAD plugin is 

used to develop models and prepare input which is then processed by the RADTRAD-AC 

(Version 4.0). The RADTRAD-AC then calculates the dose and generates the results. The 

combined package is referred to as SNAP/RADTRAD. Use of RADTRAD in the SNAP 

framework allows use of the SNAP features including the Model Editor for developing plant 

models. The Model Editor also provides tools for user input checking, for submitting and 

monitoring calculations, and for running multiple cases. The RADTRAD-AC generates data 

output files suitable for plotting with the Applied Programming Technology plotting package 

(AptPot). 

As part of the development of the RADTRAD plugin for SNAP, the user documentation is being 

updated. This report provides the documentation for the use of and the calculation models in 

SNAP/RADTRAD. 
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2.0 MODEL DEVELOPMENT USING SNAP/RADTRAD 

Running SNAP/RADTRAD will require some familiarity with the overall SNAP approach to 

developing and running models. In this section, the approach to using SNAP to develop, modify 

and execute RADTRAD problems will be discussed. However, SNAP includes many features 

which will not be discussed here. For the interested user, the Symbolic Nuclear Analysis 

Package User's Manual [4] provides more detailed information on the use of SNAP. 

2.1 Overview of SNAP/RADTRAD 

SNAP is a suite of computer applications used to develop, modify, and execute computer 

models principally for thermal hydraulic codes such as the TRAC/RELAP Advanced 

Computational Engine (TRACE) and Reactor Excursion and Leak Analysis Program (RELAP5). 

Of these tools, the Configuration Tool, Model Editor and the Job Status tools are most relevant 

to RADTRAD analysis. The Configuration Tool is used to configure global properties for running 

RADTRAD under SNAP. The Model Editor provides a GUI used to develop RADTRAD models. 

The Job Status tool is used to obtain the job status. Of these tools, the Model Editor is the tool 

used the most as it is the primary tool for developing SNAP/RADTRAD models. 

Generally, the approach for developing a new SNAP/RADTRAD model is to define the 

compartments and connections in flow pathways that represent the plant and optionally the 

control room and/or the technical support center being analyzed. Note that flow pathways are 

used to connect components in SNAP/RADTRAD. During the specification of components and 

flow pathways, removal models should be considered and specified for each normal 

compartment as appropriate. For compartments, these removal models include filtration, 

sprays, or natural deposition. The user will need to specify each model required and specify the 

required data using the SNAP GUI as a guide. 

Once the geometric, flow/leakage and removal information is specified for the compartments 

and flow pathways, a source term is then specified. A comprehensive list of nuclides based on 

International Commission on Radiological Protection (ICRP) Report 38 (ICRP-38) [5] has been 

included in SNAP/RADTRAD. The user will need to decide whether the analysis is either being 

done based on the occurrence of a LOCA by selecting either TID-14844, “Calculation of 

Distance Factors for Power and Test Reactor Sites,” [6] or NUREG-1465, “Accident Source 

Terms for Light-Water Nuclear Power Plants,” [7] and for a non-LOCA where both radionuclides 

from the fuel and the reactor coolant activity may be important contributors and make the 

appropriate selections for the plant being analyzed. A plant power level must be defined to 

obtain the correct source term. The physical form of iodine must also be defined as the rate of 

removal and filtration depends on the physical form of iodine. 
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Parameters related to the dose rate are specified, including Χ/Q data for each receptor location 

and dose conversion factors (DCFs). Default DCFs based on EPA-520/1-88-020, “Limiting 

Values of Radionuclide Intake and Air Concentration and Dose Conversion Factors for 

Inhalation, Submersion, and Ingestion,” Federal Guidance Report No. 11 (FGR 11) [8] and EPA- 

402-R-93-081, “External Exposure to Radionuclides in Air, Water, and Soil,” Federal Guidance 

Report No. 12 (FGR 12) [9] (see Section 3.6) are built into SNAP/RADTRAD. The EAB and the 

LPZ are defined by default in SNAP/RADTRAD. Other dose receptors can be added as 

needed. For each dose receptor that is located in the environment or draws from the 

environment such as a control room, time-dependent Χ/Q and breathing rate values must be 

specified. For the control room, occupancy factors must also be specified. Note that default 

values for breathing rates are provided which are suitable for most analyses. 

SNAP/RADTRAD can be used to develop new models and modify existing models. The key 

aspect of model development is the use of compartments and connecting flow pathways to 

model a system. The approach used to prepare this section was to open the SNAP GUI and 

start exploring the features for RADTRAD model development. Therefore, the discussion in the 

following sections assumes that the user has SNAP available and open and that the user will 

follow along with the discussion by using the SNAP/RADTRAD Model Editor. There is no better 

way to learn how to use the SNAP GUI except to actually use it. 

2.2 The Model Editor User Interface- Model Development 

This subsection describes working within the SNAP/RADTRAD Model Editor to develop and 

modify models. 

2.2.1 Overview of Existing Model Features 

As noted earlier, the SNAP/RADTRAD Model Editor is the basic tool used to create, modify and 

run input models. To start the Model Editor, navigate to Start->All Programs->SNAP->Model 

Editor, and the Model Editor should start. 

To illustrate many of the features in SNAP, the Test 23 sample problem will be used. This 

problem is found in the Samples/Radtrad/Test23 subdirectory in the snap directory (see Section 

1.3). It is recommended that a copy of the Test23.med file be placed in the user’s working 

directory, which is the directory where the input and output files will be kept. It is also 

recommended that the user open Test23 and follow along with the presentation in this section. 

When the Model Editor is started, a splash screen appears for several seconds and then 

a Welcome to Model Editor screen appears as shown in Figure 2-1 with the Model Editor 
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window in the background. Note that if a previous Model Editor session has been exited without 

first closing the model in use then the Restore Session prompt screen will open, as also shown 

in Figure 2-1. 

Several options are available on the Welcome to Model Editor screen, which are listed below: 

• Create A New Model 

• Open a Model Document 

• Import a New Model 

• Start an Empty Session 

• View Online Training Tutorials 

• SNAP Version Updates 

Under each of these items a short description of each option is provided to explain what each 

option does. 

 

 

 Figure 2-1 Opening the Model Editor 
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Once the SNAP Model Editor is open, the user can open sample Test23 by selecting the link 

under Open a Model Document as shown in Figure 2-1, navigate to the location of the Test23 

subdirectory under the samples directory found in the installation location of SNAP, and click 

on the file Test23.med. The Model Editor rendering of Test23 will open as shown in Figure 2-2. 

If not, click on the “default view” tab at the bottom of the page to see this view. Alternately, the 

user can open the Test23.med file in the working directory to start the SNAP Model Editor. 

Finally, the model can also be opened by selecting File->Open, navigating to the input file (.med 

file) of interest, selecting that file and clicking on open, much like any Windows program. Notice 

that there are three separate input sections in the SNAP Model Editor window shown in Figure 

2-2 which are: the Navigator window, the Property window and the View / Dock window where 

the model rendering appears. Also, notice that there are two tabs in the View / Dock window 

labeled Default View and Test23 View. In Figure 3-2 the Default View for Test23 is shown 

which gives the model rendering for Test23. The Test23 View provides the job stream view for 

Test23 and the tabs can be clicked-on to show either the modeling rendering or the job stream 

(similar to Microsoft Excel). Job streams will be discussed later in this section. There is also a 

Message window underneath the View / Dock window which lists messages from 

SNAP/RADTRAD. 

Before editing, the user should note that each of the windows shown in Figure 2-2 can be 

resized either horizontally or vertically. Resizing is done by hovering the mouse cursor over the 

border between the windows until a double-headed arrow appears. Then the user clicks and 

drags the border to the desired location. The user will need to unlock the model by clicking on 

the Lock ( ) icon shown in Figure 2-2. Notice that other icons adjacent to the Lock ( ) icon will 

change to unlocked ( ) on the toolbar. 
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Figure 2-2 SNAP Model Editor Screen 

One powerful feature in SNAP/RADTRAD is the ability to check the model for input errors. To 

illustrate the use of this feature, click on Tools->Check Model to perform a model check. Note 

that the message Note: Model check complete. No errors found in the Message window at the 

bottom of the screen. 

The input groups are shown in the Navigator window. Clicking on the Expand (  ) icon will 

expand each group and node, showing the associated input data for that input group and node. 

Figure 2-3 presents an illustration of a node expansion which is obtained by clicking on the 

Expand (  ) icon next to Compartments, then clicking on Compartment 1. Note that 

Compartment 1 input appears in the Property window (lower left). The user should experiment 

with other input groups as the approach is the same. Input specification will be presented later in 

this section. 

Note that the black bar where the input model name appears (Test23.med) contains some 

important features which are summarized in Section 2.4. One of these features is the ability to 

switch units from British to International System of Units (SI). Units switching is done by right-

clicking on the black bar, selecting Engineering Units->British to change the units from SI to 

British. 
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Figure 2-3 Illustration of the Expand Icon 

Icons are used to represent the various components used in the View / Dock window that 

comprise a typical model. Figure 2-4 presents an illustration of the various icons used. 
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Figure 2-4 Illustration of the Various Icons used to Represent a SNAP/RADTRAD Model 

1.1.1 Job Streams and Case Execution in SNAP/RADTRAD 

Before continuing the discussion of existing model features and developing a new model, the 

Test23 case will be run to illustrate how cases are run. 

Case execution is dependent on the job stream, which may be a source of confusion for new 

SNAP/RADTRAD users. Simply put, job streams are used to pass input and output data from 

one code to another for cases where multiple codes are used. SNAP is used to support a wide 

variety of analysis programs that pass data from one program to another. This feature is less of 

an issue with SNAP/RADTRAD because in most cases, output from SNAP/RADTRAD 

(RADTRAD-AC) is only passed to AptPlot for plotting. For the convenience of the user, a 

default job stream is predefined for all SNAP/RADTRAD cases. 

Figure 2-5 presents a typical SNAP/RADTRAD job stream. The default job stream for 

SNAP/RADTRAD shows three steps: 1) input preparation shown in the RADTRAD Model 

(Base_Model node), 2) the analytical code execution in the RADTRAD (RADTRAD node) 

(middle box in Figure 2-5), and 3) the passing of plot data from SNAP/RADTRAD to AptPlot 

(PlotStep node). The input is passed from the Model Editor (Base_Model node) to the 
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RADTRAD-AC (RADTRAD node) and then the plot file data generated by the RADTRAD-AC is 

passed to the AptPlot (PlotStep node). 

 

 

Figure 2-5 Typical Job Stream in SNAP/RADTRAD 

As in the case of model input, job streams specification can also be checked. In the case of the 

Test23 problem, expand the Job Stream node in the Navigator window; select Test23 and right- 

click, then select Check Stream. An error report window will appear in the Message window 

and in this case, no errors were found. 

Part of the job stream input specification is to determine where the RADTRAD-AC output will be 

written. To display the location of the RADTRAD-AC output clicking on the Expand (  ) icon for 

the Job Streams node and select the Test23 job stream to open the Property window as 

illustrated in Figure 2-6. 

 

Figure 2-6 Job Stream Property Window 
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The two job stream properties which determine where the output is written are the Root Folder 

text box and the Relative Location text box. The SNAP/RADTRAD output is then the Relative 

Folder location appended to the Root Folder location. To review the root folder settings, click on 

the Custom Editors ( ) icon and a window similar to that shown in Figure 2-7 appears. In this 

example, three root folders along with the path locations are shown. 

 

Figure 2-7 Typical Root Folder Settings in SNAP/RADTRAD 

Assuming that the root folder is set to Samples, the path to the output will be Samples\RADTRAD 
or C:\Work\Current\0-RADTRAD\Training\Samples\RADTRAD. In a new installation, the root 
folder is not set. When the root folder is not set, the message No Root Folders Available appears 
in red as shown in Figure 2-8. 
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Figure 2-8 Job Stream Property Window with an Unset Root Folder 

Setting the root folder requires selecting the Custom Editors ( ) icon under the Root Folder text 
box to open the Edit Calculation Server Root Folders window (Figure 2-7). Click on the New 
( ) icon and navigate to the desired location in the Select Folder Location window. The root 

folder name will change to the last folder name in the directory path. 

The relative location can be reset and should be reset to a name more mnemonic so that the 

SNAP/RADTRAD cases can be tracked. For example, to change the name, highlight the 
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Relative Location Name and type in a new name (Sample_Test23). Note that the file location is 

automatically appended. 

Note that multiple root folders are allowed which is handy for organizing SNAP/RADTRAD case 

files. To add a root folder, click on the ( ) icon next to Root Folder in the Test23 job stream. 

Click on the New ( ) icon (left on Toolbar) and navigate to where you want the root folder (ex. 

NPP Dose Analysis). The root folder path will be created. Also, a path of subdirectories can be 

specified in the Relative Location text box separated by a back slash ( / ). For example, the 

relative location can be set to RADTRAD/LOCA, so that the path to the output would be 

Samples/RADTRAD/LOCA assuming that the root folder is set to Samples. 

A couple of points should be noted about root folders. First, the root folder directory needs to 

exist – otherwise you’ll get a warning that the directory doesn’t exist and the root folder will 

not be defined. Second, overlapping paths are not allowed and will generate an error. 

Finally, one remaining item should be configured before proceeding to submit the job stream 

for execution. This remaining item is to the link the SNAP Model Editor to the RADTRAD-AC 

by navigating to Tools->Configuration Tool to open the SNAP Configuration window and then 

expanding the Applications node by clicking on the Expand (  ) icon. After the Applications 

node has been expanded, right click the Applications node to open the drop-down menu as 

shown in Figure 2-9. Select New on the drop-down menu to open the Create Application 

window. Enter RADTRAD in the Application Name text box and scroll down to select 

the RADTRAD application and click OK as shown in Figure 2-9. 
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Figure 2-9 Linking the RADTRAD-AC Using the SNAP Configuration Tool 

The SNAP Configuration window will then change to display the RADTRAD application with 

an error under the Applications node (Figure 2-10). On the right-hand side of the SNAP 

Configuration window under the Application Location->Local Location text box click the Select 

( ) icon to open Windows File navigator. Navigate to radtrad subdirectory under the snap 

directory in the in the user’s home directory as discussed in Section 2.3.3 and select the 

radtrad.jar file for the RADTRAD-AC (not the RADTRAD Plugin). (Note: The file directory 

path should look something like “C:\Users\{User Name}\snap\radtrad\radtrad.jar” and not 

“C:\Users\{User Name}\snap\Plugins\radtrad.jar.”) Be sure to save these changes by 

selecting the Save ( ) icon and the Close button on the Save Complete window as shown in 

Figure 2-10. At this point, the user can run Test23. 
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Figure 2-10 Saving the RADTRAD-AC using the SNAP Configuration Tool 

 

To run the Test23 or any other case, click on Tools->Submit Job. A Submit Job Stream window 

will appear as shown in Figure 2-11. Click on OK and a confirmatory Submit Stream window 

will appear. Finally, click OK and the run will start. The SNAP Job Status window will appear 

which is also shown in Figure 2-11. The SNAP Job Status window, in Figure 2-11 displays a 

completed job stream run. If an error message shows up saying that there is an invalid job 

stream, delete the Test23 job stream and create a new Basic stream by right clicking on Job 

Streams and selecting new.  
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Figure 2-11 SNAP/RADTRAD Job Stream and Status Windows 

The relationship between the SNAP/RADTRAD job stream and the actual case execution is 

shown in Figure 2-12. In the upper left-hand corner, the graphical job stream representation is 

shown. As noted earlier, this representation shows passing input from the Model Editor to the 

RADTRAD-AC and then to AptPlot. The job stream properties are shown in the Navigator 

window shown in the upper-right corner of Figure 2-12. The links between the various nodes 

are also shown. In the SNAP Job Status window, the status of each of the job stream steps is 

shown. Again, three steps are shown. The user interaction with the SNAP Job Status window 

will be discussed in Section 2.2.3. 
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Figure 2-12 Relationship Between Job Stream Steps and Code Execution 

Note that the SNAP Job Status window can be accessed from Tools->Job Status in the Model 

Editor for subsequent viewing. A summary of features relevant to SNAP/RADTAD available in 

the SNAP Job Status window are listed below: 

• The Job Console ( ) icon – provides the time step history for the current job. 

• The Job Execution ( ) icon – terminates the execution of the current job. This is only 
available when the job is running. 
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• The Job Deletion ( ) icon – removes the current job and files. 

• The AptPlot ( ) icon – opens the selected job for plotting in AptPlot. 

• The File Viewer ( ) icon – starts the output file viewer. 

2.2.2 SNAP/RADTRAD Input and Output Files 

There are several files produced that the user should be aware of in SNAP/RADTRAD. The 

main SNAP/RADTRAD interface file is the casename.med file where casename is the name of 

the case being analyzed. The casename.med file contains the data needed to render the 

model in the SNAP GUI, the default data used by the code and the user-specified input data. 

Section 2.4 discusses the actual input that can be specified for a SNAP/RADTRAD model. 

When a SNAP/RADTRAD case is executed through the RADTRAD-AC, the data flow is not 

directly from the casename.med file. Rather, there are several data files that are produced by 

the SNAP/RADTRAD plugin that are read by the RADTRAD-AC. These files, which are in 

extensible markup language (XML) format, include DCFs (.dfx), nuclide data (.nix), plant 

information (.psx), release fraction (.srx), and nuclide inventory (.icx) files. Output files (.out, 

.screen, .log, and .plot) are produced by the RADTRAD-AC. Log files produced by 

SNAP/RADTRAD are job stream related files (.streamlog and .tasklog). Table 2-1 provides a 

brief description of these files. 

When case execution is completed, the SNAP/RADTRAD output can be reviewed by clicking on 

the File Viewer ( ) icon. Note that there is a context in terms of the active job stream step and 

the output that is displayed. If the casename step is highlighted, then the job stream log will be 

available for viewing. If the RADTRAD step is highlighted as shown in the SNAP Job Status 

window in Figure 2-13, then the RADTRAD-AC output is available. If the PlotStep is 

highlighted, then the plot file data can be viewed using AptPlot. Figure 2-13 shows a 

screenshot of the drop-down menu cascade from the File Viewer ( ) icon for the RADTRAD job 

step from the SNAP Job Status window. 
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Figure 2-13 Drop-down Menus for SNAP/RADTRAD Output 

Table 2-1 Files Available for Viewing Using the File Viewer in the Job Status Window 

File Name Description 

Job Status Window Casename Files 

 

 

StreamLog - Casename.streamlog a 

Output from job stream manager. Provides a high- 

level summary of the execution steps for the job 

stream. Typically not reviewed by the 

SNAP/RADTRAD user. 

Job Status Window RADTRAD Files 

Plot Files->plot - radtrad.plt c Data file for AptPlot from the RADTRAD-AC. 

 

 

 

 

Text Files->input – radtrad.psx b 

Plant data input file in XML format. Includes the plant- 

specific data specified by the user including model 

parameters, information for plant geometry for each 

compartment, information for each flow path, dose 

point information including Χ/Q and breathing rates, 

occupancy factors, and information for various 

radionuclide removal models (sprays, natural 

deposition, and filters). 

 

Text Files->nix – radtrad.nix b 

Nuclide data information from ICRP-38 in XML format. 

Includes the atomic mass, half-life (s), and branching 

ratios for radionuclide daughters. 



29  

 

 

 

 

Text Files->dfx – radtrad.dfx b 

DCF file in XML format based on FGR 11 and 12 (see 

Section 4.6). Includes the organ-specific DCFs. Note 

that only the cloudshine (immersion), the inhaled 

chronic [total effective dose equivalent (TEDE)] and 

thyroid skin DCFs are used to determine dose. 

Organ-specific factors as well as those factors for 

groundshine, inhaled acute and ingestion are not 

used. 

Text Files->icx_1 – radtrad_1.icx b 

Text Files->icx_2 – radtrad_2.icx b 

(etc.) 

 

Initial radionuclide inventory file in XML format. 

Duration of source term release and release fractions. 

Text Files->srx_1 – radtrad_1.srx b 

Text Files->srx_2 – radtrad_2.srx b 

(etc.) 

 

Release fraction information file for each radionuclide 

group. 

 

Text Files->output – radtrad.out c 

Output file from the RADTRAD-AC in the original 

format. 

 

Text Files->NRC-out – radtradNRC.out c 

Output file from the RADTRAD-AC in the revised NRC 

format. 

Text Files->log – radtrad.log a Debug output. Includes warnings and errors useful to 

users and developers. . 

 

Text Files->screen – radtrad.screen c 

Problem time output to show progress of a given 

case. 

 

Text Files->Task Log – RADTRAD_tasklog a 

Output from SNAP job steam showing RADTRAD job 

step execution information (usually not referred to by 

the user). 

Job Status Window PlotStep Files 

PDF Documents – time_pdf – time.pdf c Time step results (usually not referred to by the user). 

 

Text-Files->screen – aptplot.screen 

Screen output from AptPlot (usually not referred to by 

the user). 
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Text-Files->Task Log – PlotStep.tasklog 

Output from SNAP job steam showing AptPlot job 

step execution information (usually not referred to by 

the user). 

a. SNAP/RADTRAD specific output. 

b. Input file to the RADTRAD-AC generated by SNAP/RADTRAD plugin. 

c. Output file from the RADTRAD-AC. 

The files produced by the RADTRAD-AC code which 

are radtrad.out, radtradNRC.out, radtrad.plt, and radtrad.screen are the most relevant to the 

user. The radtrad.out file is basically the original (Version 3.03/3.10) output file. Major sections 

of this output file are: 

• Input listing – provides a listing of the input in XML format that is used by the 

RADTRAD-AC. 

• Input echo – provides an edited input summary of plant description (model), scenario 

(radionuclide source term/DCF) information, compartment/pathway data, Χ/Q, DCF 

and decay data, and other relevant input. 

• Breakdown of dose results and nuclide inventory in various compartments at various 

time points generally selected by changes in events (i.e. time at which flow rate 

changes, and time at which Χ/Q changes). Activity balance information is also given. 

• I-131 inventory in various compartments as a function of time. 

• Cumulative dose results at various dose locations as a function of time. 

• Worst two-hour doses at the EAB and the final doses and final doses for the LPZ and 

other dose locations. 

The output contents can be controlled from Model Options node by expanding the Output 

Parameters tab in the Property window as shown in Figure 2-14. The main difference in the 

output is generally the editing of results for supplemental time steps when they are used and the 

model removal/decontamination factors. The Output Parameters flags are discussed in more 

detail in Table 2-5. 
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Figure 2-14 Expanded Output Parameters Tab in the Property Window 

The radtradNRC.out output file provides a time-dependent summary of activity and dose 

calculations by nuclide. The contents of the radtradNRC.out file are controlled by expanding 

the NRC Output Flags tab under Model Options node in the Property window. See Figure 2-15 

for the output parameters available. Major sections of this output are: 

• Input echo – provides an edited input summary of plant description (model), scenario 

(radionuclide source term/DCF) information, compartment/pathway data, Χ/Q, DCF 

and decay data, and other relevant input. 

• Output – activity distribution, cumulative and dose difference (delta-dose) for each 
dose component (inhalation, cloudshine, skin, thyroid, and TEDE). 

• I-131 inventory in various compartments as a function of time. 

• Cumulative dose results at various dose locations as a function of time. 

• Worst two-hour doses at the EAB and the final doses and final doses for the LPZ and 
other dose locations. 

The NRC Output Flags are discussed in more detail in Table 2-5. The radtrad.screen file lists 

the time step history for a given SNAP/RADTRAD case. 
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Figure 2-15 Expanded NRC Output Flags Tab in the Property Window 

2.2.3 AptPlot Plotting Program 

A feature of SNAP/RADTRAD is the ability to display plots of dose results. To display a plot, 

click on Plot Files and select plot – radtrad.plt. AptPlot will open. Alternately, click on the 

AptPlot ( ) icon in the SNAP Job Status window and AptPlot will open as illustrated in Figure 2-

16. 
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Figure 2-16 SNAP/RADTRAD Job Status Window with AptPlot Icon Highlighted 

When AptPlot opens, the windows presented in Figure 2-17 will appear. Dose information by 

dose location (ExclusionAreaBoundary, LowPopulationZone, and ControlRoom spaces omitted) 

and dose category (body, cloudshine, skin, tede, and thyroid) for each nuclide separated by 

periods will be presented in the Select EXTDATA Channels window in Figure 2-18. In AptPlot, 

each data set is referred to as a data channel. Test Problem 23 is used to illustrate the features 

of AptPlot and it is suggested that the user open AptPlot for Test Problem 23 and follow the 

discussion below. 
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Figure 2-17 AptPlot Startup View 
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To make a plot, the user scrolls to the result of interest, highlights that result, clicks on the Plot 

button and the plot will appear. Note that the default time units are in seconds, but that can be 

changed to hours in the drop-down menu next to Time Units text box on the Select EXTDATA 

Channels window (Figure 2-18) prior to actually generating the plot. 

AptPlot has many features for generating and formatting plots and the discussion presented 

here is not meant to be exhaustive. A comprehensive help manual can be obtained by 

selecting Help->Help Topics from the top menu. However, some of the more commonly used 

features are illustrated here. 

As the user gains familiarity with the naming convention, the filter feature can be used to locate 

specific results of interest by entering the dose location, dose category, and nuclide of interest in 

the Filter text box (Figure 2-18). If the user wants to plot the TEDE dose results for the control 

room, enter the text string ControlRoom.tede* in the Filter text box. Note that the total TEDE 

dose ends with tede (i.e. no nuclide is listed). Also note that the asterisks (wildcard) symbol is 

used to control the list of all items. Wildcards can be embedded in the string (i.e. 

ControlRoom.*.I*) to list the control room dose categories for all iodine nuclides. It is very 

important to note that the case of a character counts in applying filters in AptPlot, otherwise the 

wildcard search feature will not work properly. The spelling of the dataset name in the data 

channel window provides a guide for spelling a channel name. 
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Figure 2-18 Select EXTDATA Channels Window for Multiple Plots 

Multiple data results can be plotted by highlighting the data of interest and clicking the Plot 

button. As an example, suppose the user wants to plot the thyroid dose for I-131 through I-135 

for Test Problem 23. The user would enter ControlRoom.thyroid.I* in the Filter text box, then 

select the resulting data channels in the Select EXTDATA Channels window and click on the 

Plot button to make the plot. This string can be shortened to C*R*th*I* as a further example of 

the application of wildcards. To select multiple data channels requires the use of shift-click or 

control-click feature as described below: 
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• Shift-click – used to select a range of datasets. In this case, click on 

ControlRoom.thyroid.I131. Then hold down the shift key and select 

ControlRoom.thyroid.I135. 

• Control-click – used to select multiple datasets one at a time. Hold down the control key 

and click on each dataset, selecting that dataset. Each dataset is highlighted after 

selection. 

With either approach, all of the dose datasets will be highlighted as shown in Figure 2-18. Once 

the datasets are highlighted, click on the Plot button and the plot will be generated. The 

resulting plot is shown on Figure 2-19. 

 

Figure 2-19 Control Room Dose Plots for Test23 
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Adjustments can be made to the plot by using the plot editing features in AptPlot. These 

features are accessed by selecting Plot in the top menu. A number of features are available, 

but generally Plot->Graph appearance, Plot->Set appearance and Plot->Axis properties provide 

the features needed to edit the plot. Screenshots of each of these windows are shown in 

Figures 2-20 through 2-22. Clicking on the tabs in each window shows various properties and 

features available to the user. A subset of these features is used to edit the plot. 

Some typical AptPlot adjustments are illustrated below: 

• Change the x-axis scale from seconds to hours: – Navigate to the Select EXTDATA 
Channel window shown in Figure 2-18 and click on Clear Sets in the lower left-hand 
portion of the screen. Then change the units in the Time Units drop-down menu from 
Seconds to Hours. Confirm that the dose components are highlighted as 
shown in Figure 2-18 using shift-click or control-click. Then, click on Plot and 
Time (hours) will appear on the x-axis. 

• Reset y-axis to logarithmic scale: – Given that the I-131 dose is so dominant, it is hard 

to read the dose contributions from the other iodine nuclides. The y-axis scale can be 

changed to logarithmic by selecting Plot->Axis properties to open the Axes window 

(Figure 2-20). Change the axis setting in Edit text box from X axis to Y axis and click 

on the Main tab if it is not already selected in the Axes window (Figure 2-20). Then 

change the Scale text box from Normal to Logarithmic and click the Apply button to 

change the y-axis to logarithmic. 

• Expand y-axis to cover dose range: – The dose range can be expanded by changing 

the Start and Stop values to 0.0001 and 10.0 in the Axes window. The Axes window is 

obtained by selecting Plot->Axis properties to open the Axes window (Figure 2-20). 

Click on the Main tab if it is not already selected. Change the edit box to Y axis. Then, 

enter 0.0001 in the Start text box and 10.0 in the Stop text box. Then click the Apply 

button to apply the change. 
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Figure 2-20 AptPlot Axes Window 

• Use scientific notation for the y-axis: – The format for the y-axis labels is set by changing 

the Edit drop-down menu setting in the General section of Figure 2-20. Then, set the 

number format in the Format drop-down menu in the Tick properties section to Scientific 

from General. Also set the precision to 0 in the Precision drop- down menu and click the 

Apply button to reset the format. 

• Line colors: – The line colors selected by AptPlot can be hard to see. Each line 

color can be individually adjusted by the user. To adjust a line color select Plot-

>Set appearance to open the Set appearance window (Figure 2-21). Highlight the 

dataset to be changed in the Data sets section near the top of the Set appearance 

window (Figure 2-21). Note that the name of the data contained in a given dataset 

is identified by the String text box in the Legend section in the lower part of the 

window. Also, note that the current color of a particular dataset is shown in the 

Color drop-down menu in the Line Properties section. Using that drop-down menu, 

select the desired color and click on the Apply button. Alternately, to change the 

color of all lines to black for example, highlight all datasets using shift-click or 
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control-click or alternately clicking on the All button. Then, select Black in the Color 

drop-down menu (if it is not already selected) and click on the Apply button. 

 

Figure 2-21 AptPlot Set Appearance Window 

• Line symbols: – Symbols for the lines are set from the Main tab in the Set appearance 

window (Figure 2-21). To select a symbol for a particular data set, highlight the dataset 

in the Data sets section, then select a symbol type (circle, square, etc.) under the Type 

drop-down menu in the Symbol Properties section. Also, select the desired color in the 

Color drop-down menu and click the Apply button. A symbol will appear for each data 

point and since there are hundreds of data points, a symbol skip will have to be set. 

Select the Symbols tab in the Set appearance window and highlight the dataset to be 

changed. Then, set the Symbol skip to a value like 50 or 75 and click on the Apply 

button. This setting will display a symbol for every 50th or 75th point. Repeat these steps 

for each dataset. 

• Line style: – Line styles (solid, dash, dot-dash, etc.) can be set by selecting the Main tab 

in the Set appearance window (Figure 2-21), highlighting the desired data set in the 

Data sets sections and selecting the desired style using the Style drop-down menu in the 

Line Properties section in a manner similar to setting line colors and line symbols. Each 
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line is set individually, and then click the Apply button as the settings for each dataset 

are completed. 

• Titles and subtitles: – To add a title and subtitle to the plot select Plot->Graph 

appearance to open the Graph appearance window (Figure 2-22). In the Main tab 

section enter a title and subtitle as appropriate, then click on the Apply button. The 

title and subtitle will appear. Select the Titles tab and use the sliders to adjust the font 

size for the title and subtitle as desired. Note the font size can be incremented by 

clicking on the channel to the left or right of the slider icon. 
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Figure 2-22 AptPlot Graph Appearance Window 

Sometimes the legend box overwrites the dose results as in the plot shown in Figure 2-19. In 

order to correct this issue, the plot needs to be shrunk, which will require using several AptPlot 

features. These features are listed below: 

• Edit the legend titles: – The title for each legend can be edited. This change is made 

by selecting Plot->Set appearance to open the Set appearance window (Figure 2-21) 

and highlighting the desired data set. Change the title in the String text box in the 

Legend section as appropriate. In this case, the iodine nuclide name is used. Click on 

the Apply button after each title modification is made. 

• Change the font size for the legend: – First, the font size used in legend box will need 

to be reduced, which entails changing the legend title font and the symbol font. To 

change the font size of the legend title, select Plot->Graph appearance to open 

the Graph appearance window (Figure 2-22) and click on the Legends tab. Then, use 

the slider bar to adjust the font size to 75 for example and click on Apply button. The 

font size will change for all datasets. For the symbol size, navigate to the Set 

appearance window (Figure 2-21) and select all datasets. Then, change the Size 

setting in the Symbol Properties section to 75 using the slider. 
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• Change the size of the plot: – The plot overlays a white background which is basically 

set to allow a plot to be printed on 8.5 x 11 paper in landscape mode. So, it is 

desirable to maintain this setting although it can be changed by navigating to View- 

>Page setup. However, the approach used here is to shrink the plot by adjusting the 

settings in the Viewport section in the Graph appearance window (Figure 2-22) by 

entering suitable values. In this case, the X max and Y max text box settings are 

changed to 1.0 and 0.8, respectively. These settings permit the legend box to be 

moved to the right-hand side of the plot, and then click on the Apply button. Then, to 

move the legend box, select the Leg. Box tab in the Graph appearance window (Figure 

2-22) and adjust the box location in the X and Y text boxes in the Location section. 

Values of 1.05 and 0.60 will move the legend box to the right-hand side of the plot. 

Another approach is to change the X max text box setting to 1000 which will allow 

sufficient space for the legend box within the plot frame, although it will probably need 

to be moved for aesthetic reasons. 

The plot is saved by selecting File->Save and then navigating to the desired directory location, 

entering a suitable name, then click on OK, similar to any Windows program. To access a 

previously saved AptPlot plot, select File->Open, and navigate to the directory location where 

the plot file is saved and select that file. Also, the format and title settings can be saved by 

selecting Plot->Save defaults and overwriting the Defaults.agr file. Note that Plot->Reset 

defaults will reset the defaults to the original settings. Figure 2-23 shows the resulting plot with 

the above modifications. Note that plots can be generated in a picture format such as .png or 

.jpeg by navigating to File->Print setup. At the top of the Device setup window, change the 

device to .png for example. In the Output section, check that the directory path and filename 

are suitable. Then, click on the Print button and the plot will be saved in .png format using the 

filename set for the plot file. 
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Figure 2-23 Reformatted Control Room Dose Plots for Test23 

For those users who wish to use a spreadsheet for data analysis or for plotting, the dose data 

can be exported. The easiest way is to initiate a new plot session in a comma-delimited format 

that can be read by Microsoft Excel. This feature is accessed from the Select EXTDATA 

Channels window (Figure 2-18. As an example, set up and apply a filter for the I-131 to I-135 

thyroid dose in the control room and select the resulting data channels as done previously. 

Then, highlight the data channels and click on the Export button at the bottom of the window. 

A Save window will appear. Provide a filename, ending the filename with the .csv suffix and 

select comma separated values (CSV) as the file type (right hand side of the Save window). 

Then, click on Save to write the file. Microsoft Excel will read and organize the dose data by 

column for subsequent use. 
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2.3 SNAP/RADTRAD Model Development and Modification 

Sections 2.1 and 2.2 introduced the SNAP/RADTRAD Model Editor user interface using Test 

Problem 23 as an example. In this section, the details of building a new model are presented. 

For this illustration, a model consisting of a simple containment compartment, leakage pathway, 

source and an environment compartment will be developed. 

2.3.1 Model Editor Menus 

The commands available in the Model Editor are typical of Windows programs. Across the top 

of the Model Editor, the File, Edit, Tools, Window, and Help commands are presented. Table 2- 

2 describes the commands associated with each of these menu items. 

 

Table 2-2 Summary of Model Editor Menu Commands 

Menu Command Description 

File Commands 

 

File->New 

Creates a new model. A Select Model Type menu appears with 

available models listed. The SNAP/RADTRAD user picks RADTRAD 

and clicks on the OK button. 

 

File->Open 

Opens a previously developed model (.med file). The user navigates 

to the directory where the file is located and selects the file to be 

opened similar to any Windows program. 

 

File->Open Recent 

Allows the user to open a recently used SNAP/RADTRAD model (or 

AVF file). The user selects the file of interest and it will open in a new 

Model Editor session. 

 

File->Save 

Saves the current model with the same name as in any Windows 

program. 

 

File->Save As 

Saves the file under a new filename. The user navigates to the desired 

directory location and/or updates the filename and clicks the Save 

button as in any Windows program. 

 

File->Close 

Closes the current model. Provides a warning to the user in the case 

of any unsaved changes made to the model. 

 

File->Close All 

Closes multiple open models. Provides a warning to the user in the 

case of any unsaved changes made to the model. 
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File->Import 

Imports a previously exported RADTRAD model from a set of ASCII or 
XML input files (see Section 3.2.3). Note that a .psf file is an ASCII file 
with the same input data as the XML formatted .psx files. 

 

File->Export 

Exports a set of SNAP/RADTRAD XML input files (.psx, .nix, .srx, .icx, 

and .dfx) to a directory selected by the user 

File->Exit Exits the Model Editor. 

Edit Commands 

 

Edit->Undo 

Reverses previous user inputs to a model similar to most Windows 

program. 

Edit->Redo Redoes a previous undo command similar to most Windows program. 

 

Edit->Preferences 

Allows the user to set various preferences related to fonts, colors, and 

other Model Editor features. 

 

 

Edit->Plugin Manager 

Opens a dialog listing all of the available SNAP plugins. Toggling the 

check-box next to each plugin allows for loading and unloading the 

plugin. This feature is not generally used for SNAP/RADTRAD 

because the RADTRAD-AC only uses the RADTRAD Plugin. 

Tools Commands 

 

Tools->Check Model 

Provides a check of the SNAP/RADTRAD input model. This feature is 

very useful for model development in SNAP/RADTRAD. 

 

Tools->Submit Job 

Submits a model through the job stream and starts the SNAP Job 

Status Tool (see Section 3.2.2). 

Tools->Steam Tables Not used in SNAP/RADTRAD. 

 

Tools->Configuration Tool 

Starts the SNAP/RADTRAD Configuration Tool used to configure 
global properties for running RADTRAD under SNAP 

 

Tools->Job Status 

Starts the SNAP/RADTRAD SNAP Job Status window (see Section 

3.2.2). 

 

Tools->Model Note Viewer 

Displays model notes. The user can set up and edit notes as part of 

the model documentation. 

 

Tools->Export to jEdit 

Exports a model to the jEdit editing program. This feature requires the 

installation of jEdit. 
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Windows Commands 

Windows->Commands Scripting commands window – not used in SNAP/RADTRAD. 

Help Commands 

 

Help->Contents 

Link to the SNAP Model Editor manual, which includes information 

about the RADTRAD Plugin. 

 

Help->Check for Updates 

Checks for updates at the APT, Inc. website. Note that computer 

security settings may inhibit this feature. 

 

 

Help->Report an Issue 

Allows the user to submit Issue Reports on SNAP/RADTRAD directly 

to APT, Inc. Note that issues related to the RADTRAD-AC should be 

reported via the SNAP/RADTRAD Forum webpage under the 

SNAP/RADTRAD Support link on the RAMP website. 

 

Help->About 

Provides information on the SNAP GUI and Plugin version, licensing 
agreements, and contact information. Note that plugin version 
numbers can be obtained by clicking on the Plugins button. 

Figure 2-24 shows the icon arrangement and function of each icon in the Model Editor. Of 

particular interest is the ability to separate the Navigator, Property, and View / Dock windows 

into separate windows and to also arrange the windows vertically by clicking on the 

Single/Multiple Windows Modes icons shown in Figure 2-24. The remaining icons provide a 

shortcut to some of the menu commands listed in Table 2-2. 

 

Figure 2-24 Model Editor Tool Bar Icon Description 
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Figure 2-25 shows the icon arrangement and the function for each icon in the Navigator window. 

Basically, these tools aid the user in navigating component nodes in the Navigator window and 

multiple models in the SNAP GUI. 

 

 

Figure 2-25 Navigator Window Tool Bar Icon Description 

 

2.3.2 Building a SNAP/RADTRAD Model – Component Specification 

The first step is to start the SNAP Model Editor and click on Create a New Model in the Welcome 

screen (Figure 2-1). Alternately, a new model in SNAP/RADTRAD can also be created by 

selecting the File->New command as noted in Table 2-2. Select RADTRAD model in the Select 

Model Type screen and notice that the Model Editor opens with no icons in the View / Dock 

window (similar to Figure 2-2). The basic model nodes are shown in the Navigator window. 

Expand the Compartment [1] node using the Expand ( ) icon in the Navigator window. Highlight 

(click on) the Compartment 1 (Environment) node, so that data fields for this compartment will 

appear in the Property window. Note that an environment compartment is defined by default. 

The basic approach to building a SNAP/RADTRAD model is to set up an array of 

compartments, flow pathways and specify key parameters in the various components of the 

model. For sources, compartments, and pathways that ultimately appear in the View / Dock 

window, the basic pattern is to highlight (select) the component category (i.e. Source, 

Compartments and Pathways), right-click on the component category, and select New from 

the menu to add a numbered component to that component category. These steps result in 

a new model component being created. 
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A new compartment is added by right-clicking on the Compartment node in the Navigator 

window and selecting New from the drop-down menu that appears. A new compartment 

component Compartment 2 is created. Components are not automatically added to the View / 

Dock window and must be added by the user. The new component (Compartment 2) is added 

to the View / Dock window by right-clicking on the Compartment 2 and selecting Add to View-

>Default View from the drop-down menu. Compartment 2 now appears in the View / Dock 

window. 

The new component (Compartment 2) is unnamed. To add a name to the component, type a 

name (i.e. Containment) in the Name text box in the Property window. The name will 

simultaneously appear in both the Navigator and View / Dock windows [Compartment 2 

(Containment)]. Alternately, newly defined components can also be dragged from the Navigator 

window to the View / Dock window by clicking on the component of interest and dragging it by 

holding the left mouse button down and moving the cursor to the View / Dock window. 

The pre-defined Environment compartment is added to the View / Dock window in a manner 

similar to Compartment 2 (Containment) above. Right-click on Compartment 1 (Environment) 

and select Add to View->Default View or drag the component by clicking on the Compartment 1 

(Environment) node and dragging it into the View / Dock window. The environment 

compartment will appear in the View / Dock window. Note that two dose locations (EAB and 

LPZ) are automatically specified with the environment compartment. 

The next step is to define a flow pathway which is done by right-clicking on the pathway group 

node (Pathways [0]) and selecting New from the drop-down menu that appears. Add Pathway 1 

to the View / Dock window by right-clicking on Pathway 1 and then selecting Add to View-

>Default View or drag the component by clicking on the Pathway 1 node and dragging it into the 

View / Dock window. The flow pathway should be named by entering a suitable name in the 

Name text box in the Property window (i.e. Leakage). 

Similarly, a source can be added by right-clicking on the Sources node in the Navigator window 

(Sources [0]) and selecting New from the drop-down menu that appears. After naming the 

component (i.e. Fuel Release), the component can be added to the View / Dock window in the 

same manner as used above for the compartments and flow pathways. 

At this point, the user can see that a pattern is emerging. Each input group has an associated 

group node where components within that group can be defined and added to the Navigator 

window. Figure 2-26 displays the Navigator window for the components added in the previous 

steps above. The component nodes that can be added as part of a model are: Sources, 

Compartments, and Pathways. The nodes for Dose Locations, Natural Deposition, Filters, 

Sprays, and Χ/Q Tables are not drawn, but are defined in the same manner as compartments, 
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pathways, and sources by right-clicking on the component group node and selecting New from 

the drop-down menu that appears. 

The user has developed a new model consisting of a source, a compartment representing the 

containment, a leakage pathway and an environmental compartment. Also, this new model was 

added to the View / Dock window by either dragging the new component nodes to the View / 

Dock window or right-clicking on the new component nodes, then selecting Add to View-

>Default View. Figure 2-27 shows the View / Dock window with the new model’s components. 

Additionally, once the components are added to the View / Dock window, they can be moved 

around by the user for presentation clarity. Make sure the Selection Tool ( ) icon is activated 

before selecting a component icon to be moved in the View / Dock window. Features common 

to most Windows-based programs are available to aid the user in editing and arranging icons. 

The function of each icon can be determined by hovering the mouse pointer above the icon of 

interest. This action should cause a text pop-up to appear with a short statement of the function 

of that icon. The tools and features most commonly used in SNAP/RADTRAD are illustrated in 

Section 2.3.4. 

 

 

Figure 2-26 Navigator Window with Newly Added Model Components 
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Figure 2-27 View / Dock Window for 4-Node Model (Unconnected) 
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Table 2-3 shows all of the icons which are available in the View / Dock window with a 

description of each icon. All of the icons for the compartments, sources and pathways have 

connection points for connecting flow pathways and source components to compartment 

components as illustrated in Figure 2-27. The number in the different icons in Figure 2-27 are 

the component numbers (i.e. the number of Compartments, Pathways, and Sources), which are 

generally consecutive in SNAP/RADTRAD models. 

One feature that the user should be aware of is the orientation feature for flow pathway icons. 

In Figure 2-27, the orientation is pointing right; however, the orientation can be changed to 

pointing up, pointing down, or pointing left by right-clicking on the flow pathway icon and 

selecting Drawn Orientation from the drop-down menu that appears and then pick the desired 

orientation. 

 

Table 2-3 Icons Used in the View / Dock Window 

View / Dock Window Icons Description 

 

 

Compartment Icon 

 

Flow pathway connection point indicated by small circles on 

each edge. Small square at the upper-left corner is a source 

connection point. 

 

Source Icon 

 

Small square at the lower edge is a source connection point to a 

compartment. 

 

Flow Pathway Icon 

 

Flow pathway connection point indicated by small circles on 

each side. 

 

 

Environment Icon 

 

Flow pathway connection point indicated by small circles on 

each edge. Small square at the upper-left corner is a source 

connection point. 
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Icon denoting that natural deposition is active in a component 

(grayed-out indicates inactive). 

 

Icon denoting that a filter is defined in a component (grayed- out 

indicates no filter). 

 

 

Icon denoting that a spray is defined in a component (grayed- 

out indicates no spray). 

The next step is to connect the components using the Connection Tool ( ) icon shown in 

the View / Dock window tool bar (see Section 2.3.4). Connection points for the various icons 

are shown in Figure 2-27. These connection points are indicated by circles and squares on 

the periphery of the icons. The first step is to click on the Connection Tool ( ) or (cross 

hairs) icon in the View / Dock window tool bar, which activates the connection tool. Then for 

compartment to flow pathway connections, click on the connection point (circle) on the edge 

of the compartment to be connected and drag holding the left mouse button down to the 

desired connection point (circle) on the flow pathway icon and release the button. The 

procedure is the same for the source to compartment connections except the connection 

points are denoted by squares. Note that square connection points can only be connect to 

other square connection points and likewise circle connection points to only other circle 

connection points. Figure 2-28 shows the model with the connections made. 

 

Figure 2-28 View / Dock Window for 4-Node Model (Connected) 

Figure 2-29 shows the expanded node view of the Navigator window corresponding to all the 

components modeled in Figure 2-28. Basically, it is an expanded node view of the schematic 

representation shown in Figure 2-26. Users should get into the habit of naming the various 
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components of their models. This practice will help avoid errors, particularly as models get more 

complicated. 

 

 

Figure 2-29 Navigator Window with all Nodes Expanded 

2.3.3 Building a SNAP/RADTRAD Model – Input Specification 

Input specification is the next step in developing a SNAP/RADTRAD model. The Model Editor 

design basically guides the user through the various input parameters required. Clicking on any 

of the defined compartments presents a list of input data that needs to be specified in the 

Property window. Also, an important feature in SNAP/RADTRAD is the ability to check the 

model using the Check Model feature which is found by navigating to Tools->Check Model. 

This illustration will start by completing the input for Compartment 2 (Containment) shown in 

Figure 2-28. The volume of this compartment will be set to 2.5E+06 ft3. Note that the default 

units of the Model Editor are in SI. To switch units to British units, right-click on the black bar in 

the Navigator window, select Engineering Units->British from the drop-down menu to change 

the units. Figure 2-30 shows the location of the black bar and the accompanying drop-down 

menu. Once the desired units are selected, click on the Compartment 2 (Containment) icon in 

the View / Dock window or in the Navigator window to open the Compartment 2 (Containment) 
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Property window. Enter 2.5E6 in the Volume text box in the Property window. Also check that 

the Compartment Type text box is set to Normal. Other compartment types are discussed in 

Table 2-8. Figure 2-31 shows the Property window with the volume set to 2.5E6. Note that 

deposition, filter, and sprays models are not used. 

 

 

Figure 2-30 Navigator Window with the Balck Bar Menu for the Engineering Units Selection 

 

Figure 2-31 Property Window with Volume Entry for Compartment 2 (Containment) 

Input for the flow pathway involves a data entry table to capture the time dependence of the 

assumed containment leakage rate of 0.1 percent per day (%/day). The first step is to change 

the Pathway Type text box in the Property window from Piping (default) to Air leakage (typically 

used for containments). Next, specify a leakage rate by clicking on the Custom Editors ( ) icon 
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adjacent to the Leakage Rate text box to open the Editing Leakage Rate window Figure 2-32. A 

data entry table window will open, which is one of the most common ways to specify input 

entries in SNAP/RADTRAD. 

 

 

Figure 2-32 Pathway Input Windows for Sample Problem 

The user can click on the Add button and add a leakage rate of 0.1 %/day for 0 to 720 hrs. Two 

rows will be needed in this instance. Users should be aware that there are several ways of 

entering the data using the Custom Editors ( ) icon and the edit table features in 

SNAP/RADTRAD. Some users prefer to set up the number of rows needed for all the data prior 

to entering the time and leakage rate data (e.g. select the Add button twice for this entry). While 

other users prefer to enter one row of data at a time before adding another row to the table. 

When using the second method, users should note that if a cell in an existing row is highlighted 

then the Add button will add the row before the existing row in the table. Likewise, if there is no 

cell highlighted in a row and the Add button is selected then the row will appear as the last entry 

row on the table. The user should also note that when new row is added the row will contain 
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“Unknown” in the data cells to be entered by the user. To enter data into the newly created cell 

the user should select the cell with the mouse and enter the data. The Tab button on the 

keyboard allows the user to move from cell to cell without selecting the cell with the mouse. 

Data initially entered into a cell will appear in red until the user selects the Enter or the Tab key 

on the keyboard to move to the next cell in the row. Finally, the SNAP Model Editor also allows 

the user to sort data entered out of sequential order by selecting the Sort button on the bottom 

of the Editing Leakage Rate window (Figure 2-32). To delete a row, highlight the row to be 

deleted and click on the Remove button. 

The next step is to specify the Χ/Q tables. The Χ/Q values used for this illustration are listed in 

Table 2-4 and the approach is basically the same as that used for the data table entry for the 

flow pathway. The first step is to click on the Expand ( ) icon next to the Χ/Q Tables node in 

the Navigator window, then click on Χ/Q Table 1 (Exclusion Area Boundary) node. In 

the Property window for the Χ/Q Table 1 (Exclusion Area Boundary) click on the Custom Editors 

( ) icon adjacent to the X/Q Table text box to open the Editing X/Q Table window Figure 2-33. 

As in the case of the Editing Leakage Rate window described above, the user can enter X/Q 

values from Table 2-4 in the Editing X/Q Table window. Using the Add and Remove buttons, 

the X/Q values for the EAB and LPZ can be completed by the user. With version 5.1.0 and later 

of RADTRAD, users can specify the timing option for the X/Q tables if Regulatory Guide 

Revision is set to Rev 1 in the model options. This can be done by clicking on the X/Q Table 

main section (not the individual table) and checking the box next to X/Q Time Option. A drop-

down menu will become available and then the option for Time or Duration can be picked. The 

Time option remains as the figure shows below. The Duration option will instead set the 

duration of time that the specified X/Q value will be used but the duration will not be linked to a 

specific problem time. When this option is picked, RADTRAD-AC picks the problem time to use 

the X/Q values depending on when the worst two-hour dose occurs for each compartment. The 

highest or worst X/Q value in table will be used at the time of the worst two-hour dose. If the 

duration of the highest or worst X/Q value is longer than 2 hours, then the remaining time is split 

evenly before and after the worst two-hour period. The remaining X/Q values and durations are 

used in descending order of the value. If the total duration time listed in the X/Q tables do not 

sum up to the total problem time, then the smallest X/Q value is used for the remainder of the 

time. The output will show the times that the X/Q values are used when this option is chosen. 

Figure 2-33 also shows the completed Editing X/Q Table windows. 
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Table 2-4 Sample Problem X/Q Values 

 

Time Interval 

(hrs) 

Χ/Q Value by Location 

(sec/m3) 

EAB LPZ 

0 – 2 1.4E-04 4.5E-05 

2 – 8  2.39E-05 

8 – 24  1.29E-05 

24 – 96  5.49E-06 

96 – 720  1.61E-06 

 

Figure 2-33 X/Q Input Tables for EAB (Left) and LPZ (Right) 
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The final item to be completed is the source term specification. The source term specification 

consists of two parts. The first part is to specify the radionuclide inventory in the fuel or reactor 

coolant and the second is the source or release fraction scenario specific to the accident type. 

Both combine to generate the radionuclide inventory to determine an overall source term. 

Additionally, there is also the setting for core power in the Model Options node that is used to 

determine the radionuclide inventory. 

There are two sample default core inventory libraries (PWR and BWR) from Tables 1.4.3.2-2 

and 1.4.3.2-3 of NUREG/CR-6604, which are not editable by the user. 

• PWR – normalized Methods for Estimation of Leakages and Consequences of 

Releases (MELCOR) / Accident Consequence Code System (MACCS) sample 3412 

megawatt thermal (MWth) PWR core inventory (60 nuclides). 

• BWR – normalized MELCOR/MACCS sample 3578 MWth BWR core inventory (60 

nuclides). 

To view and access these sample default core inventory libraries in SNAP/RADTRAD, left click 

on Nuclide Data node in the Navigator window and locate the Total Inventories text box in the 

Property window. Select the Custom Editors ( ) icon adjacent to the Total Inventories text box 

to open the Editing Total Inventories Window Figure 2-34. The basic editing features for the 

Edit Total Inventories window is also shown in Figure 2-34. These features can be used to 

either edit an existing file or specify a new inventory file. For example, the PWR inventory file 

can be duplicated by selecting the PWR inventory and then clicking on the Copy Existing File 

icon which will make a duplicate and append a number to the file that can then be renamed by 

the user. Once a copy is made, the data becomes editable. Nuclides can be added, deleted, 

and rearranged using the Nuclide Editing Tools shown in Figure 2-34. In addition, nuclide files 

can be exported and imported. The user should note that values in the Inventory (Ci) column 

will appear as “Unknown” until the plant power lever is entered as described below. 

For this illustration, the generic PWR inventory with a core power level of 3637 MWth and the 

alternative source term release fractions from Regulatory Guide 1.183 (RG 1.183), “Alternative 

Radiological Source Terms for Evaluating Design Basis Accidents at Nuclear Power Reactors” 

[10] will be demonstrated. The source specification steps are as follows: 

• Left-click on the Model Options node in the Navigator window, locate the Plant Power 

Level text box in the Property window and set the plant power level to 3637 MWth as 

shown in Figure 2-35. 
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• Expand the Sources [1] node and left-click on Source 1 (Fuel Release), locate Source 

Scenarios text box in the Property window and left-click on the Custom Editors ( ) 

icon. In the Edit Inventory Scenarios window, add a new scenario by clicking on 

the New ( ) icon. When the Select from Total Available Inventories window opens 

select PWR and click the OK button to return to the Edit Inventory Scenarios window 

as shown in Figure 2-36. 

 

 

Figure 2-34 SNAP/RADTRAD Edit Total Inventories Window Editing Features 
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Figure 2-35 Setting the Power Plant Level 
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Figure 2-36 Selecting from Available SNAP/RADTRAD Inventories 

• Enter the name PWR Source in the Scenario Name text box on the Edit Inventory 

Scenarios window. Notice that the Active Scenario name changes to PWR 

Source. Under the Accident Parameters tab, pick the DBA AST option under 

the Accident Type drop-down menu and select the PWR button under Defaults Type 

(see Figure 2-37). 

• At this point, the user should review the data comprising the source term by clicking on 

each tab in the Edit Total Inventories window and noting the progression of the 

calculations leading to the total source term definition. 

• Clicking on the Adjusted Inventory tab will list the core inventory based on the generic 

PWR file as shown in Figure 2-38. Note in Figure 2-38 that there are two columns. 

The column labeled Amount (Ci)/MWth lists the activity in curies (Ci)/MWth and the 

column labeled Inventory lists the total activity in Ci. Note that the inventory is 

calculated using the values in the Amount (Ci)/MWth column and the Plant Power 

Level set previously in the Model Options node. 
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Figure 2-37 Edit Total Inventories Window Accident Parameters Tab 

 

Figure 2-38 Edit Total Inventories Window Adjusted Inventory Tab 
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• Clicking on the Release Fractions and Timings tab displays the release fractions from 

Table 2 of RG 1.183 (see Section 3.3 for more details on this tab). The Release 

Durations (hrs) are also listed and are from Table 4 of RG 1.183 as shown on Figure 

2-39. 
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Figure 2-39 Edit Total Inventories Window Release Fractions and Timings 
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• Finally, clicking on the Source Term tab shows the calculated source term associated 

with the particular nuclide as shown in Figure 2-40. Further discussion of source term 

modeling in SNAP/RADTRAD is presented in Sections 2.4.2. 

 

 

Figure 2-40 Edit Total Inventories Window Source Term Tab 

The final step for the source term specification is to set the source term fraction and the iodine 

chemical forms to the RG 1.183 (NUREG-1465) values. The user sets the source term fraction 

by entering the value of 1 in the Source Term Fraction text box of the Property window for 

Source 1 (Fuel Release) as shown in Figure 2-41. The iodine chemical form is set by using the 

drop-down menu associated with the Iodine Physical Form text box in the Property window for 

Source 1 (Fuel Release) as shown in Figure 2-41. The aerosol, elemental and organic iodine 

fractions are listed but are not editable (grayed-out). 
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Figure 2-41 Property Window for Source Term Iodine Chemical Form Settings 

The user can now run a model check by navigating to Tools->Check Model and looking for the 

notes in the Message window in the lower part of the Model Editor indicating that no errors were 

found as shown in Figure 2-42. There are three icons to the right of the message window used 

to copy or delete messages. 

 

Figure 2-42 Model Editor Message Window with Icons 

If an error is detected, an Error Report window appears listing the errors and warning messages 

as shown in the example Error Report window shown in Figure 2-43. The error messages, 
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which are generally self-explanatory, provide a guide to what needs to be fixed. Note that there 

are other classifications of messages (Notes, Alerts, Warnings, and Errors). Generally, SNAP 

displays messages in these different classifications automatically. The goal for model 

development is to have no errors or warnings generated by the SNAP Model Editor. Users 

should note that models may execute with warnings detected by the Model Editor, but they will 

not execute with errors. Once error checking is complete and no errors or warnings exist in the 

model, the user can run the case as described in Section 2.2.2 (Tools->Submit Job). 

 

 

Figure 2-43 Example of a SNAP Model Editor Error Report Window 

2.3.4 Building a SNAP/RADTRAD Model – Additional Features 

There are a number of features and icons in the View / Dock window, as shown in Figure 2-44, 

that the SNAP/RADTRAD user should become familiar with for general model building. These 

features include the Cut ( ), Copy ( ) and Paste ( ) icons which are used by selecting the 

icon (Compartment, Pathway, etc.) in the View / Dock window to be cut or copied, then clicking 

on the Cut ( ) or Copy ( ) icon and pasting it in the View / Dock window. 
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Figure 2-44 View / Dock Window Tool Bar Icons 

The Paste Special ( ) icon allows the user to paste multiple copies or to control component 

renumbering. The features of the Paste Special ( ) icon are shown in Figure 2-45. The utility 

of this tool is to maintain unique component numbers in the copy and paste process. To 

duplicate a component using the Copy ( ) icon and Paste Special ( ) icon, confirm 

the Selection Tool ( ) icon is activated (Figure 2-44) and then click on the component to be 
duplicated. Click on Paste Special ( ) icon and confirm that the numbering offset is selected, a 
value of 1 for the offset is fine. Then click on the OK button and the component will be duplicated. 

duplicated. Click on Paste Special () icon and confirm that the numbering offset is selected, a 

value of 1 for the offset is fine. Then click on the OK button and the component will be 

duplicated. 
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Figure 2-45 Features of the Paste Special Window 

The Selection Tool ( ) icon, as the name implies, allows the selection of icons for copying. This 

tool needs to be activated as shown in Figure 2-44 to allow components to be selected or 

moved. A component is moved by clicking on the component and holding the left mouse button 

down while dragging the component to the desired location. The Find Component ( ) icon is 

used to find a component and it is usually used for large models with tens or hundreds of 

components and is typically not needed for SNAP/RADTRAD models. 

Another very useful feature of SNAP/RADTRAD is the ability to group components (rubber band 

selection) and move them as a unit. The Group ( ) and Ungroup ( ) icons appear inactive 

(grayed out) until a group of components are defined. To define a component group, click the 

mouse button in an empty area of the View / Dock window, then drag the cursor around the 

group of components to be grouped (rubber banded) together. The Group ( ) icon, shown in 

Figure 2-44, will now become active. Click the Group ( ) icon to group the components 

together and note that the Ungroup ( ) icon the View / Dock window tool bar will become 

active. Clicking on the Ungroup ( ) icon ungroups the components in the previously defined 

group. 

The Zoom ( ) icon is used to zoom in on sections of a model. Clicking on the Zoom ( ) icon 

and then clicking on the background of the View / Dock window will magnify the components. 

Additionally, some useful zoom and sizing features are available when the Selection Tool ( ) 

icon is activated by right-clicking on the View / Dock window background and clicking on Zoom 

in the drop-down menu. Alternately these features are available while the Zoom ( ) icon is 
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active by right-clicking on the View / Dock window background. Both methods open the Zoom 

and Size window shown in Figure 2-46 

 

 

Figure 2-46 Zoom and Size Features 

When the Zoom tab is activated, the zoom level can be set to any desired value by either using 

the slider or entering a number in the percent value in the text box. Note that clicking on the red 

arrow ( ) displays a drop-down list of preset values from which the user may make a suitable 

selection. When the Canvas Size tab is active, the width and height of the canvas can be set. 

The canvas is the portion of the View / Dock window surrounded by a thin border on two sides 

(bottom and right sides) and the scaling ruler on the remaining two sides of a model as 

illustrated in Figure 2-47. All component icons are rendered on the canvas and for larger 

models, sometimes the canvas borders cannot be seen. The Zoom ( ) icon can be used to 

shrink the model and bring the borders into view. Also, if the canvas is larger than the model, 

clicking on the Trim Excess button will shrink the canvas area to fit the model. 

In some SNAP models, the scale of icons is of interest to get a sense of perspective particularly 

for models where plant components are represented. Generally, SNAP/RADTRAD models are 

represented in a manner similar to a block diagram; however, a plant representation can be 

drawn using the Component Insertion ( ) icon on Figure 2-44. 

SNAP/RADTRAD provides the feature of scaling meshes with some of the drawing features 

available using the Component Insertion ( ) icon. The Component Insertion ( ) icon allows the 

insertion of various components and basic drawing shapes into a model representation. Figure 
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2-48 displays the Component Insertion ( ) icon menus illustrating the available features. These 

menus are accessed by clicking on the drop-down arrow. 

The features that would be most used in developing a SNAP/RADTRAD model would be 

the Compartments, Sources and Pathways Insertions. These three features make it easy to 

build a model by navigating the menus to the component of interest, clicking on that 

component, then moving the cursor to the View / Dock window and clicking again. This 

approach provides an alternative and is quicker than the approach involving right-clicking 

on the desired nodes in the Navigator window described earlier. 

 

 

Figure 2-47 View / Dock Window Model Canvas 
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The other feature that is useful is the ability to annotate a model using the Annotation feature. 

This Annotation feature allows the user to draw basic shapes and to add descriptive text. The 

basic approach is to navigate to the annotation feature of interest, select that feature and then 

click on the View / Dock window which will draw the selected icon. 

As an example, to draw an ellipse, navigate to Annotation->Ellipse, click on Ellipse in the menu, 

then move the cursor to the View / Dock window and click in that window to draw the selected 

shape. Right-clicking on the shape activates a menu that allows various drawing rendering 

features to be set. These features are typical of Windows-based drawing programs and are not 

discussed in detail. 

The drawing features combined with scaling may be of interest to some users with an artistic 

tendency. When a new model is initiated, default values are set for the dimensions of the 

canvas which are a height of 850 pixels and a width of 1100 pixels. These values can be 

checked in the Canvas Size tab in the Zoom and Size window. Additionally, the user can enter 

custom values for the height and width by typing them and selecting the Enter key on the 

keyboard. The default scaling is 20 pixels per meter with a width scale factor of 1.0 which can 

be checked by clicking on the Scaling tab in the Zoom and Size window which is shown in 

Figure 2-46. Dividing the pixel values by the scaling factor yields a height of 42.5 meters and a 

width of 55 meters. Note that the ruler at the edge of the canvas shows these dimensions. 

Units are immaterial in this context as the dimensions can be expressed in yards, feet or any 

other unit. The scaling factor is the number of pixels per unit of length. 

Figure 2-48 Component Insertion Icon Feature Menus 
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Once a suitable scaling is set, scaled drawings representing plant components can be made 

using the annotation features discussed above. A sample is shown in Figure 2-49 in which a 

cylinder is scaled to be 100 feet in diameter and 100 feet high. 

 

Figure 2-49 Cylinder Drawn using the Annotation Features of SNAP 

It is noted that, in general, the icons used to represent various components in a 

SNAP/RADTRAD model are adequate for model presentation. These features are illustrated for 

those users who may want to explore and use these features for additional model annotation. 

2.4 SNAP/RADTRAD Input Summary 

Up to this point, the user has seen the various approaches to specifying input in 

SNAP/RADTRAD. The first step is to define a component (compartment, flow pathway, dose 

location, etc. using the right-click and left-click sequences shown earlier) and then specifying the 

actual input parameters using drop-down menus, text boxes, and input tables. However, up to 

this point, many of the available input parameters have not been discussed. 

Tables 2-5 through 2-15 present a summary of all the inputs that can be specified in a 

SNAP/RADTRAD model. The organization of the tables follows the group node organization in 
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the Navigator window. Summary explanations of the input requirements are provided. In 

addition, screenshots are provided to help orient the user and to provide context with the input. 

Comments are also provided to aid the user in specifying input. 

SNAP/RADTRAD input is largely self-explanatory given that the user has some dose analysis 

background. However, the user should be aware of the relationships among some of the group 

nodes from an input specification perspective. These relationships are as follows: 

• general model options (Table 2-5); 

• nuclide data and sources for specifying source terms (Tables 2-6 and 2-7); 

• compartments, pathways, natural deposition, filters and sprays (Tables 2-8 through 2- 

12); 

• dose locations (including breathing rates), and Χ/Q tables (Tables 2-13 and 2-14); and 

• remaining inputs (Table 2-15). 

The relationships will become obvious as the user works with the SNAP Model Editor. 

Sometimes the relationship is “one way.” As an example, the user can tell which Χ/Q table is 

linked to a particular dose location by clicking on one of the Dose Location nodes. However, if 

the user clicks on a particular Χ/Q Table node, the associated dose location is not readily 

identified. Hence, it is important to name the various model components to keep track of 

associations. 

2.4.1 Model Options 

Model options are applied to the overall problem and the use of the default values should be 

acceptable for most problems, but should be checked by the user. Table 2-5 lists the available 

inputs for the Model Options node in SNAP/RADTRAD (Figure 2-50). Some general comments 

on model options are listed below: 

• Plant Power Level needs to be specified as it is used to determine the overall inventory 
in the source term calculation. 

• Either Decay or Decay with daughter production should be used for most problems. 
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• The Onset of Gap Release and the Start of Accident. Note that the values of the Onset 

of Gap Release and the Start of the Accident should remain at 0.0. If values greater 

than 0.0 are used, the problem time is advanced by the specified time value. 

Therefore, specifying a value greater than 0.0 causes the lookup values for time- 

dependent data such as Χ/Q to be later than it should be. This issue will be addressed 

in future versions of the RADTRAD-AC. 

• Options are provided to reduce the volume of output in the Output Parameters and NRC 

Output Flags Property window if the user desires to reduce the volume of output data. 

 

Figure 2-50 Property Window for the Model Options Node 
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Table 2-5 Summary of SNAP/RADTRAD Input - General Model Options 

Input Description 

Model Options – General 

 

Title 

Problem title (optional), specified by user. Typically, it is a good idea to 

name the problem particularly since multiple models can be accessed 

in a single SNAP Model Editor session. 

 

Description 

Problem description (optional), specified by user. It is a good idea to 

provide a short problem description for the record. 

Regulatory Guide Revision 
Input and functionality can differ between the versions of the 

regulatory guide 1.183. For backwards compatibility, the option to 

specify which revision is used was added. 

Plant Power Level Core power level in MWt (required). 

 

 

Decay 

Select one of the following options: 

• Decay and daughtering (default) 

• No decay or daughtering 

• Decay, no daughtering 

 

Onset of Gap Release 

Specify the time that the gap release from the fuel starts in hours 

(required). The default is 0.0 hours which is recommended for most 

SNAP/RADTRAD models. 

 

 

Start of Accident 

Specify the time that the accident starts in hours (required). This 

parameter is only significant if radionuclide decay is being calculated. 

The default is 0.0 hours which is recommended for most 

SNAP/RADTRAD models. 

 

Duration of Accident 

Specify the time the accident ends in hours (required). The default is 

720 hours which is recommended for most SNAP/RADTRAD models. 
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Dose Conversion Type 

Select one of the following options for DCFs: 

• User defined 

• FGR 11 & 12 (default) 

Generally, the default FGR 11&12 DCFs should be used. 

 

Dose Conversions 

Values for FGR 11 & 12 can be displayed. If user-defined is selected, 

then user can input DCFs. 

Time Step Algorithm 

Two algorithms are available for controlling the time step: 

• Adaptive 

• Default 

• Default with Error Calculation 

The Default time step algorithm is the original RADTRAD (version 3.10) 

algorithm implemented with the matrix exponential method [11] (see 

Section 3.1). The Adaptive and the Default with Error Calculation time 

step algorithms were introduced with the RADTRAD-AC (version 4.5) 

and are discussed in Section 3.2. 

Time Step Table 

Specified by user. This option allows the user to specify time steps for 

finer time step resolution for the default time step algorithm and also 

used to control the generation of output. If this option is not used, 

SNAP/RADTRAD generates time-dependent output at each time point 

where there is a change in the time-dependent input data such as Χ/Q, 

filtration efficiency, etc. The appropriate time step size is dependent on 

how quickly radioactivity is added or removed from the system being 

modelled. If the default time step algorithm is used the user should 

manually adjust the time step size to make sure the results are 

independent of the time step size. Finally, the user should note that 

entering values in this table will override the Adaptive time step 

algorithm if the minimum and maximum time step size are equal (see 

Section 3.2). 

Minimum Time Step Table 

The minimum time step table provides a way to limit RADTRAD when 

setting the time step sizes. In certain occasions, RADTRAD can make 

time step sizes small enough that can cause run times and output file to 

increase significantly. This time step table allows the user to have more 

control and avoid situations where a small time step is not desirable.  
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Use Full Time Step 

(if Time Step Algorithm is 

Adaptive) 

When Adaptive time stepping is enabled, a full step solution is 

compared to a two half step solution to determine the error. The two 

half step solution is generally more accurate and is used by default. If 

Use Full Time Step is set to True, then the full step solution is used. 

Note that this option is valid if Adaptive time stepping is used or if 

Default with Error Calculation is turned on and the default value is set 

to True. 

Plot All Points 

When the Adaptive time stepping or Default with Error Calculation 

options are enabled, time steps will be repeated in order to calculate 

error. By default, repeated time steps are not plotted. If Plot All Points 

is enabled, set to True, then these points are written to the plot file.The 

default value is set to False. 

 

Max Error 

(if Time Step Algorithm is 

Adaptive) 

When Adaptive time stepping is enabled, this option indicates the error 

threshold used for Adaptive time stepping to determine when time step 

needs to be cut. This value is the fractional error and the default value 

is set to 1E-3. 

Model Options – Output Parameters 

The following output parameter flags only affect the casename.out output file. 

 

Dose/Activity Output Units 

This flag option determines whether the RADTRAD output text files are 
generated in Curies and Rem based units [traditional RADTRAD units] 
or SI units (MBq, mSv). The default units are Curies and Rem. 

 

Echo Model Definition 

The flag options are either True or False and specified by the user. If 

set to False, the edited summary of the input is suppressed. The 

default value is set to True. 

 

Show Event 

This option determines whether the code should write output at each 

time interval. The flag options are either True or False and specified by 

the user. The default value is set to True. 

Show Step 

This option displays each time interval given by the time step control 

input on the output. The flag options are either True or False and 

specified by the user. The user should set this flag to True to get the 

output for all time steps. The default value is set to True. 

 

Show Model 

This displays the model output at each time interval in the output. The 
flag options are either True or False and specified by the user. The 
default value is set to True. 

Model Options – NRC Output Flags 

The available flags that control the generation of output to the NRC-formatted output file. 
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Note that the bulk of the output is generated for the Delta Dose and Cumulative Dose 
results. 

 

Input Echo 

This option defines whether the input model will be echoed to the NRC 

output file. The flag options are either True or False and the default 

value is set to True. 

General Input Parameters 

This option defines whether general input parameters are written to the 

NRC output file. These parameters include the number of 

compartments, pathways, dose locations, and nuclides. The problem 

start and end time are also included in the parameters under this 

option. The flag options are either True or False and the default value 

is set to True. 

Source Term Parameters 

This option defines whether the source term parameters, as specified 

in the inputs, are written to the NRC output file. These parameters 

include the plant power level, inventory power, the consideration for 

radioactive decay and daughter production, start time of the release, 

and the delay time for the release if applicable. The iodine chemical 

fractions, nuclide group release fractions and timings, and nuclide 

inventory file are also included in the parameters under this option. 

The flag options are either True or False and the default value is set 

to True. 

 

Dose Conversion Factor 

Data 

This option defines whether the DCFs, as specified in the inputs, are 

written to the NRC output file. These include the nuclide DCFs and 

decay constants. The flag options are either True or False and the 

default value is set to True. 

Compartment Data 

This option defines whether compartment data parameters, as 

specified in the inputs, are written to the NRC output file. These 

parameters include the number of compartments and the specific data 

for each compartment such as the number, name, volume, type, dose 

location, radionuclide removal features (sprays, recirculation filters, and 

natural deposition), source input and output from the compartment, and 

flow path connections. The flag options are either True or False and 

the default value is set to True. 

Flow Path Data 

This option defines whether flow pathway data parameters, as specified 

in the inputs, are written to the NRC output file. These parameters 

include the number of pathways and the specific data for each pathway 

such as the number, name, to compartment, from compartment, nuclide 

transfer mechanism, and output mode. The flag options are either True 

or False and the default value is set to True. 
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Dose Location Data 

This option defines whether dose location data parameters, as 

specified in the inputs, are written to the NRC output file. These 

parameters include the number of dose locations and the specific data 

for each dose location such as the name (EAB, LPZ, and control 

room), Χ/Q data, breathing rate data, and occupancy factor data. The 

flag options are either True or False and the default value is set 

to True. 

Activity Distribution Results 

This option defines whether activity distribution results at the end of 

each time step are written to the NRC output file. These results include 

the radionuclide, the group number, and the activity (Ci) in each 

compartment of the model at the end of the time step. The flag options 

are either True or False and the default value is set to True. 

Delta Dose Results 

This option defines whether delta dose results at the end of each time 

step are written to the NRC output file. These results include the 

change in doses (inhalation, cloudshine, skin, thyroid, and TEDE) for 

each radionuclide at the dose locations (EAB, LPZ, and control room) 

from the previous time step to end of the next time step. The flag 

options are either True or False and the default value is set to True. 

Cumulative Dose Results 

This option defines whether cumulative dose results at the end of each 

time step are written to the NRC output file. These results include the 

integrated doses (inhalation, cloudshine, skin, thyroid, and TEDE) for 

each radionuclide and dose location at the end of the time step. The 

flag options are either True or False and the default value is set 

to True. 

I-131 Activity Summary 

This option defines whether an I-131 activity summary table is written 

to the NRC output file. The results are a table of the I-131 activity (Ci) 

in each compartment at the end of each time step. The flag options 

are either True or False and the default value is set to True. 

Cumulative Dose Summary 

This option defines whether the cumulative dose summary table is 

written to the NRC output file. The results are a table of the cumulative 

thyroid, skin, TEDE and whole body doses at each dose location (EAB, 

LPZ, and control room) at the end of each time step. The flag options 

are either True or False and the default value is set to True. 

Lines Per Page 
This option specifies the maximum number of lines per page in the 
NRC output before inserting a page break. The user can adjust this 
value with the default value set at 55 lines per page. 
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Cut-off Value 

This option specifies the cut-off value for table data. The nuclide 

summary tables written at each time step will use this value to 

determine which nuclides are written: at least one column for the 

nuclide must have a value greater than the cut-off, or it will not be 

written for that time step. The default value is set at 1.0E-04. 

Model Options – Diagnostic Flags 

Level – xxx 

These flags are used for generating additional output for code 

debugging using write statements contained in the code subroutines. 

Increasing the flag value from zero to five will increase the information 

provided. Higher values indicate a greater amount of output, with a 

value of zero disabling the diagnostic. The default values for these 

Diagnostic Flags are set to zero. These flags are not generally used 

for SNAP/RADTRAD analyses. Some additional information regarding 

these flags can be found in Section 4.2.3 of NUREG/CR-6604. 

2.4.1.1 Dose Conversion Factors 

The DCFs are also managed under the Model Options node and relate concentration and dose 

to organs by nuclide. There are two modes of DCF management, FGR 11&12 (default) 

and User Defined DCFs. The user can select either of these two options by selecting the 

drop-down menu button next to the Dose Conversion Type text box as shown in Figure 2-51. 
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Figure 2-51 Setting Dose Conversion Factors in the Model Option Property Window 

When set to FGR 11&12 (default) option, the RADTRAD plugin automatically matches the 

nuclides in active scenario inventories (see Section 2.3.3) against an extensive database of 

DCF values taken from the reference data in FGR 11 and FGR 12. Additionally, the user can 

view these DCFs by selecting the View ( ) icon next to the Dose Conversion text box to open 

the Viewing “FGR11&12” Dose Conversion Defaults window as shown in Figure 2-52. The user 

should note that icons on the tool bar in Figure 2-52 are “greyed” out indicating that these icons 

are not active with this option and that the user cannot change the FGR 11 and FGR 12 DCF 

values. Additionally, the user should note that the RADTRAD plugin flags an error when the 

source inventory contains nuclides that are not in the DCF file (nuclides in the DCF file that are 

not in a source inventory are not listed as an error). When exporting models, the RADTRAD 

plugin will only write the DCFs for nuclides found in the active source scenario inventory (in the 

order defined in the inventory). This helps to preserve the RADTRAD requirement of equivalent 

nuclides in the DCFs and the source inventory. 
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Figure 2-52 Viewing "FGR11&12" Dose Conversion Defaults Window 

When the user selects the User Defined option, the icon next to the Dose Conversion text box 
changes from the View ( ) icon to the Custom Editors ( ) icon. The user can select the 
Custom Editors ( ) icon to open the User-Defined Dose Conversion Factors window as shown 
in Figure 2-53. 

 

 

Figure 2-53 User-Defined Dose Conversion Factors Window 

As noted in Figure 2-53, the icons on the tool bar are active with this option indicating that these 

icons can be used to change the DCF values. The names and functions of these icons on the 

tool bar are the same as those in Figure 2-34, with the exception of the Import ( ) icon. 
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The Import ( ) icon on Figure 2-53 provides a drop-down menu option in which the user can 

select either the FGR11&12 or Import from file option. The Import from file option will open a 

typical Windows file navigator window to allow the user to search for a specific file (the default 

file type option is *.dfx and *.inp). As shown in Figure 2-53 the DCFs are listed in a table format 

with one nuclide per row. Additionally, nuclides that are not present in a source inventory are 

highlighted with a blue background and nuclides listed in a source inventory that are not 

represented in the DCFs are displayed with DCF values listed as <unset>. For additional 

information on DCFs usage in the dose analysis see Section 3.6. 

2.4.1.2 Adaptive Time Step 

Generally, the Default time step algorithm is adequate for most RADTRAD calculations. If the 

user wants to determine if there are time step sensitivities, then two options are available: 

1. Default with Error Calculation, and 

2. Adaptive time step. 

Error in the dose calculation can be determined by selecting the Default with Error Calculation 

option. The results can be viewed using the AptPlot program. Search for error or error.scaled 

to see the error results. To use the adaptive time step algorithm, select Adaptive in the Time 

Step option from the drop-down menu. 

The Adaptive time step algorithm is new in SNAP/RADTRAD and it is considered to be 

experimental. Use of this algorithm adds a significant amount of running time to the problem. It 

is suggested that the user set up the problem using the Default time step algorithm option and 

check for any time step sensitivities using the Default with Error Calculation or Adaptive time 

step algorithm option. For additional information on the Adaptive time step algorithm see 

Section 3.2. 

2.4.2 Nuclear Data and Source Scenarios 

The source term specification was introduced in Section 2.3.3. However, a new feature that has 

been added to SNAP/RADTRAD is the ability to consider the reactor coolant system (RCS) 

activity for either a PWR or BWR. The user can access the RCS Activity Calculator window, 

Figure 2-54, by clicking on the Nuclide Data node in the Navigator window and then selecting 

the Custom Editors ( ) icon for Total Inventories text box in the Property window to open the 

Edit Total Inventories window. Then select the Open RCS Activity Calculator ( ) icon on the 

Edit Total Inventories window as shown in Figure 2-34. The user has the option to enter RCS 

activity or to allow SNAP/RADTRAD to calculate the RCS activity. Formulations for the 

calculation of RCS activity are presented in Section 3.4. Figure 2-54 displays the RCS Activity 

Calculator window where the user can select from either BWR or PWR. 
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The user will note that the RCS Activity Calculator window in Figure 2-54 is an input 

specification window where parameters need to be specified to determine the RCS activity. 

There are two options available to calculate RCS activity. 

1. The user can input the RCS specific activity (µCi/g) in the Activity column (Figure 2-54) 

and then add the effect of iodine spiking by checking either the Use pre-incident spike or 

the Use co-incident spike box. If the user checks the Use co-incident spike box, then 

the Calculate Appearance button on Figure 2-54 will become active. Note that the co- 

incident spike model is not available for BWRs. 

2. The user can also have SNAP/RADTRAD calculate the equilibrium Technical 

Specification (T/S) Limit RCS activity (without spiking) and add the effect of a pre- 

incident or co-incident spike to the total RCS activity. 

In Figure 2-54, the user will note the Activity column is editable so that the user can input the 

known radionuclide specific activity, the RCS mass in kilograms and the RCS inventory will be 

calculated. Generally, the radionuclide specific activities based upon one percent fuel defects 

are presented in Chapter 11 of the Final Safety Evaluation Report for a given plant. Once the 

radionuclide specific activity is entered, the user has the option to calculate the iodine and 

xenon equilibrium activities from the specified equilibrium activity for the dose equivalent iodine 

131 (DE I-131) or the dose equivalent xenon 133 (DE Xe-133) from the facility’s technical 

specification (T/S) equilibrium specific activity. These calculations are done by checking or 

unchecking the appropriate boxes on the RCS Activity Calculator window. Note that the 

calculations are completed using the user-specified radionuclide specific activity (µCi/g). 

Additionally, after selecting either the BWR or the PWR option on Figure 2-54, when the user 

selects the Calculate Activity button on Figure 2-54 either Figure 2-55 or 2-56 will open 

respectively. In either instance, the user inputs the required data and clicks the OK button to 

complete the calculation. Note that for the BWR, the user can apply the calculation to either 

steam or liquid (Calculate activity in steam or liquid?) by clicking on the radio button for either 

the Steam activity or Liquid activity option shown in Figure 2-56. 

 



88  

 

Figure 2-54 RCS Activity Calculator Window 

 

Figure 2-55 RCS Activity Inputs - PWR Window 
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Figure 2-56 RCS Activity Inputs - BWR Window 

To apply pre-incident or co-incident spiking to either user-supplied or code-calculated RCS 

radionuclide specific activities, the appropriate box is checked on the RCS Activity Calculator 

window (Figure 2-54) and the required input supplied. For the pre-incident spike, which is 

applicable to either PWRs or BWRs, the user checks the Use pre-incident spike box and 

supplies the T/S spike activity. 

To use the co-incident spike, which is applicable only to PWRs, the user can select either user 

defined values by inputting the iodine appearance rate data into table in the Iodine Appearance 

Rate section of Figure 2-54 or choose to have the code calculate the iodine appearance rate by 

selecting the Calculate Appearance button. Note that the iodine appearance rate Ci/hr column 

is editable so that the user can enter appropriate values of the iodine appearance rate. 

When the user clicks the Calculate Appearance button the Calculate Iodine Appearance window 

as shown in Figure 2-57 will open. The user will provide the required inputs and click the OK 

button which will update the iodine appearance rate values in the table in the Iodine Appearance 

Rate section of Figure 2-54. 
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Figure 2-57 Calculate Iodine Activity Window 

Once the RCS activity calculations are complete, the user clicks on the OK button on the RCS 

Activity Calculator window (Figure 2-54) and the total RCS activity is automatically transferred 

from the RCS activity calculator to the Inventory (Ci) column in the Edit Total Inventories window 

(Figure 2-34) and the specific inventory amount is back-calculated from the core power. Note 

that a new file is created each time the RCS activity calculator is invoked. These files are 

automatically named, but the user can rename them using the Name text box in the Edit Total 

Inventories window (Figure 2-34). Finally the models used to compute the RCS activity are 

discussed in Section 3.4 and an example showing the detailed use of the RCS Activity 

Calculator, in a SNAP/RADTRAD model, is demonstrated in the draft SNAP/RADTRAD 

Workbook (available at the RAMP website (https://www.usnrc-ramp.com). 

Regardless of whether fuel or RCS activity is used, it is the total inventory that is the basis for 

the source term calculation accessed from the Source Scenarios text box, in the Property 

window, once a new source model is initiated. Recall from earlier discussions that part of the 

specification of a new source scenario is the appropriate nuclide inventory either from the 

reactor fuel, RCS or other source. Once that step is completed, an appropriate release model is 

specified from the available pre-defined release models listed under the Accident Parameters 

tab on the Edit Inventory Scenario window as shown in Figure 2-58. Alternately, the user has 

the option of setting release fractions and a release time under the Release Fractions and 

Timings tab. For releases of radionuclides from the reactor coolant, the release rate is usually 

controlled using the flow pathway leak or flow rate from the compartment where the reactor 

coolant is released. Accordingly, using a user-specified release fraction of 1.0 for noble gases, 

halogens, and alkali metals and a release duration of 1.0E-04 hours for the gap release as a 

surrogate should suffice. Note that the initial inventory prior to the application of release 

fractions appears under the Adjusted Inventory tab while the Source Term tab lists the actual 

releases to be used in the model after multiplication by the release fractions. 

http://www.usnrc-ramp.com/
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• For the Use Total Inventory option, user-defined release data are entered under 
the Release Fractions and Timings tab. 

• For DBA-TID and DBA-AST options, the release fractions are listed under the Release 

Fractions and Timings tab. The basis for the values for these options is presented in 

Section 3.3. 

• For the Gap Release, rod ejection accidents-control rod drop accidents (REA-CRDA), 

and fuel handling accidents (FHA) options, the default release fractions are set under 

the Accident Parameters tab as each accident is selected. The release fractions for 

the relevant nuclide groups are set to 1 under the Release Fractions and Timings tab. 

Tables 2-6 and 2-7 list the available inputs for the Nuclear Data and Source nodes in 

SNAP/RADTRAD. 
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Figure 2-58 Available Pre-Defined SNAP/RADTRAD Release Models 

Table 2-6 Summary of SNAP/RADTRAD Inputs - Nuclear Data 

Input Description 

Nuclide Model 

Select one of the following options: 

• ICRP-38 definitions (default) 

• User Defined 

It is recommended that the ICRP-38 data be used. 

Note that if the User-Defined option is selected and new nuclide 

definitions are specified and then the user switches to the ICRP-38 

option, the new nuclide definitions are deleted. References in the Total 

Inventories or the Sources to those nuclide definitions will be set to 

“<not defined>.” 

Nuclides 

Specified by user when the User Defined option is chosen in the 

Nuclide Model input. Note that the nuclide definitions can be reviewed 

by selecting Custom Editors ( ) icon. This will open the Nuclide 

Definitions window, which contains the nuclide name, atomic mass, 

and half-life on the left-hand side. When a user clicks on a nuclide on 

the left-hand side the daughter nuclides and its associated branching 

ratios will be displayed on the right-hand side of the window. 
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Total Inventories 

Used to develop radionuclide inventories in the fuel or in the RCS. 

This input works in conjunction with the Sources node to develop a 

source term. The two sample default core inventories for a PWR and 

BWR from RADTRAD 3.03 are included in the SNAP Model Editor. 

Core inventories can also be specified by the user. Section 3.3.3 and 

Figures 3-34 through 3-40 provide more detailed instructions on how to 

use these inputs. 

 

Table 2-7 Summary of SNAP/RADTRAD Inputs - Sources 

Input Description 

Name Specified by user for the source (optional). 

 

Component Number 

Multiple sources can be used in a model and the SNAP/RADTRAD 

Model Editor assigns the number. These numbers must begin with 

number 1 and increase sequentially for each additional source. 

Description Specified by user (optional). 

 

 

 

Source Scenarios 

Various source (release) scenarios are available to the users which are 

linked to the Nuclide Data definition. Source scenarios include LOCA 

DBAs and non-LOCA DBAs such as FHA, CRDA or REA, and Gap 

releases. Additionally, scenarios involving RCS activity, such as steam 

generator tube ruptures and main steam line breaks can also be 

defined. Section 3.4.2 and Figures 3-54 through 3-58 provide more 

detailed instructions on how to use this input to model these scenarios. 

 

Source Term Fractions 

User defined value which is the fraction of the inventory being released 

by the source. Multiple sources referencing the same inventory can 

divide the source term between them through this value. 

 

 

 

 

 

 

 

Iodine Physical Form 

Specified the fraction of iodine that is in elemental, organic or 

particulate chemical form. Predefined fractions are listed below and 

are user-selectable from the drop-down menu. 

• TID-14844 – 0.05 aerosol (particulate), 0.91 (elemental), and 

0.04 (organic) 

• NUREG–1465 – 0.95 aerosol (particulate), 0.0485 

(elemental), and 1.5E-3 (organic). 

• User Defined 

Note that if one of the predefined fraction options is selected, the 

above fractions appear in the Aerosol Fraction, Elemental Fraction or 

Organic Fraction text boxes. These fields are greyed-out and are not 

editable. Selecting the user-defined option from the iodine physical 

form drop-down menu allows the user to specify the aerosol, 

elemental, and organic fractions. 
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Compartments 

Links the release scenario to a given compartment. Works in 

conjunction with the compartment specification. 

2.4.3 Compartments, Pathways, Natural Deposition, Filters and Sprays 

Section 2.3.2 presented the approach for defining compartments and pathways and connecting 

these two components. Once an initial model is developed, completing the model is a matter of 

input specification. Input specification is done by left clicking on the Expand (  ) icon (if it is not 

already expanded) of the associated component (Compartments, Pathways, Natural Deposition, 

Filters and Sprays) in the Navigator window, and completing the input specification fields of the 

Property window for that component. The input specification fields for the components in the 

Property window consist of input text boxes, drop-down menus or input tables that are accessed 

by the Custom Editors ( ) icon. Tables 2-8 through 2-12 list the available inputs for the 

Compartments, Pathways, Natural Deposition, Filters and Sprays in SNAP/RADTRAD. 

Table 2-8 Summary of SNAP/RADTRAD Inputs - Compartments 

Input Description 

Name Specified by user (optional). 

 

 

Component Number 

Multiple compartments can be used in a model and the 

SNAP/RADTRAD Model Editor assigns the number. These numbers 

must begin with number 1 and increase sequentially for each additional 

component. 

Description Specified by user (optional). 

Type 

The user can select from the following options: 

• Control Room Dose – This option is used for a control room 

compartment which enables a dose location to be associated 

with the compartment. 

• Environment – This option couples radionuclide release points 

and dose locations through the specification of Χ/Q. 

• Normal – A general compartment type that can be 

interconnected to other compartments. Removal by sprays, 

natural deposition and filtration can be modeled in these 

compartments. 

• Normal Dose – This option is similar to the Normal 

compartment except that a dose location can be specified 

within the compartment. 

Note that an Environment compartment is defined by default in 

SNAP/RADTRAD. Additional compartments are specified by the user. 
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Output Level Detail 

Sets the detail level used to output compartment data (nuclide activity 

and decontamination for the compartment) during model execution. 

The user can select from the following options: 

• No additional detail (default) 

• Full edit at time steps 

• Full edit at end of problem only. 

When set to Full edit at time steps, the editing of nuclide activity and 

decontamination for the compartment are printed to the output. These 

details may be printed at every time step or only once, at the end of the 

problem. 

Volume 

Specified by user (ft3 or m3 depending on user-specified units 

selection). Units switching is done by right-clicking on the black bar of 

the Navigator window and selecting Engineering Units and British or SI 

units. 

Deposition 
Works in conjunction with the Natural Deposition node summarized in 

Table 3-10. Used in Normal and Normal Dose compartments as 

appropriate. 

Filter 
Works in conjunction with the Filter node summarized in Table 3-11. 

Used in Normal, Normal Dose and Control Room Dose compartments 

as appropriate. 

 

Spray 

Works in conjunction with the Spray node summarized in Table 3-12. 

Used in Normal and Normal Dose compartments as appropriate. 

 

Table 2-9 Summary of SNAP/RADTRAD Inputs - Pathways 

Input Description 

Name Specified by user (optional). 

 

Component Number 

Multiple pathways can be used in a model and the SNAP/RADTRAD 

Model Editor assigns the number. These numbers must begin with 

number 1 and increase sequentially for each additional component. 

Description Specified by user (optional). 

From Compartment Lists the upstream compartment in this pathway. 

To Compartment Lists the downstream compartment in this pathway. 
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Pathway Type 

The method by which radionuclides are transported and deposited 

through the pathway. The user can select from the following options: 

• Piping (default) – transport in volumetric flow with a 

decontamination factor. 

• Filtered pathway – transport in volumetric flow through filters 

with a specified efficiency. 

• Generic – transport in volumetric flow with a decontamination 

factor (replaces legacy suppression pool mechanism). Allows 

for the user to independently specify the decontamination 

factors for aerosols (particulate), elemental iodine, organic 

iodine, and noble gases. 

• Air leakage – transport in volumetric percent (%/day). This is 

the typical path used for containment leakage. 

• Generic w/non-Iodine aerosols – transport is the same as the 

Generic option above without Iodine particulate. 

• BWR Main Steam Lines – Represents leakage from the 
outboard and inboard sections of BWR steam lines. This 
model is gathered from Regulatory Guide 1.183 Rev. 2 

Appendix A. 

Printout Level Detail 

Determines what additional pathway details are written to the output 

file. The user can select from the following options: 

• None (default) – writes no extra details. 

• Transport Each Time Step – writes information about the 

transport for each group (noble gas, elemental, organic, and 

aerosol (particulate)) at each time step. 

• Nuclide and Transport Each Time Step – same as the option 

above, but includes information about each transported 

nuclide. 

• Nuclide and Transport at End Only – same as the option 

above, but only written out at the end of the calculation. 
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Aerosol Removal Model 

(if pathway type is Piping) 

Specifies how aerosols (particulates) are deposited in the pipe. The 

user can select from the following options: 

• No aerosol removal (default) – aerosol removal is not 

modeled in the pipe. 

• User Defined Decontamination Factors – if the user selects 

this option the Aerosol DF text box appears below this option. 

Select the Custom Editors ( ) icon for this text box to open 

the Editing Aerosol DF window. The user enters time- 

dependent decontamination factors and flow rates (ft3/min or 

m3/s) in the data entry table (see Section 3.3.3 for details 

regarding data entry using the Custom Editors ( ) icon and 

the edit table features in SNAP/RADTRAD). 

• Brockmann-Bixler Model – If the user selects this option the 
following additional input text boxes appear below this option 

with user-specified values to be entered: 

▪ pipe volume (ft3 or m3) 

▪ pipe surface area (ft2 or m2) 

▪ pipe angle (degrees) 

▪ pipe temperature (°F or °C) 

▪ pipe pressure (psi or kPa) 

▪ pipe aerosol settling velocity (ft/min or m/s) 

▪ pipe aerosol flow rates are entered by selecting 

the Custom Editors ( ) icon to open the Editing 
Pipe Aerosol Flow Rates window. Enter the flow 
rates (ft/min or m/s) as a function of time in the 

data entry table. 

Note that addition guidance and information on these inputs is 

available by clicking on the Help ( ) icon and Section 4.5.3. 

 

 

 

 

 

 

Elemental Iodine Removal 

Model 

(if pathway type is Piping) 

Determines how elemental iodine is deposited in the pipe. The user 

can select from the following options: 

• None (default) – elemental iodine removal is not modeled in 

the pipe. 

• Enter DFs and Flow Rates – if the user selects this option the 

removal rate is defined as a function of flow rate and DFs over 

time. When this option is selected the Elemental Iodine DF 

text box appears below this option. Select the Custom Editors 

( ) icon for this text box to open the Editing Elemental Iodine 

DF window. The user enters time-dependent DFs and flow 

rates (ft3/min or m3/s) in the data entry table. 

• Enter Deposition Velocity – If the user selects this option the 

Elemental Iodine Deposition Velocity text box appears below 

this option. The user enters iodine the deposition velocity 

(ft/min or m/s). 
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Organic Iodine Removal  

Model 

(if pathway type is Piping) 

Determines how organic iodine is deposited in the pipe. The user can 

select from the following options: 

• None (default) – elemental iodine removal is not modeled in 

the pipe. 

• Enter DFs and Flow Rates – if the user selects this option, 

the removal rate is defined as a function of flow rate and DFs 

over time. When this option is selected, the Organic Iodine 

DF text box appears below this option. Select the Custom 

Editors ( ) icon for this text box to open the Editing Organic 

Iodine DF window. The user enters time-dependent DFs and 

flow rates (ft3/min or m3/s) in the data entry table. 

• Enter Deposition Velocity – if the user selects this option, the 

Organic Iodine Deposition Velocity text box appears below 

this option. The user inputs the iodine enter deposition 

velocity (ft/min or m/s).  

Note: The NRC does not credit organic deposition in design basis 

calculations.  

Filter 

(if pathway type is Filtered 

Pathway) 

Specified the air filter removing radionuclides from transport in the 

pathway. Use the Select ( ) icon to open the Select from Filters 

window to link to one of the available filter models or create a filter 

component.  

Aerosol DF  

(if pathway type is Generic or 

Generic w/non-Iodine 

Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Organic Iodine DF window. Enter the time-dependent DFs and 

flow rates (ft3/min or m3/s) in the data entry table. 

Elemental Iodine DF 

(if pathway type is Generic or 

Generic w/non-Iodine 

Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Elemental Iodine DF window. Enter the time-dependent DFs 

and flow rates (ft3/min or m3/s) in the data entry table. 

Organic Iodine DF 

(if pathway type is Generic or 

Generic w/non-Iodine 

Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Organic Iodine DF window. Enter the time-dependent DFs and 

flow rates (ft3/min or m3/s) in the data entry table. 

Note: The NRC does not credit organic deposition in design basis 

calculations.  

Nobel Gas Flow Rates 

(if pathway type is Generic or 

Generic w/non-Iodine 

Aerosols) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Noble Gas Flow Rates window. Enter the time-dependent flow 

rates (ft3/min or m3/s) in the data entry table. 
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Leakage Rate 

(if pathway type is Air 

Leakage) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Leakage Rate window. Enter the time-dependent flow rates 

(%/day) in the data entry table. 

Aero Mass Median Diameter 

(if pathway type is BWR Main 

Steam Lines) 

Aerodynamic mass median diameter (m) based on a distribution 

directly measured from experiments to evaluate the settling velocity 

where the specific aerosol parameter distributions of shape factor, 

density, and volume-equivalent diameter do not need to be defined. 

Geometric Standard Deviation 

(if pathway type is BWR Main 

Steam Lines) 

Geometric standard deviation used to create a normalized number 

distribution of particles of aerodynamic diameter 

Geometric Mean 

(if pathway type is BWR Main 

Steam Lines) 

An optional parameter that specifies a geometric mean when setting 

up the standard deviation.  

Geometric Factor 

(if pathway type is BWR Main 

Steam Lines) 

Factor used in specifying spacing intervals.  

Viscosity 

(if pathway type is BWR Main 

Steam Lines) 

Viscosity of the steam in the BWR Steam Lines (Pa-s). 

Density 

(if pathway type is BWR Main 

Steam Lines) 

Density of the steam in the BWR Steam Lines (kg/m3). 

MSL Inboard Area 

(if pathway type is BWR Main 

Steam Lines) 

Settling surface area of the inboard pipe (m2). 

MSL Inboard Volume 

(if pathway type is BWR Main 

Steam Lines) 

Inner volume of the inboard pipe (m3). 

MSL Inboard Flow Rate 

(if pathway type is BWR Main 

Steam Lines) 

Flowrate through the inboard section of the BWR steam line (m3/sec). 
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MSL Outboard Area 

(if pathway type is BWR Main 

Steam Lines) 

Settling surface area of the outboard pipe (m2). 

MSL Outboard Volume 

(if pathway type is BWR Main 

Steam Lines) 

Inner volume of the outboard pipe (m3). 

MSL Outboard Flow Rate 

(if pathway type is BWR Main 

Steam Lines) 

Flowrate through the outboard section of the BWR steam line 

(m3/sec). 
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Table 2-10 Summary of SNAP/RADTRDA Inputs - Natural Deposition 

Input Description 

Name Specified by user (optional). 

 

 

Component Number 

Multiple natural deposition models can be used in a model and 

the SNAP/RADTRAD Model Editor assigns the number. These 

numbers must begin with number 1 and increase sequentially for 

each additional component. 

Description Specified by user (optional). 

 

 

 

 

 

 

 

 

Aerosol Deposition Model 

Specifies the method by which the deposition removes 

radionuclides from the compartment. The user can select from 

the following options: 

• None (default) –no deposition is modelled. 

• User Defined Coefficients – deposition is determined 

from user-specified removal rate coefficients over time. 

• Henry’s Model Coefficients – uses Henry’s model for 

natural deposition. User specifies compartment height 

and particle density over time. See Section 4.5.2.1 for 

more model details and references. 

• Powers’ Deposition Model – the Powers’ model for 

natural deposition, calculated based on an uncertainty 

percentile associated with a reactor and accident type. 

This model is only for large buildings, and is not valid for 

deposition in passages such as pipes. See Section 

4.5.2.2 for more model details and references. 

 

Aerosol Removal Coefficients 

(if Aerosol Deposition Model is 

User Defined Coefficients) 

Defines the aerosol (particulate) radionuclide removal as a 

function of time. Select the Custom Editors ( ) icon for this text 

box to open the Editing Aerosol Removal Coefficients window. 

Enter the time-dependent removal coefficients (1/hour) in the 

data entry table. 

 

 

Henry Deposition Table Data 

(if Aerosol Deposition Model is 

Henry’s Model Coefficients) 

The table is used by the code to determine the particle deposition 

rate from the compartment height and particle density over time. 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Henry’s Deposition Table Data window. Enter the time- 

dependent height (ft or m) and particle density (lb/ft3 or g/cm3) in 

the data entry table. 
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Powers Accident Model Type 

(if Aerosol Deposition Model is 

Powers Deposition Model) 

Sets the model of decontamination based on the type of reactor 

and accident. Select the accident type using the drop-down 

menu. 

• PWR-DBA 

• BWR-DBA 

• APWR-DBA 

 

 

 

Power’s Model Percentile 

(if Aerosol Deposition Model is 

Powers Deposition Model) 

Sets the uncertainty percentile for the Powers model for natural 

deposition. Select the accident type using the drop-down menu. 

• 10% 

• 50% 

• 90% 

Note: The 10% deposition model yields the most conservative 

aerosol removal coefficients. 

 

 

 

 

Elemental Deposition Model Type 

Determines the method by which the deposition removes 

elemental iodine from the compartment. The user can select 

from the following options: 

• None (default) –no decontamination is modelled. 

• User Defined Coefficients – decontamination is specified 

as a function of removal coefficients over time. When 

this option is selected the Elemental Iodine Removal 

Coefficient text box appears below this option. 

 

 

Elemental Iodine Removal 

Coefficient 

(if Elemental Deposition Model 

Type is User Defined Coefficients) 

Defines the elemental iodine radionuclide removal as a function 

of time. The removal coefficient is defined as the fraction of the 

total elemental iodine mass inserted into the containment 

removed per second. Select the Custom Editors ( ) icon for this 

text box to open the Editing Elemental Iodine Removal 

Coefficient window. The user enters time-dependent elemental 

iodine removal coefficients (1/hour) in the data entry table. 

 

 

 

 

 

Table 2-11 Summary of SNAP/RADTRAD Inputs - Filters 

Input Description 

Name Specified by user (optional). 
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Component Number 

Multiple filters can be used in a model and the SNAP/RADTRAD 

Model Editor assigns the number. These numbers must begin 

with number 1 and increase sequentially for each additional 

component. 

Description Specified by user (optional). 

 

 

 

 

 

 

Filter Table 

The removal efficiency of filters and flow rate through the filters 

as a function of time. Select the Custom Editors ( ) icon for this 
text box to open the Editing Filter Table window. Each row 
defines time dependent filter flows (ft3/min or m3/s) and 
efficiencies (%) for: 

• aerosol (particulate) 

• elemental iodine 

• organic iodine filtration 

There is no noble gas efficiency as it is assumed that the noble 

gases are not filtered. The efficiencies will change in a stepwise 

fashion at each specified time. 

 

Table 2-12 Summary of SNAP/RADTRAD Inputs - Sprays 

Input Description 

Name Specified by user (optional). 

 

 

Component Number 

Multiple spray models can be used in a model and the 

SNAP/RADTRAD Model Editor assigns the number. These 

numbers must begin with number 1 and increase sequentially 

for each additional component. 

Description Specified by user (optional). 
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Aerosol Removal Model 

Determines the method by which the spray removes aerosol 

(particulate) radionuclides from the compartment. The user can 

select from the following options: 

• None (default) – aerosols are not removed from the 

compartment. 

• User Defined Coefficient Table – allows the user to 

specify the aerosols removal rate coefficient over time. 

When this option is selected the Aerosol Removal 

Coefficients, Aerosol DF Limit Enabled, Aerosol DF 

Limit, Aerosol Lambda/10 DF Limit Enabled, and the 

Aerosol Lambda/10 DF Limit text boxes appear below 

this option. 

• Powers’ Model – the aerosol removal rate is 

determined using by the Powers and Burson model, 

which takes into account sprayed and non-sprayed 

volume, deposition percentile, and spray flux ratio and 

height over time. When this option is selected the 

Powers Model Spray Table, Powers Model Spray Ratio 

and the Powers Model Percentile text boxes appear 

below this option. See Section 4.5.1 for more details. 

 

Aerosol Removal Coefficients 

(if Aerosol Removal Model type is 

User Defined Coefficient Table) 

Select the Custom Editors ( ) icon for this text box to open the 

Editing Aerosol Removal Coefficients window. The user enters 

time-dependent aerosol removal coefficients (1/hour) in the data 

entry table. 

Aerosol DF Limit Enabled 

(if Aerosol Removal Model is User 
Defined Coefficient Table) 

The user selects from either True or False. If True is selected, 

the Aerosol DF Limit text box appears below this option. 

 

Aerosol DF Limit 

(if Aerosol Removal Model is User 

Defined Coefficient Table) 

The user enters a DF value to limit the amount of aerosol 

removal. Once this DF is reached in the compartment the 

aerosol lambda or removal coefficient is automatically set to 

zero. The DF value must be 1.0 or greater and the default value 

is 1.0E+06. 

Aerosol DF Limit, Aerosol 

Lambda/10 DF Limit Enabled 

(if Aerosol Removal Model is User 
Defined Coefficient Table) 

The user selects from either True or False. If True is selected, 

the Aerosol Lambda/10DF Limit text box appears below this 

option. 

 

Aerosol Lambda/10 DF Limit 

(if Aerosol Removal Model is the 

Powers Model) 

The user enters a DF value to limit the amount of aerosol 

removal. Once this DF is reached in the compartment the 

aerosol lambda or removal coefficient is automatically set to 

1/10th its original value. The DF value must be 1.0 or greater 

and the default value is 50. 
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Powers Model Spray Table 

(if Aerosol Removal Model is the 

Powers Model) 

Specified as a function of spray flux and the fall height of the 
spray droplets (typically the distance between the spray headers 

and the containment floor). Select the Custom Editors ( ) icon 
for this text box to open the Editing Powers Model Spray Table 
window. Enter the time-dependent spray flux (cfm/ft2 or 
(m3/s)/m2) and spray height (ft or m). Unit switching is done by 
right-clicking on the black bar of the Navigator window and 
selecting Engineering Units and choosing either British or SI 
units. 

The spray flux and height are discussed in NUREG/CR-5966, “A 

Simplified Model of Aerosol Removal by Containment Sprays” 

[12]. 

The Powers’ model is valid in the spray flux ratio range 1.0E-05 

to 2.5E-03 m3/s-m2 (0.002 and 0.5 cfm/ft2) and a range of spray 

fall heights between 5 to 50 m (16.4 and 164 ft). 

 

Powers Model Spray Ratio 

(if Aerosol Removal Model is the 

Powers Model) 

The ratio of unsprayed to sprayed volume in the compartment. 

This is typically zero, as the unsprayed volume is often modeled 

as a separate compartment. Good mixing is assumed for any 

ratio above zero; if good mixing is not available, the sprayed and 

unsprayed compartments should be modeled separately. 

Powers Model Percentile 

(if Aerosol Removal Model is the 

Powers Model) 

The percentile model used in the calculation. Select the percent 

using the drop-down menu. 

• 10% 

• 50% 

• 90% 

Note: the 10% model yields the most conservative aerosol 

removal coefficients.  

Elemental Iodine Removal Model 

Determines the method by which the spray removes aerosol 

(particulate) radionuclides from the compartment. The user can 

select from the following options: 

• None (default) – elemental iodine is not removed from 

the compartment.  

• User Defined Coefficient Table – elemental iodine is 

removed using user-specific removal rate coefficients 

input by the user. When this option is selected, the 

Elemental Iodine Removal Coefficients, Elemental-I DF 

Limit Enables, and Elemental-I DF Limit text boxes 

appear below this option.  
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Elemental Iodine Removal 

Coefficients 

(if Elemental Iodine Removal Model is 

set to the User Defined Coefficients) 

Defines the elemental iodine radionuclide removal coefficients 

used to determine the elemental iodine removal rate as a function 

of time. Select the Custom Editors ( ) icon for this text box to 

open the Editing Elemental Iodine Removal Coefficients window. 

The user enters time-dependent elemental iodine removal 

coefficients (1/hr) in the data entry table.  

Elemental-I DF Limit Enabled 

(if Elemental Iodine Removal Model is 

set to the User Defined Coefficients) 

The user selects from either True or False. If True is selected, the 

Elemental-I DF Limit text box appears below this option.  

Elemental-I DF Limit 

(if Elemental Iodine Removal Model is 

set to the User Defined Coefficients) 

The user enters a DF value to limit the amount of elemental 

removal. Once this DF is reached in the compartment, the 

elemental lambda or removal coefficient is automatically set to 

zero. The DF value must be 1.0 or greater and the default value 

is 20. 

Organic Iodine Removal Model 

Determines the method by which the spray removes organic 

iodine from the compartment. The user can select from the 

following options: 

• None (default) – organic iodine is not removed from the 

compartment. 

• User Defined Coefficient Table – organic iodine is 

removed using user-specified removal rate coefficients 

as an organic removal coefficient over time. When this 

option is selected the Organic Iodine Removal 

Coefficients text box appears below this option.  

 

 

Organic Iodine Removal 

Coefficients 

(if Organic Iodine Removal Model is 

the User Defined Coefficients) 

Defines the organic iodine radionuclide removal as a function of 

time. Select the Custom Editors ( ) icon for this text box to 

open the Editing Organic Iodine Removal Coefficients window. 

The user enters time-dependent elemental iodine removal 

coefficients (1/hour) in the data entry table. 

Note: The NRC does not credit organic deposition in design basis 

calculations. 
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2.4.4 Dose Locations, Breathing Rates, and Χ/Q Tables 

Section 2.3.3 demonstrates the general approach for defining dose locations, breathing rates, 

and Χ/Q tables. Generally, the default breathing rates are used for most analyses and are 

entered under the Dose Locations node in the Property window. The values for Χ/Q are 

specified through the use of data entry tables as illustrated in Section 2.3.3 (Figure 2-33). 

Tables 2-13 and 2-14 list the available inputs for the Dose Locations and Χ/Q Tables nodes in 

SNAP/RADTRAD. 

 

Table 2-13 Summary of SNAP/RADTRAD Inputs - Dose Locations 

Input Description 

 

Name 

The EAB or LPZ dose location names are set by 

SNAP/RADTRAD. Other dose location names (i.e. control 

room) are created by the user. 

 

Description 

The EAB or LPZ dose location descriptions are set by 

SNAP/RADTRAD. Other dose location descriptions (i.e. control 

room) must be created manually by the user. 

 

 

Component Number 

Multiple dose locations can be used in a model and the 

SNAP/RADTRAD Model Editor assigns the number. These 

numbers must begin with number 1 and increase sequentially 

for each additional component. 

Breathing Rates 

Defines the breathing rates at the dose locations as a function 

of time. Select the Custom Editors ( ) icon for this text box to 

open the Editing Breathing Rates window. The user can then, 

if necessary, select the default breathing rates by left-clicking 

the Default button and choosing between either the EAB/LPZ 

or Control Room options. The default breathing rates for each 

are listed below: 

EAB/LPZ 

Time (h) Breathing Rates 

(m3/s) 

0.0 3.5E-04 

8.0 1.0E-04 
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24.0 2.3E-04 

Control Room 

Time (h) Breathing Rates 

(m3/s) 

0.0 3.5E-04 

 Additionally, the user can enter time-dependent breathing rates 

(ft3/min or m3/s) in the data entry table. 

X/Q Table 

Specifies the X/Q table to be used with this dose location. Use 

the Select ( ) icon to open the Select from X/Q Tables 

window to link to one of the available X/Q Tables. 

Occupancy Factors 

Specifies the occupancy factors table to be used with the 

control room (or the technical support center) dose locations. 

Use the Custom Editors ( ) icon to open the Editing 

Occupancy Factors window. The user can then provide time 

dependent occupancy factors for the dose location. Occupancy 

factors may only be input for the control room compartment.  

 

Table 3-14 Summary of SNAP/RADTRAD Inputs - X/Q Tables 

Input Description 

Name 

X/Q values are specified for the EAB and 
LPZ dose locations by default in 
SNAP/RADTRAD. Users must specify X/Q 
data for the EAB and LPA. X/Q data for 
additional dose locations can be specified 
by the user (optional) 

Component Number 

The EAB is set to X/Q Table 1 and LPZ is 
set to X/Q Table 2 by default in 
SNAP/RADTRAD. User-specified X/Q 
tables are automatically numbered by 
SNAP/RADTRAD. The component number 
can be changed by the user, but it is 
suggested to keep X/Q (along with other 
components) in numerical order.  

Description 
Specified by the user to add a description of 
the component. 

X/Q Table 
Select the Custom Editors ( ) icon for this 
text box to open the Editing X/Q Tables 
window. The user enters time-dependent or 
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duration-dependent X/Q values (s/m3) in the 
data entry table.  

X/Q Time Option 

When Regulator Guide Revision is set to 
Rev 1, the box to pick the timing option for 
the X/Q tables shows up in the uppermost 
X/Q Tables tab (shows up as X/Q Tables 
[<number of tables>]). When clicked, this 
box allows the user to pick between two 
options, Time and Duration. When Time is 
picked, the Time column in the X/Q tables 
will be set to a specific problem time. When 
Duration is picked, the Time column will 
change to Duration and the values will no 
longer be set to a certain problem time but 
will last the length of the duration specified. 
RADTRAD will use the highest value at the 
worst two-hour dose period for the dose 
location linked to the X/Q table. The 
duration will be split evenly before and after 
the worst two-hour dose time if the duration 
for the value is longer than two hours. The 
remaining values will be used in descending 
order from that time.   

One note is the link between the dose location and X/Q table. Like most of the functions in the 
SNAP Model Editor there is a couple of different ways to create the link between the dose 
location and the X/Q Table. The easiest way to establish this link is by clicking on the main X/Q 
Tables [2] node in the Navigator window to view the Property window for this node. In the 
Property window, select the Custom Editors ( ) icon to the right of the Onsite X/Q Tables text box 
to open the Onsite X/Q Table Map window (Figure 2-59). Alternatively, the user can also open the 
Onsite X/Q Table Map window by opening the Property window for the environment compartment 
and select the Custom Editors ( ) icon to the right of the Onsite X/Q Tables text box.  

The Onsite X/Q Table Map window will appear, and the user can link the X/Q table and dose 
location. In the Onsite X/Q Table Map window, the provided row headers list each of the 
pathways which are entering the environment. These are annotated further by the Release to 
Environment label to the left of the rows. Column headers in the Onsite X/Q Table Map window 
represent the pathways out of the environment. These are annotated by an Intake from 
Environment label placed above the table. Each column represents an exhaust while every row 
represents an inflow. To map an X/Q table, click within a cell to enable the Select icon. Click the 
Select icon to open the Select from X/Q Tables window; use this window to select the X/Q Table 
mapped to the inflow and exhaust. Users should note that SNAP/RADTRAD does not allow X/Q 
tables to be defined for exhaust from the control room to the environment. The remaining nodes 
under the Navigator window are listed and described in Table 2-15.  
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Figure 2-59 Onsite X/Q Table Map Window 

 

Table 2-14 Summary of SNAP/RADTRAD Inputs - Remaining Inputs 

Input Description 

Connections 

Connections among compartments (paths), dose locations, and source connections can be specified. 

Usually, drag and drop is used. Note that connections between compartments cannot be created by 

the Navigator window. A pathway needs to be defined and then the connection needs to be made 

using the Connection Tool ( ) icon in the View / Dock window (see Section 2.3.2). 

Job Streams 

 

 

Name 

The name for this job stream. This will be used to generate the 

relative path for the tasks that make up this stream. The default 

value for the name is Simple_Stream and it is recommended 

that SNAP/RADTRAD users change this to a unique name that 

is identifiable to the model (see Section 2.2.2). 

Description Specified by user (optional). 
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Stream Type 

Defines the type of calculation that may be implemented through 

this job stream. The user can select from the following options: 

• Basic Job Stream (default) – a simple job stream. 

• Numeric Combination – builds a set of input models by 

modifying one or more shared numeric variables. Each 

selecte4d shared numeric will either iterate through a list 

of predefined values or increment from a start value to 

an end value.  

• Tabular Parametric – the parametric case takes the form 

of a table of shared variable values.  

• Dakota Uncertainty – uncertainty support for the Dakota 

toolkit.  

File Groups 

Typically, the File Groups text box is not used in 

SNAP/RADTRAD. This option defines groups of input sources 

and forces files inside file sets to be associated one-to-one with 

other file sets or parametric model node outputs.  

Platform 
The platform that this stream will be submitted to by default. The 

default value for SNAP/RADTRAD is Local. 

Root Folder 

The calculation server folder where the job stream is executed 

(see Section 2.2.2). Select the Custom Editors ( ) icon for this 

text box to open the Edit Calculation Server Root Folders 

window. 

Relative Location 

The relative location of this stream in relation to the selected 

staging location. The staging location is where intermediate files, 

such as the stream definition, will be stored while a job stream is 

running (see Section 2.4.2 of reference [4] for more details).  

Log Level 

Typically, the Log Level text box is not changed from the default 

value (Information) in SNAP/RADTRAD. Defines the current log 

level for messages produced by this stream.  

View in Job Status 

This property determines whether the SNAP Job Status window 

will be opened to view the status of this stream after submission. 

The default value for SNAP/RADTRAD is Yes.  

Linear Execution 

Job Streams using Linear Execution are executed one task at a 

time, prioritized by their Step Number. In a normal (non-linear) 

Job Stream, tasks will be executed as soon as their 

dependencies are available (i.e. up-stream tasks are complete) 

up to the maximum number allowed by the platform. This option 

should only be used in situations where the stream must 
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execute one task at a time and each task must be completed 

before another can be executed. 

In most cases, including SNAP/RADTRAD, this value should be 

left at its default value (No). 

Numerics 

The SNAP user-defined Numerics feature is designed to allow properties of a model to be modified 

and/or calculated outside the normal input for the model. A user may create real, integer, Boolean, 

string, and table variables, as well and functions. Typically, the Numerics node is not used in 

SNAP/RADTRAD. See Section 2.5 of reference [4] for more details about User-Defined Numerics in 

other SNAP applications. 

Views 

The user can specify multiple views so that various model icons can be seen. Usually, one view 

(Default View) is sufficient for SNAP/RADTRAD models. The Property window for the Default View 

node values can be modified by the user as needed, but typically the default values for the text boxes 

will be sufficient for most models. Section 2.3.4 describes some of the options associated with the 

Default View node Property window text boxes. The user can select the Help ( ) icon for each 

Default View node Property window text box to obtain more information on each one. 

3.0 MODELS USED IN RADTRAD 

The radiological consequences of an accident in a nuclear reactor depend upon the quantity of 

the radioactive material that escapes to the environment or enters into the control room. 

SNAP/RADTRAD is designed to calculate doses at offsite locations, such as the EAB, LPZ and 

in the control room. Source term models from TID-14844 or from NUREG-1465 are 

incorporated into SNAP/RADTRAD to describe fission product release from the fuel to the 

containment. Models for natural deposition within a compartment and engineered removal 

mechanisms, such as sprays and filters are available in the code. Flow between compartments 

is modeled and HEPA and charcoal filters can be included in the flow paths for radionuclide 

removal due to filtration. Leakage to the environment can also be modeled and doses 

calculated to various points in the environment, such as the EAB and LPZ. After transporting 

the nuclides to different locations, SNAP/RADTRAD calculates the dose at user-specified 

locations. Note that much of the discussion in this section is based on the original RADTRAD 

documentation in NUREG/CR-6604 and its two supplements. 

3.1 Governing Equations in RADTRAD 
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The basic RADTRAD-AC model is a multi-compartment model where each compartment 

represents a portion of the plant being analyzed. Generally, the containment volume(s), 

environment, and control room(s) are modeled as compartments. Figure 3-1 presents a 

diagram illustrating a typical SNAP/RADTRAD model. This figure shows a two-volume 

containment connected to the environment. A two-volume containment compartment may be 

used to represent the sprayed and unsprayed portions of the containment. A control room is 

shown which contains ventilation intakes from the environment through two filtered flow 

pathways, one recirculating and one that intakes directly from the environment. Recirculating 

filtered flow paths are typically used to reduce the airborne radionuclide concentration in the 

control room. An unfiltered intake to the control room from the environment representing in 

leakage is also represented. The control room ventilation discharges back to the environment. 

Dashed lines denote connections with transfer rates of zero and are shown for completeness 

(e.g. no backflow from the control room or environment to the containment). 

The governing equations in the RADTRAD-AC are balanced first-order linear differential 

equations relating the release of radionuclides typically from the reactor core to a given 

compartment to the removal of radionuclides within a given compartment and the transfer of 

radionuclides among compartments. Within each compartment except the environment, the 

radionuclides that are airborne within that compartment are assumed to be uniformly distributed 

or mixed. The environment compartment is where the EAB and LPZ dose points are located. In 

many cases, the control room ventilation system draws suction from the environment. Note that 

coupling of transfer pathways from the containment to the EAB, LPZ and control room intakes is 

done using Χ/Q values. The Χ/Q values relate the amount of radionuclide released to the 

environment to the dispersed radionuclide concentration at a particular location in the 

environment. Since each Χ/Q value is associated with a release point and an intake location, 

the radionuclide inventory is not uniformly distributed in the environment compartment. 
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Figure 3-1 Schematic of a Typical SNAP/RADTRAD Dose Assessment Model 

The equations used to calculate the quantity of radionuclide in each compartment can be 

presented concisely in terms of the Λ𝑘,𝑗
𝑖  coefficients. However, it is important to note that 

multiple factors contribute to each of these transfer and removal rate coefficients. After 

presenting the concise form of the transport equations, the specific terms included in the 

Λ𝑘,𝑗
𝑖  coefficients will be presented.  

In developing equations representing the system shown in Figure 3-1, the quantity within each 

compartment or transferred from compartment is expressed in terms of the number of atoms in 

a chemical element group presented in Section 3.3 (Table 3-2). The quantity can also be 
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expressed in terms of radionuclide inventory for each nuclide. In the equations below, the term 

species can refer to a radionuclide or chemical element. 

Referring to Figure 3-1, the rate of change of the number of atoms in compartment 1 (upper left) 

is determined from Equation (3-1): 

 

𝑑𝑁1
𝑖

𝑑𝑡
= 𝑅1

𝑖 − Λ1,1
𝑖 𝑁1

𝑖 + Λ1,2
𝑖 𝑁2

𝑖 + Λ1,3
𝑖 𝑁3

𝑖 + Λ1,4
𝑖 𝑁4

𝑖 

(3 - 1) 

 

Where: 

    𝑅1
𝑖  = the source release rate of species i in compartment 1 in atoms/s 

Λ1,1
𝑖       = the removal rate of species i within compartment 1 in 1/s 

𝑁1
𝑖        = the inventory of species i in compartment 1 in atoms 

Λ1,2
𝑖       = the transfer rate of species i from compartment 2 to compartment 1 in 1/s 

𝑁2
𝑖        = the inventory of species i in compartment 2 in atoms 

Λ1,3
𝑖       = the transfer rate of species i from compartment 3 to compartment 1 in 1/s 

𝑁3
𝑖        = the inventory of species i in compartment 3 in atoms 

Λ1,4
𝑖       = the transfer rate of species i from compartment 4 to compartment 1 in 1/s 

𝑁4
𝑖        = the inventory of species i in compartment 4 in atoms 

The rate of change of the number of atoms in compartment 2 is given by Equation (3-2): 

𝑑𝑁2
𝑖

𝑑𝑡
= 𝑅2

𝑖 − Λ2,2
𝑖 𝑁2

𝑖 + Λ2,1
𝑖 𝑁1

𝑖 + Λ2,3
𝑖 𝑁3

𝑖 + Λ2,4
𝑖 𝑁4

𝑖 

(3 - 2) 

 

Where: 

 𝑅2
𝑖  = the source release rate of species i in compartment 2 in atoms/s 
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Λ2,2
𝑖       = the removal rate of species i within compartment 2 in 1/s 

Λ2,1
𝑖       = the transfer rate of species i from compartment 1 to compartment 2 in 1/s 

Λ2,3
𝑖       = the transfer rate of species i from compartment 3 to compartment 2 in 1/s 

Λ2,4
𝑖       = the transfer rate of species i from compartment 4 to compartment 2 in 1/s 
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The rate of change in the number of atoms in compartment 3 is given by Equation (3-3): 

𝑑𝑁3
𝑖

𝑑𝑡
= 𝑅3

𝑖 − Λ3,3
𝑖 𝑁3

𝑖 + Λ3,1
𝑖 𝑁1

𝑖 + Λ3,2
𝑖 𝑁2

𝑖 + Λ3,4
𝑖 𝑁4

𝑖 

(3 - 3) 

Where: 

    𝑅3
𝑖  = the source release rate of species i in compartment 3 in atoms/s 

Λ3,3
𝑖       = the removal rate of species i within compartment 3 in 1/s 

Λ3,1
𝑖       = the transfer rate of species i from compartment 1 to compartment 3 in 1/s 

Λ3,2
𝑖       = the transfer rate of species i from compartment 2 to compartment 3 in 1/s 

Λ3,4
𝑖       = the transfer rate of species i from compartment 4 to compartment 3 in 1/s 

 

 

 

The rate of change of the number of atoms in compartment 4 is given by Equation (3-4): 

𝑑𝑁4
𝑖

𝑑𝑡
= 𝑅4

𝑖 − Λ4,4
𝑖 𝑁4

𝑖 + Λ4,1
𝑖 𝑁1

𝑖 + Λ4,2
𝑖 𝑁2

𝑖 + Λ4,3
𝑖 𝑁3

𝑖 

(3 - 4) 

 

Where: 

    𝑅4
𝑖  = the source release rate of species i in compartment 4 in atoms/s 

Λ4,4
𝑖       = the removal rate of species i within compartment 4 in 1/s 

Λ4,1
𝑖       = the transfer rate of species i from compartment 1 to compartment 4 in 1/s 

Λ4,2
𝑖       = the transfer rate of species i from compartment 2 to compartment 4 in 1/s 

Λ4,3
𝑖       = the transfer rate of species i from compartment 4 to compartment 4 in 1/s 
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More generally, the rate of change of the number of atoms in the kth compartment in a set of n 

interconnected compartments is given by Equation (3-5) below: 

𝑑𝑁𝑘
𝑖

𝑑𝑡
= 𝑅𝑘

𝑖 − ∑ 𝜆𝑗,𝑗
𝑖 𝑁𝑘

𝑖

𝑛

𝑗=1

+ ∑ 𝜆𝑘,𝑗
𝑖 𝑁𝑗

𝑖

𝑗=1,𝑘≠1

 

(3 - 5) 

In Equation (3-5), Ri
k is the source release rate of species i in compartment k in atoms/s. The 

first summation represents the removal of terms from compartment k due either to removal 
within the compartment or transfer to another compartment. The second summation represents 
transfer from compartment j to compartment k. The general matrix formulation of transport 

Equation (3-5) is represented in Equation (3-6). 

 

(3 - 6) 

Note that the time derivative is represented by 𝑁𝑗
𝑖̇ . The Λ coefficient matrix is a transfer matrix 

where the diagonal terms are the removal coefficients applicable to a given compartment j 
(hence the – sign) and the off-diagonal terms are transfer coefficients relating the transfer of 
material from various compartments to compartment j.  

Off-diagonal transfer terms are calculated as f/V where f is the flow rate out of a compartment 

(volume units/s) and V is the compartment volume, yielding units of 1/s. This ratio is multiplied 
by the radionuclide inventory in the upstream connecting compartment to provide a source to 
the connecting downstream compartment. Diagonal terms or removal terms are more complex 
because of the various removal processes that are modeled in the RADTRAD-AC. However, 
the idea is the same in that a removal coefficient expressed in units of 1/s is multiplied by the 
radionuclide inventory to yield a removal rate. The terms included in the diagonal removal 
coefficients and the off-diagonal transfer coefficients are shown below (Equation 3-7) with 
details on the calculation of removal coefficients provided in Section 3.5. 
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The terms included in the diagonal removal coefficients each have unit of 1/s and are: 

Λ𝑗,𝑗
𝑖 = 𝜆𝑗,𝑠𝑝𝑟

𝑖 + 𝜆𝑗,𝑑𝑒𝑝
𝑖 + 𝜆𝑗,𝑓𝑖𝑙𝑡𝑒𝑟

𝑖 + ∑ 𝜆𝑘,𝑗
𝑖

𝑛

𝑘=1,𝑘≠𝑗

 

(3 - 7) 

 

Where: 

    λ𝑗,𝑠𝑝𝑟
𝑖        = the spray removal coefficient in 1/s 

λ𝑗,𝑑𝑒𝑝
𝑖        = the natural deposition removal rate in 1/s 

λ𝑗,𝑓𝑖𝑙𝑡𝑒𝑟
𝑖     = the filtered removal rated within a compartment in 1/s 

λ𝑘,𝑗
𝑖           = the removal rate from compartment j toward compartment k in 1/s 

The removal rate λ𝑘,𝑗
𝑖  includes a few different types of transfer between compartments as shown in 

Equation (3-8). 

 

𝜆𝑘,𝑗
𝑖 = 𝜆𝑘,𝑗,𝑙𝑒𝑎𝑘

𝑖 + 𝜆𝑘,𝑗,𝑓𝑖𝑙𝑡𝑒𝑟
𝑖 +

𝑓𝑘,𝑗

𝑉𝑗
 

(3 - 8) 

Where: 

    𝜆𝑘,𝑗,𝑙𝑒𝑎𝑘
𝑖      = the transfer via leakage paths in 1/s 

𝜆𝑘,𝑗,𝑓𝑖𝑙𝑡𝑒𝑟
𝑖    = the natural deposition removal rate in 1/s 

𝑓𝑘,𝑗            = the filtered removal rated within a compartment in 1/s 

    𝑉𝑗              = the removal rate from compartment j toward compartment k in 1/s 

The removal terms from Equation (3-8) are related to the off-diagonal transfer terms in Equation 

(3-6). However not all of the nuclide leaving compartment j necessarily reaches compartment k. 

The filtered flow and the DF related flow terms require an additional coefficient that indicates the 

fraction of the nuclide that was removed in transit. The terms in the off-diagonal transfer 

coefficients are shown in Equation (3-9). 
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Λ𝑗,𝑘
𝑖 = λ𝑗,𝑘,𝑙𝑒𝑎𝑘

𝑖 + (1 −
η𝑗,𝑘

𝑖

100
) λ𝑗,𝑘,𝑓𝑖𝑙𝑡𝑒𝑟

𝑖 + (
1

𝐷𝐹
)

𝑓𝑗,𝑘
𝑖

𝑉𝑘
 

(3 - 9) 

Where: 

    η𝑗,𝑘
𝑖        = the percent efficiency of the filter in the path from compartment k to j 

DF           = the nondimensional DF for path with flow from compartment k to j 

Equation (3-6) is solved in the RADTRAD-AC using a matrix exponential method based on work 

done in references [11] and [13]. Matrix exponential methods are used to solve systems of 

linear differential equations of the form �̇� = 𝑅 + Λ𝑁 subject to an initial condition N0. The units of 

the solution variable are expressed in atoms. This quantity can be converted to other units such 

as grams or Becquerels (Bq). Section 3.6 discusses how dose is calculated from the number of 

atoms. 
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Note that radionuclide decay is not explicitly included in Equation (3-6). Rather, decay is 

accounted for in the RADTRAD-AC by dividing the solution of the differential equations into two 

parts: (1) radioactive decay and daughter in-growth, and (2) radionuclide transport. Inclusion of 

radioactive decay and daughter in-growth modeling with Equation (3-4) significantly increases 

the size of the linear system as well as the computational load to solve the system. The 

separation of these calculations was used to overcome the limitations of personal computers 

available at the time the original version of the RADTRAD-AC was developed and has been 

retained to the present time. 

Radioactive decay and daughter production occur within a compartment, so no 

intercompartmental transfer needs to be considered. The equations that are solved for these 

processes at each time step are shown in Equation (3-10). 

𝑑𝑁𝑗
𝑖

𝑑𝑡
= ∑ λ𝑣β𝑣

𝑖 𝑁𝑗
𝑐

𝑛−1

𝑣=1

+ λ𝑑𝑒𝑐𝑎𝑦
𝑖 𝑁𝑗

𝑖 

(3 - 10) 

Where: 

    β𝑣
𝑖      = the fraction of nuclide v that decays to nuclide i (dimensionless) 

λ𝑣            = the decay rate associated with β𝑣
𝑖  in 1/s 

𝑁𝑗
𝑣           = the quantity of nuclide v in compartment j 

         λ𝑑𝑒𝑐𝑎𝑦
𝑖      = the rate of decay of nuclide i in 1/s 

The decay and transport calculations are performed alternately. That is, the code begins its 

integration over a time step by analyzing the effect of radioactive decay and daughter in-growth 

on the inventory of all compartments using Equation (3-10). After updating the inventory, the 

code calculates the effect of radionuclide transport between compartments during that same 

time step using Equation (3-6). This process of alternating between radioactive decay and 

daughter in-growth and radionuclide transport continues until the specified end time is reached. 

In calculations where radioactive decay is not modeled, the solution algorithm is simplified to the 

single step of calculating radionuclide transport. 

During the course of its numerical integration, the code keeps track of the quantity of each 

nuclide at each location. Locations include not only compartment volumes, but surfaces and 
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filters as well. By tracking the radionuclides in this manner, conservation of mass can be 

verified. 

The analytical solution of a matrix equation in the form Ṅ = ΛN + R is N(t) = N(0)eAt - A-1(eAt - 
1)R  from Equation 3.7 and 3.8 of reference [13], can be confirmed by substituting the solution 
into the matrix equation. Numerical solution of the transport equations is accomplished by 
constructing the solution as a Taylor series expansion of the analytical matric exponential 

solution in terms of t (specifically the eAt term which is the only time dependent term) and 
truncating the series when the estimated relative error is less than 1E-08. One advantage of 
this approach is its capacity to obtain good solutions over large time intervals. The key 
assumption is that there is no change in any phenomenon during a time step, i.e., that the 
coefficients in the ordinary differential equations (ODEs) are constant. 

Without this assumption, the method would not apply. In order to accommodate this 

assumption, the code synchronizes time steps with the user-supplied phenomena in order to 

capture changes in the coefficients. Another advantage of this approach is that it is very fast 

and extremely robust. The algorithm is essentially identical to the one described in reference 

[13]. A useful discussion of matrix exponential methods and how they are solved is given in 

reference [14]. 

The assumption that all nuclides can be grouped according to their chemical and transport 

similarities is also applied in the solution. Thus, four transport groups were used: noble gases, 

elemental iodine, organic iodine, and aerosols. Note that the aerosol transport group includes 

all radionuclides assumed to be aerosol as listed in Section 3.3. These transport groups 

interact with their surroundings differently, but all components of any one group act the same. 

This implies that all xenon and krypton isotopes will transport identically and that cesium, 

barium, and all other aerosol isotopes will transport identically. The user specifies the fractions 

for the released iodine and thus partitions the iodine within the latter three groups. 

3.2 Adaptive Time Step Algorithm 

The RADTRAD-AC includes a default algorithm for selecting time step size that is fast and has 

proven to produce good results for typical models. However, the default time step algorithm 

does not perform error checking to verify that a solution has converged. The Adaptive Time 

Step option increases the computational cost significantly, but allows the RADTRAD-AC to 

estimate error and adjust the time step size keeping the error within a specified limit. For many 

models, the Adaptive Time Step option will not change results significantly because the default 

time step algorithm is adequate to achieve convergence. 
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As discussed above, a single system of coupled ODEs that simultaneously represents all of the 

phenomena considered by the RADTRAD-AC is defined. Computation time can be reduced by 

dividing the calculations into two parts: (1) transport and (2) radioactive decay. The 

fundamental premise behind this approach is that during a time step of small enough duration, 

ignoring the interdependence of the two components of the calculations results in negligible 

error. That is, numerically solving the transport equations defining transfer of material between 

compartments during a time step can be solved numerically, without taking account of the 

radioactive decay and in-growth occurring over that period, will have a negligible impact on the 

transport solution. Likewise, solving the radioactive decay and in-growth equations during a 

time step, without considering the simultaneous phenomenon of transport between 

compartments, will have a negligible impact on the decay and in- growth results. Reducing the 

time step size reduces the error that results from separately calculating transport and 

radioactive decay, and the RADTRAD-AC automatically reduces the default time step size when 

decay is active. If the user is concerned with this approach, adaptive time step control can be 

enabled to assure that the error introduced by this assumption is small. 

The purpose of an adaptive time step algorithm is to actively choose the time step size in order 

to keep the solution error below a specified limit. The exact error is not known, so error must be 

estimated. The error estimate is then used to decide if the time step is too large (or too small) 

and adjust the time step size accordingly. The adaptive time step algorithm involves the 

following steps: 

1. The error is estimated at each time step by calculating two solutions for the next time 

step, with one solution being more accurate. The magnitude of the difference between 

the solutions is used to estimate the error. The errors range from 0, if there is no error, 

to a maximum error of 1. The error is scaled in order to reduce the number of time steps 

taken in regions where the solution is not changing significantly. The scaled error is also 

limited to the range 0 to 1. 

2. The scaled error is compared to the user specified maximum error and the following 

steps are taken depending on the magnitude of the error: 

a. If the error value is above the maximum error value (0.001 by default, but can be 

set by the user), then the time step size is cut in half and the calculation is 

repeated. 

b. If the error value is between the maximum error and 1/10 the maximum error, the 

time step size is kept. 
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𝑗
𝑗 

c. If the error is below 1/10 the maximum error the time step size is doubled starting 

with the next time step. 

This algorithm works without modifications as long as error decreases as the time step size 

decreases and the time step size stay above the minimum time step size. Modifications to this 

logic to address special cases are discussed later in this section. 

The governing equations for the RADTRAD-AC are defined and solved in terms of the 

radionuclide inventory (atoms) in each compartment. The key results; however, are the dose to 

hypothetical individuals located at specified locations. The dose values were used in calculating 

an error estimate since they are the primary values of interest. Additionally, the dose values are 

included in the plot file which makes it easier to understand the adaptive time step controller 

behavior and diagnose problems. 

The ODE solves for Ni
j(tm) which is the number or atoms of nuclide i in compartment at time tm (the 

time at time step m). Based on the nuclide quantities, dose values are calculated at each dose 

location specified in the model. Two different dose pathways are modeled cloudshine and 
inhalation, to calculate dose to the skin, thyroid, and TEDE. These doses are referred to as 
‘dose categories’ for the remainder of this section. The dose that is calculated can be 

represented as a function of time by a vector Dk(tm), where the 𝑘 index represents the different dose 
categories. A separate error is calculated for each category, and the largest of these is 
recorded as the error. 

To estimate the error at each time step m, two solutions are calculated for time 𝑡𝑚+1 = 𝑡𝑚 + Δ𝑡 

starting from the base solution point Ni
j™, with associated dose represented as Dk,B (dose for 

category k at the base point):
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1. The first solution at time tm+1 is calculated by advancing the ODE solver by a full time 

step of size Δt. The associated dose is represented as Dk,S1 (solution 1 dose for 
category 𝑘). 

2. The second solution for time tm+1 is calculated by advancing the ODE solver by two half 

time steps (i.e. time steps of size Δt/2). The associated dose is represented as Dk,S2 

(solution 2 dose for category 𝑘). 

In order to estimate the error, it is useful to define a measure of magnitude for the dose vector. 
The most obvious choice is the Euclidean length, which gives an overall measure of the 
magnitude of the dose vector. The magnitude (or norm) of the dose vector will be represented 

as ‖D‖. 

To estimate the local error for dose category 𝑘𝑘, the magnitude of the difference between the two 

solutions ‖Dk,S2 ─ Dk,S 1‖ is compared to the magnitude of the change in the solution over the 
time step. The magnitude of the change in the dose over the current time step for solution 1 
and 2 is ‖Dk,S 1 ─ Dk,B‖ and ‖Dk,S 2 ─ Dk,B‖ respectively. To characterize the change in the 

magnitude, the two values are averaged (‖Dk,S1 ─ Dk,B‖ + ‖Dk,S 2 ─ Dk,B‖)/2. A slightly modified 
version of the following formula is used in Equation (3-11) to calculate a local error: 

𝑒𝑟𝑟𝑜𝑟 =  
2 ‖𝐷𝑘,𝑆2 − 𝐷𝑘,𝑆1 ‖

‖𝐷𝑘,𝑆1 − 𝐷𝑘,𝐵 ‖ +  ‖𝐷𝑘,𝑆2 − 𝐷𝑘,𝐵‖
 

(3 - 11) 

If we consider that the points Dk, B, Dk,S 1, and Dk,S 2 form a triangle, and that the error above is the 
magnitude (or length) of one side of the triangle compared to the average magnitude of the two 
remaining sides, it can be shown that the range of values for the error is 0 to 2. A value of 0 
occurs if the dose solutions Dk,S 1 and Dk,S 2 are identical, in which case the numerator is 0. The 
range 0 to 1 seems to be a more natural choice for specifying an allowable error fraction, so the 
error equation was modified slightly by dropping the factor of 2, resulting in Equation (3-12) for 
local error: 

𝑙𝑜𝑐𝑎𝑙 𝑒𝑟𝑟𝑜𝑟 =  
‖𝐷𝑘,𝑆2 − 𝐷𝑘,𝑆1 ‖

‖𝐷𝑘,𝑆1 − 𝐷𝑘,𝐵 ‖ +  ‖𝐷𝑘,𝑆2 − 𝐷𝑘,𝐵‖
 

(3 - 12) 

To provide an example of how Equation (3-12) works, the error will be calculated for a set of two 
nuclides (I-131 and I-132). Table 3-1 represents the values for I-131 and I-132 at the base step 
and after solution 1 and solution 2 are calculated. 
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Table 3-1 Local Error Solutions for I-131 and I-132 

 

Solution Step 

 

I-131 Dose 

(rem) 

 

I-132 Dose 

(rem) 

Magnitude 

(I-1312 + I-1322)0.5 

(rem) 

DB (20 hrs) 0.75 0.00130  

DS1 (24 hrs) 0.92 0.00153  

DS2 (24 hrs) 0.90 0.00150  

DS1 ─ DB 0.17 0.00023 0.17000016 

DS2 ─ DB 0.15 0.0002 0.15000013 

DS1 ─ DS2 0.02 0.00003 0.020000002 

Note that the change in the dose value (0.17) over a solution step for I-131 (Dk,S 1 ─ Dk,B ) is much 

larger than the change in the dose value of 0.00023 for I-132. This is reflected in the magnitude 

of the dose vector since the value is very close to the I-131 value of 0.17 rem. In the error 

calculation below the small tail value is dropped. In general, it is the dose channels with the 

largest change in dose over a time step that dominates the error calculation. Over this time 

step, the local error is calculated by Equation (3-13). 

𝑙𝑜𝑐𝑎𝑙 𝑒𝑟𝑟𝑜𝑟 =
0.02

(0.17 + 0.15)
= 0.0625 

(3 - 13) 

The default threshold for error is 0.001, so the local error exceeds the default threshold by an 

order of magnitude. 

In test simulations it was found that the RADTRAD-AC required very small time steps to limit 

error despite the fact that the rate of dose increase was very small over the first few seconds in 

these cases. In order to avoid taking an excessive number of time steps over a time period 

when the changes in dose were small, the error is scaled in proportion to how quickly the dose 

is increasing compared to a more global measure of the rate of change in dose. 

An error scaling factor is calculated using the following steps: 
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1. The local rate of change for the dose is characterized by taking the change in dose (rem) 
over the time step (i.e. ‖Dk,S2 ─ Dk,B‖) and dividing this by the time step size Δt. This 

gives a local rate of change d‖D‖/dt. 

2. Two more global rate of change values are then calculated: 

a. One global estimate of d‖D‖/dt is calculated by taking a time step of the default 

time step size. The error may be large for this time step, but the rate of change 

in dose provides a general estimate of how rapidly the dose is expected to 

increase over time steps of the default size. The calculation is only performed 

over the first 1/10 of the simulation because early on, this is the best estimate 

that can be obtained of the rate of change in dose. Later in the simulation, the 

calculated dose provides a reasonable estimate. 

b. The value d‖D‖ = ‖Dk,S ─ Dk,B‖ is integrated (i.e. summed over the time steps) 

and divided by the total simulation time DT. This basically gives a rate at which 
dose would have to increase over the whole simulation to get the current dose 
magnitude. 

3. The scaling factor is calculated by dividing the local rate of change by the maximum of 

the two global rate estimates from step 2. If the local dose is changing at a very slow 

rate compared to the global measure, then the error is of less concern since the error is 

small in comparison to time when dose is increasing rapidly. If the scaling factor 

exceeds 1, it is set to 1. 

4. The scaled error is calculated by multiplying the error by the scaling factor. The scaled 

error can then be used to decide if the time step size needs to be cut, held constant, or 

increased. 

In some cases, it may be desirable to directly control the time step size even if the adaptive time 

step algorithm is used. This can be done by opening the Property window for the Model 

Options node and then left-clicking on the Custom Editors ( ) icon for the Time Step Table text 

box to open the Editing Time Step Table window as shown in Figure 3-2. The user can then 

use the Add button to add rows to the table and specify a time step table with the minimum and 

maximum time step size set to the same value as shown in Figure 3-3. This will override the 

adaptive time step algorithm. 
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Figure 3-2 Property Window for the Model Option Node 
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Figure 3-3 Editing Time Step Table Window 

In test cases, it was found that the reported error was always large over the first few time steps. 

To stabilize the simulation, a few time steps are taken at the minimum time step size. The 

adaptive time step logic is interrupted occasionally over the first 1/10 of the simulation to take a 

step of the default size in order to calculate a scaling factor. In some cases the error may 

increase as the time step size is decreased due to round off error or due to instability of the 

numerical algorithm (which can happen if the time step size is too large). The adaptive time 

step algorithm tracks the error vs. time step size. If it detects a region where the error increases 

as the time step size decreases, the algorithm just uses a default time step for a few steps and 

returns control to the adaptive time step logic. In some cases the adaptive time step algorithm 

cuts the time step until the minimum time step size is reached. The adaptive time stepper will 

count how many steps it remains at the minimum time step size. If more than a few time steps 

are taken at the minimum time step, a time step of the default size is requested. This approach 

is used to keep the adaptive time algorithm from performing calculations for long periods at the 

minimum time step size. 

3.3 Radionuclide Release Mechanisms 

A large number of radionuclides in various chemical forms are generated in the fuel as the 

reactor operates. The nuclides which are generated are categorized into chemical groups in 

order to make the problem more tractable. Table 3-2 and Table 3-3 list the chemical grouping 

used in SNAP/RADTRAD. Note that the chemical grouping was revised from RADTRAD 
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version 3.03 because of the addition of the ICRP-38 nuclide set by combining strontium and 

barium into a single group and adding the other chemical elements as Group 9. Further 

changes were made in Revision 1 of Regulatory Guide 1.183 adding the Molybdenum group 

and slightly altering some of the other groups as shown in Table 3-3. The Revision one 

grouping is used when the model option for Regulatory Guide Revision is set to Rev 1. Since 

SNAP/RADTRAD treats all nuclides that are in Groups 3 and above as aerosols, there were no 

internal coding changes needed. A representative nuclide is used to identify each chemical 

group. The tenth group for non-radioactive aerosols is retained in SNAP/RADTRAD. 
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Table 3-2 Chemical Element Groups for SNAP/RADTRAD RG 1.183 Rev. 0 

Group 

Number 

 

Group Name 

RG 1.183 

Rev 0 

Chemical 

Grouping 

 

Additional Nuclides 

1 Noble Gases Kr, Xe H (H-3), Ne, Ar, Rn, N, O 

2 Halogens I Br 

3 Alkali Metals Cs, Rb  

4 Tellurium Group Te, Sb Se 

5 
Barium, Strontium 
(Alkaline Earth 

Metals) 

Sr, Ba Sr, Ba 

6 Noble Metals 
Ru, Rh, Mo, 
Tc, Co 

Pd 

7 Cerium Group Ce, Pu, Np  

8 Lanthanides 
La, Zr, Nd, 

Nb, Pr, Y, Cm, 

Am 

 

Eu, Pm, Sm 

 

 

9 

 

 

Others 

 Ac, Ag, Al, As, At, Au, Be, Bi, Bk, C, Ca, Cd, 

Cf, Cl, Cr, Cu, Dy, Er, Es, F, Fe, Fm, Fr, Ga, 

Gd, Ge, Hf, Hg, Ho, In, Ir, K, Lu, Md, Mg, Mn, 

Na, Ni, Os, P, Pa, Pb, Po, Pt, Ra, Re, S, Sc, 

Si, Sn, Ta, Tb, Th, Ti, Tl, Tm, U, V, W, Yb, Zn 

10 
Non-Radioactive 
Aerosols 

No change F, Cl a 

a. F and Cl (halogens) are included in Group 10 since they likely do not behave like iodine. 
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Table 3-3 Chemical Element Grouping for SNAP/RADTRAD RG 18.183 Rev. 1 

Group 

Number 

 

Group Name 

RG 1.183 

Rev 1 

Chemical 

Grouping 

 

Additional Nuclides 

1 Noble Gases Kr, Xe H (H-3), Ne, Ar, Rn, N, O 

2 Halogens I Br 

3 Alkali Metals Cs, Rb  

4 Tellurium Group Te, Sb Se 

5 
Barium, Strontium 
(Alkaline Earth 

Metals) 

Sr, Ba Sr, Ba 

6 Noble Metals 
Ru, Rh, Co 

Pd 

7 Cerium Group Ce, Pu, Np   Zr 

8 Lanthanides 

La, Nd, Pr, Y, 
Cm, Am 

Eu, Pm, Sm 

 

 

9 

 

 

Others 

 Ac, Ag, Al, As, At, Au, Be, Bi, Bk, C, Ca, Cd, 

Cf, Cl, Cr, Cu, Dy, Er, Es, F, Fe, Fm, Fr, Ga, 

Gd, Ge, Hf, Hg, Ho, In, Ir, K, Lu, Md, Mg, Mn, 

Na, Ni, Os, P, Pa, Pb, Po, Pt, Ra, Re, S, Sc, 

Si, Sn, Ta, Tb, Th, Ti, Tl, Tm, U, V, W, Yb, Zn 

10 
Non-Radioactive 
Aerosols 

No change F, Cl a 

11 
Molybdenum 

Mo, Tc, Nb  

a. F and Cl (halogens) are included in Group 10 since they likely do not behave like iodine. 
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The iodine group is further subdivided into three physical forms, which are elemental, organic 

and aerosols. The fraction of each form depends on the source term model used. The 

radionuclide inventory for the fuel for all radionuclides of interest in dose analysis on a per MWth 

basis for PWR and BWR plants is included in SNAP/RADTRAD. 

Two models available in SNAP/RADTRAD in which to model the release from the fuel are the 

TID-14844 model and the NUREG-1465 model. The TID-14844 model, which is generally 

applied to LOCA analysis, is based on the assumption that 100 percent of the noble gas 

radionuclides and 50 percent of the iodine radionuclides are available for release to the 

containment. The iodine release is reduced by a factor of 2 to account for deposition within the 

containment so that 25 percent of the iodine remains airborne in the containment based on the 

assumptions in Regulatory Guide 1.3 (RG 1.3), Revision 2, “Assumptions used for Evaluating 

the Potential Radiological Consequences of a Loss of Coolant Accidents for Boiling Water 

Reactors,” [15] and Regulatory Guide 1.4 (RG 1.4), Revision 2, “Assumptions used for 

evaluating the Potential Radiological Consequences of a Loss of Coolant Accidents for 

Pressurized Water Reactors” [16]. No adjustment is made for the noble gases since 

radionuclides in this group are inert. The release is assumed to be instantaneous (a puff 

release) and is assumed to occur at the beginning of the accident (t=0). The fractions for the 

physical form of iodine used in the TID-14844 model are: elemental – 0.91, organic – 0.04, and 

aerosol – 0.05. 

An alternative release model was developed in NUREG-1465 for LOCA analysis that 

considered the results of severe accident research conducted by the NRC. In this model, the 

release from the fuel is subdivided into the Gap release and the Early In-vessel release. 

Radionuclides that have accumulated in the gap between the fuel pellet and the cladding that is 

released when cladding failure commences is the Gap release. The Early In-vessel release 

occurs as fuel rod temperatures increase driving the volatile nuclides, such as iodine from the 

fuel pellet into the vessel through the failed cladding. The release fractions for the Gap and 

Early In-vessel releases are summarized in the table below: 
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Table 3-4 Default DBA Release Rates 

Group Gap Release Early In-Vessel 
Release 

 RG 1.183 
Rev. 0 

RG 1.183 
Rev. 1 

RG 
1.183 
Rev. 0 

RG 
1.183 
Rev. 1 

Nobel Gases PWR 0.05 0.022 0.95 0.94 

BWR 0.05 0.008 0.95 0.96 

Halogens PWR 0.05 0.007 0.35 0.37 

BWR 0.05 0.003 0.25 0.54 

Alkali Metals PWR 0.05 0.005 0.25 0.23 

BWR 0.05 0.003 0.2 0.14 

Tellurium PWR 0 0.007 0.05 0.3 

BWR 0 0.003 0.05 0.39 

Alkali Earth 
Metals 

PWR 0 0.0014 0.02 0.004 

BWR 0 0 0.02 0.005 

Noble Metals PWR 0 0 0.0025 0.006 

BWR 0 0 0.0025 0.0027 

Cerium PWR 0 0 0.0005 1.5E-7 

BWR 0 0 0.0005 1.6E-7 

Lanthanides PWR 0 0 0.0002 1.5E-7 

BWR 0 0 0.0002 2.0E-7 

Others PWR 0 0 0 0 

BWR 0 0 0 0 

Nonradioactive 
Aerosols 

PWR 0 0 0 0 

BWR 0 0 0 0 

Molybdenum PWR N/A 0 N/A 0.1 

BWR N/A 0 N/A 0.03 

 

The fractions for the physical form of iodine used in the NUREG-1465 model are: elemental – 

0.0485, organic – 0.0015, and aerosol – 0.95. 

Release phase duration is considered in NUREG-1465 in contrast to the instantaneous release 

model used in TID-14844. The release phase durations from Table 3-6 of NUREG-1465 are 

listed in Table 4-3. Additionally, the radionuclides for each phase are assumed to be uniformly 

released over the time period corresponding to that phase. These values do not differ between 

regulatory guidance revisions. 
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Table 3-5 Release Phase Durations for PWRs and BWRs 

 

Release Phase 

Duration (hours) 

PWR BWR 

Gap 0.5 0.5 

Early In-Vessel 1.3 1.5 

Note that Gap release fraction models are available in SNAP/RADTRAD. The three models 

which are available are based on Table 3 of RG 1.183 Revision 0, Tables 3 and 4 of RG 1.183 

Revision 1, and Regulatory Guide 1.25 (RG 1.25), “Assumptions Used for Evaluating the 

Potential Radiological Consequences of a Fuel Handling Accident in the Fuel Handling and 

Storage Facility for Boiling and Pressurized Water Reactors,” [17]. The Gap release fractions 

used are listed in Table 3-4.  It should be noted that the release fractions for revision 1 are only 

used when the model option for Regulatory Guide Revision is set to Rev 1.
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Table 3-6 Gap Fractions Used in SNAP/RADTRAD 

Radionuclide RG 1.25 RG 1.183 Rev. 0 RG 1.183 Rev. 1 

I-131 

PWR 0.12 a 0.08 0.07 

BWR 0.12 a 0.08 0.03 

I-132 

PWR N/A N/A 0.07 

BWR N/A N/A 0.03 

Kr-85 

PWR 0.3 0.1 0.40 

BWR 0.3 0.1 0.32 

Other Noble 

Gases 

PWR 0.1 0.05 0.06 

BWR 0.1 0.05 0.02 

Other Iodines 

PWR 0.1 0.05 0.04 

BWR 0.1 0.05 0.02 

Alkali Metals 

PWR 0.0 0.12 0.2 

BWR 0.0 0.12 0.16 

a. The value in RG 1.25 is 0.1 and this value was increased by 20 percent to account for the use of extended burnup fuel, per 

NUREG/CR-5009, “Assessment of the Use of Extended Burnup Fuel in 

Light Water Power Reactors,” [18]. 

The FHA model for RG 1.183 Revision 0 also requires several other input parameters including 

the number of fuel rods or assemblies in the core, the number of fuel rods or assemblies 

damaged, the fraction of fuel rods or assemblies damaged, the radial peaking factor for the 

damaged assemblies, the pool iodine DF and the decay period. The pool iodine DF is set to a 

default value of 200 which is from Appendix B of RG 1.183 for water pool depths of 23 feet or 

greater. The decay time, essentially the time since plant shutdown is required in both options of 

the regulatory guide revision. Note that the decay calculation carried out by the 

SNAP/RADTRAD Model Editor input for the fuel handling accident does not include 

contributions from daughter products. 
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A new FHA model was added to Revision 1 of RG 1.183  that added in the re-evolution of 

elemental iodine. This model also requires the spent fuel pool volume, spent fuel pool surface 

area, the volumetric flow of the pool recirculation system, the recirculation system filter 

efficiency for iodine, the mass transfer coefficient, the acidity of the pool, and the inventory of 

nonradioactive iodine or I-127 (only seen in SNAP/RADTRAD when Rev 1 is set in the model 

options). Another addition to the Rev. 1 model is a box labeled pin pressure that will calculate 

the pool DF with regards to the fuel pin pressure. The equations below are equations B-1 

through B-3 of RG 1.183 Revision 1. 

𝐷𝐹𝐼 = 81.046𝑒0.305(𝑡/𝑑) 

(3 - 14) 

Where:  

𝑡 = 9.2261𝑒−6𝐸−4∗𝑥 

𝑑 =  −0.0002𝑥 +  1.0009 

And: 

   DFI   = elemental iodine DF 

   t   = bubble rise time (s) 

   x    = pin pressure (psig) 

   d   = bubble diameter (cm) 

It should be noted that this calculated pool DF is only applicable for pools with depths from 19-

23 feet. The amount of iodine release that stayed in the pool is determined by the DF (either 

user-defined or calculated from the equations above) and is used to determine the total amount 

of iodine in the pool in moles from the following equation: 

𝑁𝐼 = ∑ (
𝐴𝑖(𝑑𝑖𝑠/𝑠)

λ𝑖(𝑑𝑖𝑠/𝑎𝑡𝑜𝑚𝑠 − 𝑠)
) /𝑁𝐴 

(3 - 15) 

Where: 

   NI   = the total amount of iodine (moles) 

   Ai   = activity for an individual isotope of iodine (Bq) 
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   λ𝑖   = decay constant for an individual isotope of iodine 

Because SNAP does not allow you to enter stable isotopes into an inventory file, the equation 

above is only performed on radioactive isotopes of iodine that were provided in the inventory 

file. The following equation is used to account for the non-radioactive iodine (I-127): 

 

𝑁𝐼−127 =
𝑚𝐼−127

𝑀𝐼−127
 

(3 - 16) 

Where: 

   NI-127   = moles of iodine I-127 

   mI-127   = user-provided amount of iodine I-127 (g) 

   MI-127   = molar mass of I-127 (g/mol) 

 

After the total amount of iodine in moles is gathered, the volatile fraction of iodine atoms in 

elemental form can be calculated. 

𝑋𝑒 =
𝐵𝑚 − √𝐵𝑚

2 − 16𝐶𝑡
2

4𝐶𝑡
 [𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 11 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1] 

(3 - 17) 

Where: 

𝐵𝑚 =
4𝐶𝑡 + 1

𝑅𝑖
 [𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 10 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1] 

 

𝑅𝑖 =
[𝐼2]

[𝐼 −]2
=

𝐶ℎ
2

6.05𝑥10−14 + 1.47𝑥10−9𝐶ℎ
[𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 9 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1] 

 

 

𝐶ℎ = [𝐻+] = 10−𝑝𝐻[𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 8 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1] 

 

𝐶𝑡 = 𝑡𝑜𝑡𝑎𝑙 𝐼 𝑐𝑜𝑛𝑐𝑒𝑛𝑡𝑟𝑎𝑡𝑖𝑜𝑛(𝑀)(𝑚𝑜𝑙𝑒𝑠 𝐼 /𝐿) =
𝑁𝐼 + 𝑁𝐼−127

1000 ∗ 𝑉𝑝𝑜𝑜𝑙
 

[𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 7 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1 (𝑤𝑖𝑡ℎ 𝑐𝑜𝑛𝑣𝑒𝑟𝑠𝑖𝑜𝑛 𝑓𝑟𝑜𝑚 𝑚3 𝑡𝑜 𝐿)] 

And: 

   Vpool   = user-provided volume of the suppression pool (m3) 

   pH   = user-provided acidity of the suppression pool 
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With the fraction of iodine in elemental form (Xe), the evolution removal coefficient can be 

calculated using the following equation: 

 

λ𝑒 =
𝐾𝐿𝑋𝑒𝑆𝑝𝑜𝑜𝑙

𝑉𝑝𝑜𝑜𝑙

[𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 𝐵 − 12 𝑜𝑓 𝑅𝐺 1.183 𝑅𝑒𝑣. 1] 

(3 - 18) 

Where:  

   KL   = mass transfer coefficient (default value of 3.66E-6 m/s) 

   Spool   = total pool surface area (m2) 

 

The user has an option to include a recirculation filter which is applied to the release fraction if 

the input value is greater than 0. The user can also include a compartment recirculation filter or 

a flow loop with a filter to model removal due to filtration.  

 

The removal rate (λ𝑒) is then applied to each isotope of iodine (in atoms) in the pool to get an 

individual elemental release rate in atoms/s and is included in the dose calculations. The same 

is done for the total amount of iodine for the elemental group release rate. The release rate is 

calculated every time step and the change in time between time steps is used to calculate the 

change in iodine in the pool due to the release as well as applying removal due to decay (if 

decay is turned on).  

3.4 Reactor Coolant System Activity Calculations 

Models for specifying the release during a FHA, a REA, and CRDA have also been incorporated 

into SNAP/RADTRAD. The models generally follow those specified in RG 1.183. For the FHA, 

the user-selectable Gap release fractions are based on either RG 1.25 or RG 1.183 (both Rev. 

0 and Rev. 1 are included) as listed in Table 3-4. In addition, relevant plant parameters (as 

described above) for modeling a FHA can be specified by the user. Similarly, for the REA-

CRDA, a release model based on RG 1.183 is available in SNAP/RADTRAD (both Rev. 0 and 

Rev. 1). The release fractions used are the same as Table 3-4 except for Iodine and Noble 

Gases for RG 1.183 Rev. 0. RG 1.183 Rev. 0 has a footnote under the release fractions that 

states that Iodine and Noble Gases should have a 10% release, setting their fractions to 0.1. 

Also, the relevant plant parameters for cladding breach, fuel melt fraction and radial peaking 

factor can be set by the user in SNAP/RADTRAD. Additionally, when the model option for the 

Regulatory Guide Revision is set to Rev 1, the REA-CRDA accident type includes a box to 

include Transient Fission Gas Release. The transient fission gas release is additional fission 

release due to fuel fragmentation that is based on burnup and the average change in fuel rod 



 

140  

enthalpy. When the box is clicked, options to include the values for burnup and  the change in 

enthalpy are included.  SNAP/RADTRAD uses equations 1-4 in section 3.2 of RG 1.183 Rev. 1 

to calculate the additional release values to be used. These values are then added on to the 

initial inventory for each nuclide. The transient fission gas release (TFGR) value calculated by 

SNAP/RADTRAD is printed to the output when the Level Source diagnostic flag (in model 

options) is set to be greater than 0. These gap fractions are used in SNAP/RADTRAD to adjust 

the inventory. The adjusted inventory is then used as input (.icx file) to the RADTRAD-AC. So, 

the .icx input file will be the total inventory multiplied by the gap fractions listed in SNAP. The 

user should take this into consideration if any manual changes to the input file are made.  

Like the automatic adjustment to the inventory in SNAP/RADTRAD, the ability to calculate the 

RCS activity, consider equilibrium activities based on DE I-131 and DE Xe-133 and iodine 

spiking has been incorporated into SNAP/RADTRAD. The RCS activity calculator, described 

in Section 2.4.2, determines the RCS concentrations using formulations based on the 

NUREG-0017, Revision 1, “Calculation of Releases of Radioactive Materials in Gaseous and 

Liquid Effluents from Pressurized Water Reactors (PWR- GALE Code),” [19], NUREG-0016, 

Revision 1, “Calculation of Releases of Radioactive Materials in Gaseous and Liquid Effluents 

from Boiling Water Reactors (BWR-GALE Code),” [20], and the ANSI/ANS-18.1-1999, 

“Radioactive Source Term for Normal Operation of Light Water Reactors,” [21]. The 

formulations used are basically correlations correcting for plant-to-plant variations in power, 

system fluid and steam mass and flow rates and other plant-specific parameters applied to a 

reference PWR or BWR plant. The RCS activity calculations performed in SNAP/RADTRAD 

are similar to, but basically a subset of those performed by the PWR and BWR Gale codes. 

Table 3-7 presents the formulae used by the SNAP/RADTRAD RCS activity calculator for the 

reference PWR plant to calculate coolant concentration adjustment factors for the radionuclide 

concentration in the RCS. Note that these formulations are applicable to plants with U-tube 

steam generators. The adjustment factors presented in Table 3-6 are multiplied by the 

reference PWR radionuclide concentrations given in Table 3-7 to obtain the RCS concentration 

(μCi/g). 
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Table 3-7 Formulations used to Determine RCS Water Radionuclide Concentrations in PWRs with U-tube Steam 

Generators 

Element Class Adjustment Factor Formula a 

Noble Gases = (
162 ∗ 𝑃

𝑊𝑃
) (

0.0009 + λ

𝑅 + λ
) 

Halogens = (
162 ∗ 𝑃

𝑊𝑃
) (

0.067 + λ

𝑅 + λ
) 

Cs, Rb = (
162 ∗ 𝑃

𝑊𝑃
) (

0.037 + λ

𝑅 + λ
) 

where 

R = the removal rate - reactor coolant 1/hr 

λ = the radionuclide decay constant in 1/hr 
P = the core power in MWth 

WP = the mass of reactor coolant system water lbm 

Formulas for the removal rate (R) are presented below b 

Noble Gases 𝑅 =
𝐹𝐵 + (𝐹𝐷 − 𝐹𝐵) ∗ 𝑌

𝑊𝑃
 

 

Halogens & Cs, Rb 

𝑅 =
𝐹𝐷 ∗ 𝑁𝐵 + (1 − 𝑁𝐵) ∗ (𝐹𝐵 + 𝐹𝐴 ∗ 𝑁𝐴)

𝑊𝑃
 

where 

FD = the removal rate in the reactor coolant in 1/hr 

NB = the fraction of material removed in passing through the purification 
demineralizer 

FB = the reactor coolant letdown flow in 1/hr 
FA = the flow through the purification system cation demineralizer 

NA = the fraction of material removed in passing through the cation 
demineralizer 

Y = the ratio of the total amount of noble gases routed to gaseous 
radwaste from the purification system to the total amount routed 
from the primary coolant system (not including the boron recovery 
system) 
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a. The adjustment factor formula is from Table 2-7 of reference [19]. 

b. The formulas for the removal rates (R) are from Table 2-6 of reference [19] and Table 9 of reference [21]. The 

values for the constants are from a reference PWR described in Table 2-4 of reference [19] and Table 2 of 

reference [21]. The PWR-GALE code calculates the removal rates (R) for these nuclides for PWRs other than 

the reference PWR plant described in Table 2-4 of reference [19] and Table 2 of reference [21]. 
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Table 3-8 RCS Radionuclide Concentrations for a Reference PWR Plant 

 

Radionuclide 

Concentration 

(µCi/g) a 

 

Radionuclide 

Concentration 

(µCi/g) a 

Kr-83m b 0.0E+00 I-131 2.0E-03 

Kr-85 4.3E-01 I-132 6.0E-02 

Kr-85m 1.6E-02 I-133 2.6E-02 

Kr-87 1.7E-02 I-134 1.0E-01 

Kr-88 1.8E-02 I-135 5.5E-02 

 

Xe-131m 7.3E-01 Cs-134 3.7E-05 

Xe-133 2.9E-02 Cs-136 8.7E-04 

Xe-133m 7.0E-02 Cs-137 5.3E-05 

Xe-135 6.7E-02 Rb-86 b 0.0E+00 

Xe-135m 1.3E-01   

Xe-138 6.1E-02   

a. The radionuclide concentrations are from Table 6 of reference [21]. 

b. The radionuclide concentration is not from Table 6 of reference [21]. 

Table 3-8 presents the formulae used by the SNAP/RADTRAD RCS activity calculator for the 

reference BWR plant to calculate coolant concentration adjustment factors for the radionuclide 

concentration in the RCS water and steam. The adjustment factors presented in Table 3-8 are 

multiplied by the reference BWR radionuclide concentrations given in Table 3-9 to obtain the 

RCS concentration (μCi/g) for either the RCS water or steam. 
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Table 3-9 Formulations used to Determine RCS Water Radionuclide Concentrations in BWRs 

Element Class Adjustment Factor Formula 

Noble Gases a 1.0 

Halogens = (
112 ∗ 𝑃

𝑊𝑃
) (

1.01 + λ

𝑅 + λ
) 

Cs, Rb = (
112 ∗ 𝑃

𝑊𝑃
) (

0.19 + λ

𝑅 + λ
) 

where 

R = the removal rate - reactor coolant 1/hr 

λ = the radionuclide decay constant in 1/hr 
P = the core power in MWth 
WP = the mass of RCS water lbm 

Formulas for the removal rate (R) are presented below b 

Noble Gases 1.0 

Halogens & Cs, Rb 𝑅 =
𝐹𝐴 ∗ 𝑁𝐴 + 𝑁𝐶 ∗ 𝐹𝑆 ∗ 𝑁𝑆 ∗ 𝑁𝐵

𝑊𝑃
 

where 

FA = the water cleanup demineralizer flow rate in lb/hr 
NA = the reactor water cleanup demineralizer DFs 

NC = the ratio of condensate demineralizer flow rate to steam flow rate 
FS = the steam flow rate in lb/hr 

NS = the ratio of radionuclide concentration in reactor steam to the 
concentration in reactor water 

NB = the condensate demineralizer DF 

a. The adjustment factor formulas are from Table 2-5 of reference [20] and Table 10 of reference [21]. 

b. The formulas for the removal rates (R) are from Table 2-4 of reference [20] and Table 8 of reference [21]. The 

values for the constants are from a reference BWR described in Table 2-3 of reference [20] and Table 1 of 

reference [21]. The BWR-GALE code calculates the removal rates (R) for these nuclides for BWRs other than 

the reference BWR plant described in Table 2-3 of reference [20] and Table 1 of reference [21]. 
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Table 3-10 RCS Radionuclide Concentrations for a Reference BWR Plant 

 

Radionuclide 

Liquid 

Concentration 

(µCi/g) a 

Steam 

Concentration 

(µCi/g) a 

 

Radionuclide 

Liquid 

Concentration 

(µCi/g) a 

Steam 

Concentration 

(µCi/g) a 

Kr-83m 0.0E+00 5.9E-04 I-131 2.2E-03 4.4E-05 

Kr-85 0.0E+00 4.0E-06 I-132 2.2E-02 4.4E-04 

Kr-85m 0.0E+00 1.0E-03 I-133 1.5E-02 3.0E-04 

Kr-87 0.0E+00 3.3E-03 I-134 4.3E-02 8.6E-04 

Kr-88 0.0E+00 3.3E-03 I-135 2.2E-02 4.4E-04 

 

Xe-131m 0.0E+00 3.3E-06 Cs-134 3.0E-05 3.0E-08 

Xe-133 0.0E+00 1.4E-03 Cs-136 2.0E-05 2.0E-08 

Xe-133m 0.0E+00 4.9E-05 Cs-137 8.0E-05 8.0E-08 

Xe-135 0.0E+00 3.8E-03 Rb-86 b 0.0E+00 0.0E+00 

Xe-135m 0.0E+00 4.4E-03    

Xe-138 0.0E+00 1.5E-02    

a. The radionuclide concentrations are from Table 5 of reference [21]. 

b. The radionuclide concentration is not from Table 5 of reference [21]. 

T/S equilibrium activity based on DE I-131 and DE Xe-133 are determined from the DCFs and 

the RCS concentration. Equations (4-14) and (4-15) show the formulation used 

𝐷𝐸 𝐼131 =
∑ 𝐶𝑖𝑖 ∗ 𝐷𝐶𝐹𝑖

𝐷𝐶𝐹𝐼131
 

(3 - 19) 

 

𝐷𝐸𝑋𝑒133 =
∑ 𝐶𝑖𝑖 ∗ 𝐷𝐶𝐹𝑖

𝐷𝐶𝐹𝑋𝑒133
 

(3 - 20) 
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Where: 

    𝐷𝐶𝐹𝑖       = the DCF for each iodine or xenon nuclide. [The thyroid DCF (Sieverts (Sv)/Bq) is                             

           used for iodine nuclides and the whole body DCF (Sv-m3/Bq-s) is used for xenon 

           nuclides.] 

𝐷𝐶𝐹𝐼131   = the I-131 thyroid DCF (Sv/Bq) 

𝐷𝐶𝐹𝑋𝑒133 = the Xe-133 whole body DCF (Sv-m3/Bq-s) 

    𝐶𝑖             =  the i-th radionuclide concentration in μ𝐶𝑖/𝑔 

The actual equilibrium factor is calculated from the user-specified value of DE I-131 (typically 1 

μCi/g) divided by DE I-131. This factor is multiplied by the RCS activity to obtain the equilibrium 

activity based on DE I-131. The approach is the same for Xe-133 except that Xe-133 factors 

are applied. The calculation is performed separately for liquid and steam in BWRs. 

The pre-incident spike activity is computed from the user-specified spike activity (typically 60 

μCi/g) divided by DE I-131 and then multiplied by the RCS activity. The calculation is performed 

separately for liquid and steam in BWRs. 

Co-incident spiking is somewhat more complicated as the iodine appearance rate must be 
determined. The appearance factor in units of Ci/h is computed. 

𝐴𝐹 = (𝑀𝐿𝐷 ∗
1 − 1/𝐷𝐹

𝑊𝑃
) ∗ 𝑆𝑝𝑀 ∗ (

3600

1𝐸6
) ∗ 𝑊𝑃 ∗ 𝐸𝐹𝐼 

(3 - 21) 

 

Where: 

    MLD      = the normal letdown flow rate in gpm (converted to g/s in above equation) 

DF         = the mixed bed demineralizer DF 

WP        = the mass of RCS T/S leakage rate in gpm (converted to g/s in above equation) 

    SpM      = the iodine spike multiplier 

     EFI        = the equilibrium factor for iodine in μ𝐶𝑖/𝑔   

The total iodine appearance for co-incident spiking is computed by multiplying the appearance 
rate by the spike duration in hours to obtain the total iodine appearance. The iodine appearance 
is added to the equilibrium activity to obtain the total RCS activity for iodine. Note that co-
incident spiking only applies to PWRs. 
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One item that should be noted is that there are several formulations for the calculation of the 

RCS inventory, including ANSI/ANS-18.1-1999, the PWR-GALE Code and the BWR-GALE 

Code. The current status of ANSI/ANS-18.1-1999 is that it has been administratively withdrawn 

because it was neither reaffirmed nor updated during a 10-year period. The American Nuclear 

Society has formed a Working Group in calendar year 2014 who are now updating ANSI/ANS- 

18.1-1999. 

3.5 Removal Models 

Models for radionuclide removal from the compartment atmosphere including sprays, natural 
deposition, leakage, and filters are included in SNAP/RADTRAD. The removal coefficients for 
the various removal mechanisms are equivalent. For example, filtration is expressed in terms of 
efficiencies, and natural deposition in terms of removal coefficients. These are related to each 
other as well as to DFs. The DF is defined as the ratio of the total material (aerosol or 
elemental iodine) subjected to a removal process to the total aerosol material that remains 

airborne. Equation (3-22) shows the relationship between the DF and the removal coefficient, λ. 

𝑑𝐷𝐹

𝑑𝑡
= λ𝐷𝐹 

(3 - 22) 

The average DF is related to the mass fraction, mf , remaining in the volume as shown in 
Equation (3-23). 

𝑚𝑓 =
𝑀(𝑡)

𝑀(0)
=

1

𝐷𝐹
= 𝑒−(λ𝑡) 

(3 - 23) 

 

Where: 

𝑀(t) = the mass of aerosol as a function of time (t) in a compartment 

𝑀(0) = the total mass subjected to removal in a compartment. 

The DF is also related to the removal efficiency, η, as shown in Equation (3-24). 

𝐷𝐹 =
1

1 − η
 

(3 - 24) 

 

3.5.1 Spray Removal Model 
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The spray removal mechanism in SNAP/RADTRAD can be modeled using either the Powers’ 

model, as described in NUREG/CR-5966, for aerosol removal or through the specification of 

user-defined removal coefficients. As the Powers’ model is only applicable to aerosols, the 

SNAP/RADTRAD user will still need to specify removal coefficients for elemental and organic 

iodine. 

The extent to which sprays will decontaminate an aerosol-laden atmosphere depends on the 
number of spray droplets falling through the atmosphere and the distance they fall. The water 
flux into the containment atmosphere is time dependent and the fall distance is dependent upon 
the containment design. The Powers’ model is based on a correlation that determines the 

removal coefficient for an aerosol considering the spray water flux, Q (m3∙H2O/m2∙s) and the fall 

height of the spray droplets H (m) and considers uncertainty in the various parameters affecting 
spray removal. Since the model was developed from an uncertainty study, the user specifies a 
percentile. The “best estimate” value is associated with the 50th percentile, or median values; 
the lower bound is associated with the 10th percentile; and the reasonable upper bound, or 

largest DF, with the 90th percentile. The model was developed using values of 0.001, 0.1 and 

0.25 cm3 H2O/cm2 s for the spray water flux, Q, and fall heights of 500, 853, 1000, 1584, 2000, 
3000, 4000, and 5000 cm. The aerosol removal coefficient is dependent on the fraction of the 
aerosol suspended in the atmosphere, mf , which is defined as the aerosol mass in the 

atmosphere of a compartment at a given time, t, divided by the total aerosol mass released into 
the compartment atmosphere until this time. The model includes the effect of the unsprayed 
portions of the containment by incorporating the assumption that the circulation in the 
compartment is rapid compared with the removal rate. Equation (3-25) specifies the aerosol 

removal coefficient (λ𝑗,𝑠𝑝𝑟
𝑖 ) at any time in units of 1/s. 

 

λ𝑗,𝑠𝑝𝑟
𝑖 =

1

3600(1 − α)
(𝑎 − 𝑏𝑙𝑜𝑔10𝑄) [[1 −

𝑚𝑓

0.9
]

𝑐

+ [
𝑚𝑓

0.9
]

𝑐

] ∗ [𝑒𝑥𝑝(𝐴 + 𝐵𝑙𝑛𝑄 + 𝐶𝐻 + 𝐷𝑄2𝐻 + 𝐸𝑄𝐻2

+ 𝐹𝑄 + 𝐺𝑄2𝐻2)] 

(3 - 25) 
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The values for the constants A, B, C, D, E, F, G, a, b, and c in Table 4-10 are from Section 7 of 

NUREG/CR-5966. The parameter α is the ratio of the compartment volume not exposed to 
sprays to the compartment volume exposed to sprays (unsprayed volume/sprayed volume). If 
the assumption that the circulation is rapid compared with the removal rate is not valid, then the 
user can split the compartment into two separate compartments and model the flow from the 

unsprayed portions to the sprayed portions as a convective flow. In this case α would be zero 
for the compartment containing the sprays. 

 

Table 3-11 Values for Coefficients used in the Powers' Spray Removal Model 

Constant 
Value 

10th Percentile 50th Percentile 90th Percentile 

A 5.5750 6.83707 7.10927 

B 0.94362 1.0074 0.92549 

C 0.0 -2.4045E-05 0.0 

D -6.9821E-03 -4.1731E-03 -8.0868E-04 

E -7.327E-07 9.006E-08 0.0 

F 0.0 -1.2478 0.0 

G 3.555E-06 0.0 0.0 

a 0.1108 0.1815 0.3751 

b -0.00201 -0.01153 0.00648 

c 0.8945 0.5843 0.2786 

This expression was originally developed for a puff release of aerosols into a system. In those 

cases where there is a continuing release, the size distribution will continually be renewed by the 

injected particulate. The model has been extended for this case by setting coefficients A through 

G to zero. This makes the model assume that the size distribution has not changed in time and 

that most of the material suspended is fresh material provided by the source. The aerosols 

removed by the sprays are collected in the sump. 

3.5.2 Natural Deposition Model 

Natural deposition in SNAP/RADTRAD can be modeled using either Henry’s correlation or 

Powers’ model for aerosol removal due to natural deposition or through the specification of 

user-defined removal coefficients. As Henry’s correlation and Powers’ model are only 
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applicable to aerosols, the SNAP/RADTRAD user will still need to specify removal coefficients 

for elemental iodine. 

3.5.2.1 Henry’s Correlation 

The correlation developed by Henry, described in reference [22], is based upon observation of 

experiments concerned with aerosol decontamination. The form of Equation (3-26) is based 

upon the consideration that sedimentation was the dominant phenomenon observed, and the 

coefficients were determined from experimental data from liquid metal reactor tests. 

λ = 𝐶1 (
ℎ𝑟𝑒𝑓

ℎ
) (

ρ𝑃

ρ𝑃𝑟𝑒𝑓
) (ρ𝐴)𝐾 

(3 - 26) 

 

where 

ℎ
ref = 5.0 m, as determined from the ABCOVE test AB5 

ℎ = the user-provided fall height in m 

𝜌P = the user-provided particle density in kg/m3 

𝜌Pref = the theoretical sodium oxide particle density of 2270 kg/m, as determined 

from the ABCOVE test AB5 

𝜌A = the aerosol mass in the volume. 

The coefficients that best fit the data are:  

Where: 

ρ𝐴 ≥ 6.0𝐸 − 05
𝑘𝑔

𝑚3
 𝑡ℎ𝑒𝑛 𝐶1 = 0.0220 𝑎𝑛𝑑 𝑘 = 0.60 

ρ𝐴 < 6.0𝐸 − 05
𝑘𝑔

𝑚3
 𝑡ℎ𝑒𝑛 𝐶1 = 0.0016 𝑎𝑛𝑑 𝑘 = 0.33 

Henry’s correlation input can be modified to account for the influence of aerosol shape and moisture 

on the particle density by using Equation (3-27) 
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ρ𝑃 = αρ𝑇 + (1 − α)ρ𝑤 

(3 - 27) 

Where: 

    𝛼            = the ratio of the effective aerosol particle density to theoretical density 

𝜌𝑇 = the theoretical density in kg/m3 

𝜌𝑤 = the density of water in kg/m3. 

In many cases the aerosol has only 20 percent of its theoretical density, so that in a high steam 

environment its effective density would be closer to that of water. This correlation is 

implemented in SNAP/RADTRAD. 

3.5.2.2 Powers’ Model 

The Powers’ model for aerosol removal due to natural deposition, in NUREG/CR-6604, is based 

on the observation of a self-preserving aerosol size distribution as a key component in 
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predicting aerosol behavior. Powers included the effects due to turbulence and to the multiple 

aerosol releases specified in NUREG-1465. The modified model was then compared with a 

series of CONTAIN computer code cases to verify the aging and aerosol size distributions due 

to the multiple sources. To account for the uncertainties, a large number of calculations were 

performed with the modified mechanistic model, with specific values for the type of reactor 

containment, reactor power, and the source term release phase, while varying the values of the 

uncertainty parameters. Typical uncertainty parameters were the containment pressure during 

the various release phases, the floor and wall surface areas, the zirconium inventory, the ratio of 

containment volume to thermal power, and the properties of the concrete. In all, over 20 

parameters that were related to the phenomena were varied. Equation (3-28) shows the 

governing equation used in Powers’ model 

𝑑𝐷𝐹𝑖(𝑡)

𝑑𝑡
= λ𝑑𝑒𝑝,𝐼(𝑃𝑡ℎ, 𝑡)𝐷𝐹𝑖(𝑡) 

(3 - 28) 

where: 

DFi(t) = the DF for the ith class of radioactive aerosol at time t where i indicates 
the phase at which the material was released into the containment: 
during the Gap or Early In-vessel phases 

λ𝑑𝑒𝑝,𝐼(𝑃𝑡ℎ, 𝑡) = the decontamination coefficient at time t and power Pth for phase I 

𝑃th = the thermal power of the reactor. 

The decontamination coefficient should be weighted by each chemical group release rate as 

was done by Powers. However, SNAP/RADTRAD does not maintain the necessary weighting 

factors; hence a single chemical release rate based on iodine was used for the weighting 

coefficients. 

The decontamination coefficient, λ, was solved over the various release time intervals and for 
the different types of reactors and various operating power levels using a Monte-Carlo 
uncertainty analysis. The results of these analyses are tabulated in Tables 3-12 and 3-13, for 

PWRs and BWRs, and are presented in terms of percentile DFs, λdep(N%,Pth ). Since the model 

was developed from an uncertainty study, the user specifies a percentile, N%. The best 
estimate value is associated with the 50th percentile, or median values; the lower bound is 

associated with the 10th percentile; and the reasonable upper bound, or largest DF, with the 90th 
percentile. 
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Table 3-12 Correlations of Natural Deposition Decontamination Coefficients for PWRs DBAs 

Release Phase Time Interval (s) Correlations (hr-1) 

 

Gap 

0 – 1800 

(0 – 0.5 hr) 

λdep (90) = 0.0365 + 3.580E-06 P(MWt) 

λdep (50) = 0.0268 + 3.475E-06 P(MWt) 
λdep (10) = 0.0182 + 3.260E-06 P(MWt) 

 

Gap 

1800 – 6480 

(0.5 – 2.0 hr) 

λdep (90) = 0.1036 [1 - exp (-2.239 P(MWt)/1000)] 

λdep (50) = 0.0820 [1 - exp (-1.159 P(MWt)/1000)] 

λdep (10) = 0.0645 [1 - exp (-0.938 P(MWt)/1000)] 

Early 

In-Vessel 

1800 – 6480 

(0.5 – 1.8 hr) 

λdep (90) = 0.0522 [1 - exp (-2.458 P(MWt)/1000)] 

λdep (50) = 0.0417 [1 - exp (-1.258 P(MWt)/1000)] 

λdep (10) = 0.0326 [1 - exp (-0.910 P(MWt)/1000)] 

Gap + Early 

In-Vessel 

6480 – 13,680 

(1.8 – 3.8 hr) 

λdep (90) = 0.421 [1 - exp (-2.530 P(MWt)/1000)] 

λdep (50) = 0.196 [1 - exp (-1.040 P(MWt)/1000)] 

λdep (10) = 0.094 [I - exp (-0.869 P(MWt)/1000)] 

Gap + Early 

In-Vessel 

13,680 – 49,680 

(3.8 – 13.8 hr) 

λdep (90) = 0.1920 - 1.35E-06 P(MWt) 

λdep (50) = 0.1382 + 6.85E-06 P(MWt) 
λdep (10) = 0.0811 + 10.15E-06 P(MWt) 

Gap + Early 

In-Vessel 

49,680 – 80,000 

(13.8 – 22.22 hr) 

λdep (90) = 0.1010 

λdep (50) = 0.0912 

λdep (10) = 0.0860 [1 - exp (-2.384 P(MWt)/1000)] 
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Table 3-13 Correlations of Natural Deposition Decontamination Coefficients for BWRs DBAs 

Release Phase Time Interval (s) Correlations (hr-1) 

 

Gap 

0 – 1800 

(0 – 0.5 hr) 

λdep (90) = 2.903 [exp(-1060/P(MWt)] 

λdep (50) = 2.252 [exp(-1977/P(MWt)] 

λdep (10) = 1.285 [exp(-2199/P(MWt)] 

 

Gap 

1800 – 7200 

(0.5 – 2.0 hr) 

λdep (90) = 1.809 [exp(-777/P(MWt) 

λdep (50) = 1.722 [exp(-1777/P(MWt)] 

λdep (10) = 1.161 [exp(-2274/P(MWt)] 

Early 

In-Vessel 

1800 – 7200 

(0.5 – 2.0 hr) 

λdep (90) = 0.746 [exp(-626/P(MWt)] 

λdep (50) = 0.752 [exp(-1565/P(MWt)] 

λdep (10) = 0.520 [exp(-2173/P(MWt)] 

Gap + Early 

In-Vessel 

7200 – 18,000 

(2.0 – 5.0 hr) 

λdep (90) = 1.959 [exp(-548/P(MWt)] 

λdep (50) = 1.811 [exp(-1107/P(MWt)] 

λdep (10) = 1.551 [exp(-1507/P(MWt)] 

Gap + Early 

In-Vessel 

18,000 – 30,000 

(5.0 – 8.33 hr) 

λdep (90) = 1.533 [exp(-573/P(MWt)] 

λdep (50) = 1.317 [exp(-1225/P(MWt)] 

λdep (10) = 0.836 [exp(-1051/P(MWt)] 

Gap + Early 

In-Vessel 

30,000 – 43,200 

(8.33 – 12.0 hr) 

λdep (90) = 1.524 [exp(-647/P(MWt)] 

λdep (50) = 1.339 [exp(-1474/P(MWt)] 

λdep (10) = 0.780 [exp(-1316/P(MWt)] 

Gap + Early 

In-Vessel 

43,200 – 70,000 

(12.0 – 19.4 hr) 

λdep (90) = 1.564 [exp(-717/P(MWt)] 

λdep (50) = 1.373 [exp(-1634/P(MWt)] 

λdep (10) = 0.778 [exp(-1548/P(MWt)] 

Gap + Early 

In-Vessel 

70,000 – 86,400 

(19.4 – 24.0 hr) 

λdep (90) = 1.562 [exp(-719/P(MWt)] 

λdep (50) = 1.441 [exp(-1785/P(MWt)] 
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λdep (10) = 0.780 [exp(-1686/P(MWt)] 

Equations (3-29), (3-30) and (3-31) determine the current decontamination coefficient, λne t , from 
the sum of the coefficients for each phase weighted by the iodine release rate, SI2, I , for phase I. 

λ𝑛𝑒𝑡 =
𝑙𝑛{[𝐷𝐹(𝑡 + Δ𝑡)/𝐷𝐹(𝑡)]}

Δ𝑡  

(3 - 29) 

Where: 

 

𝐷𝐹(𝑡) =
∑ 𝑆𝐼2,𝐼

4
𝐼=1

∑ 𝑆𝐼2,𝐼
4
𝐼=1 /𝐷𝐹𝐼

 

(3 - 30) 

𝐷𝐹1 = Π𝐼=1
4 𝑒𝑥𝑝[λ𝑑𝑒𝑝,𝐼(𝑁%, 𝑃𝑡ℎ)𝑡] 

(3 - 31) 

 

Table 3-14 also provides the decontamination coefficients for a DBA in an advanced 

pressurized-water reactor (APWR) design. These values are based upon work by Powers, 

which found that the CONTAIN-related calculation results were correlated with values in the 

table. These correlations do not vary with reactor thermal power; hence an approximation is 

used when the user selects a PWR design with a different power level. 

 

Table 3-14 Correlations of Natural Deposition Decontamination Coefficients for APWR DBAs 

Release Phase Time Interval (s) Correlations (hr-1) 

 

Gap 

0 – 1800 

(0 – 0.5 hr) 

λdep (90) = 0.466 

λdep (50) = 0.233 

λdep (10) = 0.029 
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Gap 

1800 – 6480 

(0.5 – 1.8 hr) 

λdep (90) = 0.872 

λdep (50) = 0.487 

λdep (10) = 0.160 

Early 

In-Vessel 

1800 – 6480 

(0.5 – 1.8 hr) 

λdep (90) = 0.393 

λdep (50) = 0.240 

λdep (10) = 0.100 

Gap + Early 

In-Vessel 

6480 – 13,680 

(1.8 – 3.8 hr) 

λdep (90) = 1.210 

λdep (50) = 0.980 

λdep (10) = 0.731 

Gap + Early 

In-Vessel 

13,680 – 49,680 

(3.8 – 13.8 hr) 

λdep (90) = 0.594 

λdep (50) = 0.397 

λdep (10) = 0.245 

Gap + Early 

In-Vessel 

49,680 – 86,400 

(13.8 – 24.0 hr) 

λdep (90) = 0.598 

λdep (50) = 0.327 

λdep (10) = 0.107 

The approximation used assumes that the significant difference between the PWR and the 

APWR design, in terms of natural deposition, is that the wall cooling enhances the phoretic 

deposition. Therefore, the difference in decontamination coefficient at 1800 MWt represents 

this phoretic deposition and is then scaled by the power ratio. Equation (3-32) represents the 

final approximation used 
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λ𝑑𝑒𝑝(𝐴𝑃_𝑃𝑡ℎ) + [λ𝑑𝑒𝑝(𝐴𝑃_1800) − λ𝑑𝑒𝑝(𝑃𝑊𝑅_1800)]
𝑃𝑡ℎ

1800
 

(3 - 32) 

Where: 

λ𝑑𝑒𝑝(𝐴𝑃_𝑃𝑡ℎ) = the decontamination coefficient from the APWR at the power level 

indicated (Pth =1800 or design power) 

λ𝑑𝑒𝑝(𝑃𝑊𝑅_𝑃𝑡ℎ) = the decontamination coefficient from the PWR DBA calculation for the power 

level indicated (Pth =1800 or design power). 

3.5.3 Deposition in Piping Models 

At the discretion of the user, piping can be modeled as a transfer pathway where deposition can 

occur. A model is available for the removal of fission products during transport through pipes. 

Alternatively, the user may specify DFs and volumetric flow rates as a function of time. Noble 

gases are assumed not to interact with the piping and are transmitted without any depletion. 

The models chosen do not have documented limitations; however, the assumption is made that 

only primary deposition phenomena are being modeled. Scenarios in which supersaturated 

conditions occur, or in which very high or very low velocities are found, may give unrealistic 

results. 

The models that are available in SNAP/RADTRAD for piping deposition include the Brockmann 

model for aerosol removal, the Bixler model for elemental iodine removal, and the Bixler model 

for organic iodine removal. 

3.5.3.1 Brockmann Model for Aerosol Removal 

The Brockmann model described in reference [23] is used to determine the amount of aerosol 
deposition that occurs in pipe bends and due to settling, turbulent inertia and diffusion. The 
mean particle diameter, dp, used in the Brockmann model is assumed to be 1 µ with an average 

particle density, ρp, of 1000 kg/m3. The temperature, pressure, open volume, and other 
parameters are provided by the user. Particles will settle due to gravitational force and deposit 
on the horizontally projecting lower surface of the flow path during transport. This turbulent flow 
deposition efficiency, ηg , is modeled in Equation (3-33). 
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η𝑔 = 1 − 𝑒𝑥𝑝(−𝑈𝑔𝐴𝑠/π𝑄) 

(3 - 33) 

𝑈𝑔 = τ𝑔 

τ = 𝑠𝑙𝑖𝑝 ∗ 𝑑𝑝
2ρ𝑝/18 μ 

𝑠𝑙𝑖𝑝 = 1.0 + 2.0
𝑚𝑓𝑝

𝑑𝑝
(1.257 + 0.4𝑒−0.55𝑑𝑝/𝑚𝑓𝑝)(𝑑𝑖𝑚𝑒𝑛𝑡𝑖𝑜𝑛𝑙𝑒𝑠𝑠) 

 

  where: 

Ug        = the gravitational deposition velocity in m/s  

τ        = the particle relaxation time in s 

     Q = the user provided gas flow in m3/s 

    As        = the user provided total pipe surface area in m2 

     μ       = the viscosity of air, 1.93E-05 Pa-s 

    Mfp   = the particle mean free path in cm 

   g        = the gravitational acceleration in m/s2 

For instances of laminar flow, described in reference [24] the deposition efficiency is described by 

Equation (3-34). 

 

η𝑔 = 1 −
2

π
[2ϵ√1 − ϵ2/3 − ϵ1/3√1 − ϵ2/3 + 𝑎𝑟𝑐𝑠𝑖𝑛√ϵ1/3] 

(3 - 34) 

Where: 

ϵ = 0.75𝑍 − 0.75
𝐿𝑈𝑔

𝑈𝐷
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And: 

    L           = the horizontal pipe length (𝐴𝑠/π𝐷) in m 

    As
               = the user provided total pipe surface area in m2 

    D          = the pipe diameter (4Vol/As) 

    Ug         = the gravitational deposition velocity in m/s 

    U          = the linear velocity (Q/As) in m/s 

    Q          = the user provided gas flow in m3/s 

The laminar and turbulent settling efficiencies are equivalent for Reynolds Number between 500 

and 2300. 

If the flow is turbulent, then turbulence in the central core can propel a particle into the laminar 
sublayer. If the particle inertia is high, then it will penetrate the sublayer and be collected on the 
wall. There have been experiments, reference [25], on inertial deposition velocity and 

Brockmann has modeled the turbulent deposition efficiency, ηtur b , as shown in Equation (3-35). 

η𝑡𝑢𝑟𝑏 = 1 − 𝑒𝑥𝑝(𝑈𝑡𝐴𝑠/𝑄) 

(3 - 35) 

Where: 

𝑈t = 0.01988 𝑈air ⁄𝑅𝑒1⁄8 

Re = 𝜌air𝑈air 𝑑𝐻⁄𝜇 

and  

 
𝑈t 

𝑈air 

𝑑𝐻 

𝜌air 

= the turbulent inertial deposition velocity in m/s 

= the air velocity in m/s 

= the hydraulic diameter in m (4 Vol/As) 

= the density of air in kg/m3 

When the flow in the pipe is slower as described in Equation (3-36), then the turbulent velocity is 

calculated using Equation (3-37). 

τ𝑈𝑎𝑖𝑟

𝑑𝐻
𝑅𝑒3/4 < 326.3 

(3 - 36) 

𝑈𝑡 = 1.861𝐸 − 07 [
τ𝑈𝑎𝑖𝑟

𝑑𝐻
]

2

𝑈𝑎𝑖𝑟𝑅𝑒11/8 

(3 - 37) 

Small particles undergoing Brownian diffusion will diffuse from areas of high concentration to 

those of low concentration. Since the wall acts like a sink for these particles, there is net 



 

160  

diffusion from the bulk to the wall. This phenomenon has been analyzed in reference [26] and 

the diffusional deposition efficiency is modeled as shown in Equation (3-38). 

η𝑑𝑖𝑓𝑓 = 1 − 𝑒𝑥𝑝(−𝑈𝑑𝑖𝑓𝑓𝐴𝑠/𝑄) 

(3 - 38) 

Where: 

𝑈𝑑𝑖𝑓𝑓 = the diffusion velocity in m/s 

𝐹𝑠 = the user provided total pipe surface area in m2 

Q = the user provided gas flow in m3/s. 

In cases of laminar flow, this efficiency is modeled as shown in Equation (3-39). 

η𝑑𝑖𝑓𝑓 = 2.56ζ2/3 − 1.2ζ − 0.177ζ4/3 

(3 - 39) 

Where: 

   ζ                = the dimensionless diffusion parameter (AsDdiff/QdH) 

And: 

   As          = the user provided total pipe surface area in m2 

   Ddiff          = the particle diffusion coefficient in m2/s 

   Q          = the user provided gas flow in m3/s 

   dH          = the hydraulic diameter in m [see Equation 3-35] 

 

The particle diffusion coefficient is computed as shown in Equation (3-40) in units of cm2/s units 

which is converted in the code to units of m2/s. 

𝐷𝑑𝑖𝑓𝑓 = 1.38𝐸 − 16𝑇𝑔 ∗ [
𝑠𝑙𝑖𝑝

3πμ𝑑𝑝
] 

(3 - 40)  

Where: 

   𝑠𝑙𝑖𝑝 = 1.0 + 2.0
𝑚𝑓𝑝

𝑑𝑝
(1.257 + 0.4𝑒−0.55𝑑𝑝/𝑚𝑓𝑝) [See equation (3-33)] 
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And: 

   Tg             = the gas temperature in ºK 
   1.38E-16 = Boltzmann constand in g-cm2/s2-ºK 
   μ             = the viscosity of the gas in g/cm-s 
   dp             = the particle diameter in cm 

When the flow is slow or the pipe length is large such that ζ > 0.02, then the diffusional 
deposition efficiency is modeled as shown in Equation (3-41). 

η𝑑𝑖𝑓𝑓 = 0.819𝑒𝑥𝑝(−3.657ζ) + 0.097𝑒𝑥𝑝(−22.3ζ) + 0.032𝑒𝑥𝑝(−57ζ) 

(3 - 41) 

In cases of turbulent flow, the diffusional efficiency, from reference [27], is modeled as shown in 

Equation (3-42). 

η𝑑𝑖𝑓𝑓 = 1 − 𝑒𝑥𝑝 [−ζ2/30.0187𝑅𝑒13/24 (
𝐿

𝑑𝐻
)

1/3

] 

(3 - 42) 

where  

 

ζ = the dimensionless diffusion parameter [see Equation (3-39)] 

Re = 𝜌air 𝑈air 𝑑𝐻⁄𝜇 [see Equation (3-35)] 

L = the path length in m (A𝑠⁄𝜋𝑑𝐻) 

A𝑠 = the user provided total pipe surface area in m2 

𝑑𝐻 = the hydraulic diameter in m [see Equation (3-35)]. 

When the direction of gas flow is diverted in a bend, an aerosol particle may deviate from the 

gas flow due to its inertia and deposit on the wall. The efficiency of an aerosol particle in a bend 

is modeled as shown in Equation (3-43). 

 

η𝑏𝑒𝑛𝑑 =
τ𝑈𝑎𝑖𝑟ϕ

𝑑𝐻

 

(3 - 43) 
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where  

 

τ = the particle relaxation time in s [see Equation (4-28)] 

𝑈air = the air velocity in m/s 

ϕ = the user-provided sum of the angles the flow has been diverted in radians 

𝑑𝐻 = the hydraulic diameter in m [see Equation (4-30)]. 

When the flow is turbulent, the efficiency of an aerosol particle in a bend, from reference [28], is 

modeled as shown in Equation (3-44). 

ηbend = 1.0 − exp
(−2.83τUairϕ)

dH

 

(3 - 44) 

where  

 

τ = the particle relaxation time in s [see Equation (3-33)] 

𝑈air = the air velocity in m/s 

𝑑𝐻 = the hydraulic diameter in m [see Equation (3-35)]. 
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In cases of laminar flow, the efficiency of an aerosol particle in a bend is modeled as shown in 

Equation (3-45). 

η𝑏𝑒𝑛𝑑 = (1.0 + (
τ𝑈𝑎𝑖𝑟

0.171𝑑𝐻
)

𝑃1

)

−𝑃2

 

(3 - 45) 

Where: 

   P1    = 0.452 (
τ𝑈𝑎𝑖𝑟

0.171𝑑𝐻
) + 2.242 

   P2   = 
2ϕ

π
 

Therefore, the total aerosol deposition efficiency is modeled as shown in equation (3-46). 

η𝑇 = 1.0 − (1.0η𝑔)(1.0 − η𝑡𝑢𝑟𝑏)(1.0 − η𝑑𝑖𝑓𝑓)(1.0 − η𝑏𝑒𝑛𝑑) 

(3 - 46) 

 

3.5.3.2 Bixler Model for Elemental Iodine Removal 

The equation for the Bixler model for elemental iodine removal in pipes is given by Equation (3- 

47). 

η𝑒𝑖 = 1 − 𝑒𝑥𝑝 (
−𝐴𝑠𝑈𝑒𝑖

100𝑄
) 

(3 - 47) 

Where: 

   Uei   = e2809/T-12.5 

And: 

   T   = the gas temperature in ºK 

3.5.3.3 Bixler Model for Organic Iodine Removal 

The equation for the Bixler model for organic iodine removal in pipes is given by Equation (3- 

48). 
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η𝑜𝑖 = 1 − 𝑒𝑥𝑝 (
−𝐴𝑠𝑈𝑜𝑖

100𝑄
) 

(3 - 48) 

Where: 

𝑈𝑜𝑖 = 𝑒2809⁄𝑇−19.30 

and 

T        = the gas temperature in °K. 

Note: Organic iodine removal is not credited in design basis calculations. 

3.5.4 BWR Main Steam Line 

Regulatory Guide 1.183 Rev. 1 introduced a new model to removal rates of aerosol iodine in 

BWR Main Steam Lines (MSL). When the Rev 1 option is selected for the Regulatory Guide 

Revision option in model options, the pathway BWR Main Steam Line becomes available. The 

input options for this pathway are described in more detail in section 1.4.  

The pathway calculates a removal rate for the outboard section and a removal rate for the inboard 

section of the MSL. The calculation uses the numerical integration method described in appendix 

A of Regulatory Guide 1.183 Rev. 1 which incorporates Equations A-1 through A-5. The amount 

of aerosol iodine being removed in the outboard section of the pipe is determined by the following 

equation: 

𝑁𝑜𝑢𝑡 = λ𝑜𝑢𝑡𝑁𝑎𝑒𝑟𝑜Δ𝑡 

(3 - 49) 

Where: 

   λ𝑜𝑢𝑡   = outboard removal rate (1/s) 

   Naero   = the amount of aerosol iodine in the outboard section of the MSL (atoms) 

   Δ𝑡   = time step size (s) 

The amount of aerosol iodine removed by the inboard section of the pipe is then shown by the 

following equation: 
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𝑁𝑖𝑛 = (𝑁𝑎𝑒𝑟𝑜 − 𝑁𝑜𝑢𝑡)λ𝑖𝑛Δ𝑡 

(3 - 50) 

Where: 

   λ𝑖𝑛   = the inboard removal rate (1/s) 

The RADTRAD-AC coefficient matrix combines equations (3-49) and (3-50) to get the removal rate 

from the to and from compartments attached to the MSL. It should be noted that the flow out of the 

compartment connect to the pathway is normalized by the user-specified outboard volume and not 

the attached compartment volume like the filtered pathways.  

 

 

3.5.5 Filters 

Heating, ventilation, and air conditioning (HVAC) system filter efficiency can be input by the user 

for the different nuclide groups as a function of time. The filter efficiency is specified as the 

fraction of material passing through the filter that is trapped on the filter media. This efficiency, 

expressed in terms of a decontamination coefficient as shown in Equation (3-51). 

λ𝑓𝑖𝑙𝑡𝑒𝑟 = (
η𝑓𝑖𝑙𝑡𝑒𝑟

100
) λ𝑗,𝑘,𝑓𝑖𝑙𝑡𝑒𝑟

𝑖  

(3 - 5151) 

Where: 

   λ𝑗,𝑘,𝑓𝑖𝑙𝑡𝑒𝑟
𝑖    = the volume-normalized flow rate from compartment through the filter in 1/s 

 

3.6 Dose Analysis 

Doses in the environment, within a control room, or within a given volume due to inhalation and 

whole body immersion can be computed in SNAP/RADTRAD. The models used are presented 
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in the following sections and, as discussed in Section 2.4.1.1, the user can either choose the 

FGR 11 & 12 (default) or a user defined set of DCFs. 

3.6.1 Offsite Dose Analysis 

The dose to an individual at the EAB and the LPZ in the environment compartment is calculated 

in SNAP/RADTRAD. The dose due to cloudshine (immersion) for each nuclide, n, is calculated 
using Equation (3-52). 

𝐷𝑐,𝑛
𝑒𝑛𝑣 = 𝐴𝑛 (

𝑋

𝑄
) 𝐷𝐶𝐹𝑐,𝑛 

(3 - 5252) 

Where: 

   𝐷𝑐,𝑛
𝑒𝑛𝑣   = the air immersion (cloudshine) dose due to nuclide n in the environment   

       compartment in Sv 

   An   = the integrated release of nuclide n in Bq 

   (
𝑋

𝑄
)   = the user-provided atmospheric dilution factor in s/m3 

   DCFc,n  = the FGR 11 & 12 air immersion (cloudshine) DCF for nuclide n in Sv-m3/Bq-s 

The activity is related to the number of atoms of nuclide, n, as shown in Equation (3-53). 

𝐴𝑛 = λ𝑛𝑁𝑛 

(3 -53 53) 

Where: 

𝜆𝑛               = the radiological decay constant for nuclide n in 1/s. 

The thyroid and committed effective dose equivalent (CEDE) doses due to inhalation from each 
nuclide, n, are calculated using Equation (3-54). 

𝐷𝑖,𝑛
𝑒𝑛𝑣 = 𝐴𝑛 (

𝑋

𝑄
) 𝐵𝑅 ∗ 𝐷𝐶𝐹𝑐,𝑛 

(3 - 5454) 
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Where: 

   𝐷𝑖,𝑛
𝑒𝑛𝑣   = the inhalation dose commitment due to nuclide n in the environment   

       compartment in Sv 

   An   = the integrated release of nuclide n in Bq 

   (
𝑋

𝑄
)   = the user-provided atmospheric dilution factor in s/m3 

   BR   = the user-provided breathing rate in m3/s 

   DCFc,n  = the FGR 11 & 12 inhalation DCF for nuclide n in Sv/Bq for the CEDE or thyroid 

The TEDE is calculated as the sum of the CEDE and the immersion or cloudshine dose. Note that 

the conversion factor of 100 Rem = 1 Sv is applied to all the dose equations to obtain the dose in 

units of Rem. The total dose over the entire problem time is computed as the sum of the 

contributions over each time interval and each nuclide. 

3.6.2 Control Room Dose Analysis 

The dose to an individual in a control room is calculated from the time-integrated concentration 

of radionuclides in the control room compartment. The dose to the individual due to air 

immersion (cloudshine) in the control room is calculated using Equation (3-55). 

𝐷𝑐,𝑛
𝐶𝑅 = (

𝐷𝐶𝐹𝑐,𝑛

𝐺𝐹
) 𝑂𝐹 ∫ 𝐶𝑛 (𝑡)𝑑𝑡 

(3 - 5555) 

Where: 

   𝐷𝑐,𝑛
𝐶𝑅   = air immersion dose (cloudshine) due to nuclide n in the control room  

       compartment in Sv 

   DCFc,n  = the FGR 11 & 12 air immersion (cloudshine) DCF for nuclide n in Sv-m3/Bq-s 

   OF   = the user-provided control room occupancy factor 

   Cn(t)   = the instantaneous concentration of radionuclide n in the control room in Bq/s 

   GF   = the Murphy-Campe geometric factor, given in reference [29], which relates the dose 

       from an infinite cloud to the dose from a cloud of volume, V, in 1/m3. This factor is  

       defined in Equation (3-56). 

 



 

168  

𝐺𝐹 =
351.6

𝑉0.338
 

(3 - 5656) 

 

The thyroid and CEDE doses (inhalation dose) to an individual in the control room are 

calculated using Equation (3-57). 

𝐷𝑖,𝑛
𝐶𝑅 = BR ∗  𝑂𝐹 ∗  𝐷𝐶𝐹𝑖,𝑛 ∫ 𝐶𝑛 (𝑡)𝑑𝑡 

(3 - 5757) 

Where: 

   𝐷𝑖,𝑛
𝐶𝑅   = the inhalation dose commitment due to nuclide n in the control room in Sv 

   DCFi,n  = the FGR 11 & 12 inhalation DCF for nuclide n in Sv/Bq 

   OF   = the user-provided control room occupancy factor 

   Cn(t)   = the instantaneous concentration of radionuclide n in the control room in Bq/s 

      BR   = the user-provided breathing rate in m3/s 

The TEDE dose is calculated as the sum of the CEDE dose and the immersion or cloudshine 

dose. The total dose over the entire problem time is computed as the sum of the contributions 

over each time interval and each nuclide. 
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